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Welcome

Congratulations on the purchase of your Palm® Treo™ 700w 
smartphone. In one compact and indispensable device, you now have 
all of the following:

• An advanced mobile smartphone

• A Windows Mobile organizer with portable expansion capability 
(MultiMediaCard/SD/SDIO)

• Web browsing with data speeds averaging 600Kbps

• A 1.3-megapixel digital camera (camera smartphone only)

• Mobile email

• Text and multimedia messaging

• A media player

• Microsoft Office Mobile suite

This guide helps you set up your Treo 700w smartphone and quickly 
learn to use it. 

NOTE: Phone and text messaging service require a service contract with 
Verizon Wireless. Web, email, and messaging services require a service 
contract and high-speed data service from Verizon Wireless. Actual data 
speeds vary based on network capacity.

Tip
LOOK HERE: Don’t 
miss the helpful tips 
and cross-
references given in 
this column.

Did You Know
The Verizon 
Wireless business-
to-business sales 
department offers a 
Treo 700w 
smartphone without 
a camera. If you 
purchased your 
smartphone from 
this department, 
check the packaging 
to see if your 
smartphone 
includes a camera.
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What’s in the box?
You should have received all of the following items in the Treo 700w 
smartphone box:

Hardware
• Treo 700w smartphone

• Rechargeable battery

• AC charger

• USB sync cable

• Headset

Documentation and software
• setup poster

• Treo 700w Smartphone for Verizon Quick Reference Guide

• Using Your Palm Treo 700w Smartphone (this guide) 

• Windows Mobile Getting Started Disc that includes the following:

• Microsoft Outlook 2002
• ActiveSync® desktop synchronization software 
• Additional software for your smartphone

• Welcome CD that includes the Palm Treo 700w Smartphone 
Interactive User Guide

• Palm warranty
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What you need to use your smartphone CHAPTER 2

What you need to use your smartphone
As you work through the instructions in this guide, you need all the 
items that came in the Treo 700w smartphone box (see “What’s in the 
box?” on page 2) as well as the following:

• An activated mobile account with data services

• A location with wireless coverage for your smartphone 

• An electrical outlet

• The computer you want to synchronize your personal information 
with

NOTE: To use email, web browsing, or multimedia messaging, your 
Verizon Wireless service plan must include data services.
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CHAPTER 1

Getting Started

Palm® Treo™ 700w smartphone 
overview

Top view

Did You Know
The ringer switch 
silences all sounds 
when you need 
quiet—no need to 
navigate menus.

Ringer switch

Antenna

Infrared (IR) port

Stylus
Expansion 
card slot
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CHAPTER 1

Front viewTip
Be careful not to 
scratch or crush your 
smartphone screen. 
Do not store it in a 
place where other 
items might damage 
it. Visit 
www.palm.com/

mytreo700wVerizon to 
find a variety of useful 
accessories, including 
carrying cases that 
protect the screen.

Indicator light (phone 
and charge indicator)

Multi-
connector

5-way 
navigator

Earpiece

Power/End button

Microphone

Headset jack

Start 
button

Phone/Send 
button

Side button

OK button

Volume button

Action keys

http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
http://www.palm.com
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Palm® Treo™ 700w smartphone overview CHAPTER 1

Back view

The Treo 700w smartphone speaker includes a large 
magnet, so be sure not to store your smartphone near credit cards or 
other items that could be demagnetized.

Camera lens 
(camera 
smartphone 
only)

Battery door release

Speaker

Self-portrait mirror

IMPORTANT[ ! ]

ghj
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Installing the battery
1. Use one hand to press the battery door release and use the other 

hand to slide the battery door downward to remove it from your 
smartphone.

2. Align the battery contacts with the phone contacts inside the battery 
compartment. 

3. Insert the battery into the compartment at a 45-degree angle and 
then press it into place.

4. Slide the battery door onto the back of the smartphone until it clicks 
into place.

5. Your smartphone screen turns on and the Treo screen appears. Wait 
for the progress bar on the Treo screen to fill. 

6. When the Windows Mobile screen appears, tap the screen with the 
stylus to begin the setup process, and then follow the onscreen 
instructions to set up your smartphone.

Tip
If your smartphone 
does not turn on, you 
need to connect it to 
the AC charger to 
charge it. Before you 
can complete the 
setup process, you 
must also do a soft 
reset. See 
“Performing a soft 
reset” on page 191.

Tip
You can buy an extra 
battery as a spare for 
long airplane trips or 
periods of heavy data 
use. Be sure to use 
batteries from Palm 
only.

Battery door 
release

Notch

Phone 
contacts

Battery 
contacts
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Charging the battery CHAPTER 1

Charging the battery
Before using your Palm Treo 700w smartphone, you need to charge the 
battery. We recommend four hours for a full charge, or until the 
indicator light is solid green. See “Battery life” on page 29 for tips on 
maximizing the life of your smartphone’s battery.

1. Plug the AC charger into a wall outlet. If necessary, connect an 
adapter.

2. With the arrow on the connector facing up (toward your 
smartphone screen), connect the charger cable to the bottom of 
your smartphone. 

3. Check the indicator light to confirm your smartphone is charging. 
• Solid red indicates your smartphone is charging.
• Solid green indicates your smartphone is fully charged. 

Tip
If the indicator light 
does not turn on 
when you connect 
your smartphone to 
the AC charger, 
double-check the 
cable connection and 
the electrical outlet to 
which it is connected.

Indicator light
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When your smartphone is on (see “Turning your phone on and off” on 
page 11), the onscreen battery icon displays the charging status:

A solid lightening bolt indicates the battery is connected to a 
wall outlet and is charging.

A shaded lightening bolt indicates the battery is connected to 
a wall outlet and is fully charged.

A partial battery without a lightening bolt indicates the battery 
is not connected to a wall outlet and it has some power.

An exclamation point (!) indicates the battery needs charging 
immediately.

Tip
To see how much 
power is left in your 
battery, tap the 
onscreen battery icon.

Did You Know
Battery consumption 
varies based on 
personal usage. 
Consumption factors 
include signal 
strength, 
speakerphone usage, 
and the type of calls 
you make (data or 
voice).

Did You Know
If your battery ever 
becomes fully 
drained, your info is 
stored safely on your 
smartphone until you 
recharge the battery 
or connect your 
smartphone to a 
power source.

Battery 
icon
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Turning your smartphone on/off CHAPTER 1

Turning your smartphone on/off
You can use the organizer features of your Palm Treo 700w smartphone 
independently of the wireless features and applications. In other words, 
the screen and phone are designed to be turned off and on separately.

Turning your phone on and off
When you turn on your phone, it connects to a mobile network so that 
you can make and receive phone calls and use other wireless services. 

1. Press and hold Power/End  to turn on your phone. When your 
smartphone locates a signal, Verizon Wireless and the signal-
strength icon  appear at the top of the screen, indicating you can 
use the phone and Internet features (if supported by the local 
network).

2. Press and hold Power/End  again to turn off your phone off. 
When your phone is off, the phone-off icon  appears at the top of 
the screen and your smartphone is not connected to any mobile 
network. You can still use the organizer and other features.

Waking up the screen
To use the organizer features when your smartphone’s screen is off, you 
need to wake up the screen. You can also turn off your smartphone’s 
screen without turning off your smartphone’s wireless features.

1. Press Power/End  to wake up the screen. 
2. Briefly press Power/End  to turn off the screen.

Did You Know
The indicator light 
flashes green when 
your phone is on and 
you’re inside a 
coverage area. If 
you’re outside a 
coverage area, the 
indicator light flashes 
amber and no bars 
appear in the signal-
strength icon.

Tip
If Sound Mode is on 
you hear a series of 
tones when you turn 
your phone on and 
off. For more info on 
Sound Mode see 
“Setting the ringer 
switch” on page 163.
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Making your first call
We recommend that you charge your Palm Treo 700w smartphone for a 
full four hours (or until the indicator light is solid green) before using it 
for the first time. 

1. If you do not see your Today screen, 
press Phone/Send .

2. If you haven’t already activated your 
phone, follow these steps before 
continuing:
• Use the number pad on the keyboard 

to enter *228 (these numbers appear 
on the ZRRC letter keys).

• Press Phone/Send  to dial.
• Follow the voice prompts to activate 

your phone. A service provisioning message appears. 
• Wait a few minutes until you see the Programming Successful! 

message, and then press Dismiss .
3. Use the number pad on the keyboard to 

enter the number you want to call. 
4. Press Phone/Send  to dial.
5. When your call is complete, press Power/

End  to end the call.

Before You Begin[ ! ]
Make sure your phone 
is on (see “Turning 
your phone on and 
off” on page 11).

Tip
The Dial Lookup list 
might appear while 
you are dialing a 
number. Continue 
entering numbers to 
place the call. For 
more info on the Dial 
Lookup list, see 
“Dialing by contact 
name” on page 37. 
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Making your first call CHAPTER 1

Adjusting call volume
While a call is in progress, press the Volume button on the side of your 
smartphone to adjust call volume.

What’s my number?
1. Make sure your phone is on (see 

“Turning your phone on and off” on 
page 11). 

2. If you do not see your Today screen, 
press Phone/Send .

3. Press Menu .
4. Select Preferences > Phone Settings.
5. On the Phone tab, look for your phone 

number below the title bar.
6. Press OK .

Volume button

Tip
If your phone number 
doesn’t appear on the 
Phone Settings 
screen, press OK, and 
then turn your phone 
off and back on again. 
Repeat steps 1–6. If 
your phone number 
still doesn’t appear, 
your phone has not 
been activated. Turn 
your phone off, wait a 
few hours, and then 
turn on your phone 
and repeat these 
steps. If your phone 
number still does not 
appear, please 
contact Verizon 
Wireless for 
assistance.

Look here for your 
phone number
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Setting up your computer
You can enter or change information on your smartphone or in 
Microsoft Outlook on your computer, and then synchronize to 
automatically update the info in both places—no need to enter the info 
twice. We strongly recommend that you synchronize your smartphone 
and your computer frequently to keep your information up-to-date (and 
backed up) in both locations. 

Before you can synchronize, you need to install the desktop 
synchronization software and connect the sync cable on your computer. 
Even if you already installed a previous version of the ActiveSync® 
software, you must install the software that came with your smartphone 
on the Windows Mobile Getting Started Disc.

System requirements
Your computer should meet the following minimum system 
requirements:

• Windows 2000 or XP (later versions may also be supported)

• 32MB of available memory (RAM)

• 170MB of free hard disk space

• CD drive

• Available USB port

• USB sync cable (included with your Palm Treo 700w smartphone)

Tip
You can also 
synchronize your 
smartphone with a 
Microsoft Exchange 
Server using 
Microsoft Outlook for 
Windows.
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Setting up your computer CHAPTER 1

Installing the desktop synchronization software
1. Close any applications that are currently running on your computer, 

including those running in the background. Your computer needs to 
have all its resources available to install the software. 

2. Insert the Windows Mobile Getting Started Disc into the CD drive on 
your computer.

3. Follow the onscreen instructions during the installation. The Install 
program prompts you to synchronize for the first time. See 
“Synchronizing contacts and other info” on page 28 for more info 
on synchronization.

Connecting your smartphone to your computer

If you’re transferring from previous a Windows 
Mobile device or from a Palm Powered® device, follow the steps at 
www.palm.com/us/support/Treo700wVerizon before you set up your 
computer for your new smartphone.

1. Plug the AC charger into a wall outlet. If necessary, connect an 
adapter.

2. Plug the USB sync cable into an available USB port or a powered 
USB hub on your computer.

3. With the USB cable on the left, connect the sync cable to the bottom 
of your smartphone.

4. Connect the charger cable to the connector on the sync cable.

Before You Begin[ ! ]
If you are installing on 
a computer at work, 
make sure your 
company allows you 
to install new 
software. Contact 
your company’s 
IT department for 
help.

Tip
Need additional help 
installing the desktop 
software? See 
“Trouble installing the 
desktop software?” on 
page 190.

Before You Begin[ ! ]
Make sure you install 
the desktop 
synchronization 
software from the CD 
before you connect 
the USB sync cable to 
your computer.

IMPORTANT[ ! ]

http://www.palm.com/us/support/treo700wVerizon
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USB sync
cable

Tip
For best performance, 
plug your sync cable 
directly into a USB 
port on your 
computer. If your 
computer has USB 
ports on both the front 
and back, we suggest 
using the back port. If 
you use a USB hub, 
make sure it is a 
powered hub.
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CHAPTER 2

Learning the Basics

Moving around the screen
To move around the Palm® Treo™ 700w smartphone screen, you can 
use the 5-way navigator or you can tap items on the screen with the 
stylus. As you become familiar with your smartphone, you’ll find your 
own favorite way to scroll, highlight, and select items.

The 5-way includes Right , Left , Up , Down , and Center buttons.

Tip
Some third-party 
applications may not 
work with the 5-way 
navigator, and you 
must use the stylus 
instead.

Up

RightLeft

Down

Center
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Scrolling through screens
As on a computer, on your smartphone you scroll to move from field 
to field or page to page, or in some cases to highlight an item or option 
in a list. 

There are several methods of scrolling:

• Press the 5-way on the front of your smartphone. Press Right , 
Left , Up , or Down  to move to the next field, button, or action 
in that direction.

• Press and hold Option  while pressing Up  or Down  to scroll 
one screen at a time. These keys work just like the Page Up and Page 
Down keys on your computer keyboard.

• Tap an onscreen scroll arrow.

• When viewing a screen with tabs, 
such as when adding a contact, press 
Left  to switch from item scrolling to 
tab scrolling.

• When inside a text field, press Right  
or Left  to move to the next 
character, and press Up  or Down  
to move between lines. 

• When inside a list, press and hold Up 
 or Down  to rapidly scroll 

through the list.

• Tap and drag the slider of an onscreen 
scroll bar.

Tip
The arrow icons that 
indicate directions on 
the 5-way are different 
from the onscreen 
scroll arrows and the 
arrows that indicate a 
list is available (see 
“Selecting options in 
a list” on page 22). 

Tip
Press and hold Option 
while pressingLeft or 
Right to automatically 
go to the top and 
bottom of a screen. 
This extremely helpful 
in applications such as 
Messaging, Internet 
Explorer, and Word.

Scroll arrows

Scroll arrows
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Moving around the screen CHAPTER 2

Closing screens
To accept the information you entered on a screen and to return to the 
previous screen, do one of the following:

• Press OK .

• Use the stylus to tap  in the upper-right corner of the screen.

Highlighting and selecting items
On most screens, one item—a button, a list entry, or a check box—is 
highlighted by default. The highlight identifies which item is affected by 
your next action. Use the 5-way to move the highlight from one item to 
another before opening or selecting it. 

The highlight can take one of two forms, depending on what is 
highlighted:

• Border glow: This highlights items such as 
an onscreen button (such as OK, Dismiss, or 
Hide), a check box, an option, or a web link. 

• Reverse type (light text on a dark 
background): This highlights items 
such as a phone number, an email 
address, text, or an item in a list.

After highlighting an item with the 5-way, you can select or activate it by 
pressing Center, or by tapping the item with the stylus. 

Tip
Experiment with 
using the 5-way to 
highlight different 
screen elements. 

The behavior of the 
5-way varies slightly 
in each application. 
Once you become 
familiar with the two 
forms of highlights, it 
is easy to learn the 
specific behavior of 
the 5-way in each 
application. 
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Highlighting text
You can use the 5-way or the stylus to highlight text on the screen:

• 5-way: Press and hold Shift  while pressing Right , Left , 
Up , or Down  to extend the highlight in that direction.

• Stylus: Tap and drag the stylus across the text you want to 
highlight. To highlight a word, double-tap it. To highlight a 
paragraph, triple-tap it.

Using the action keys
The action keys are designed to give you quick access to relevant tasks, 
so the action key items vary from application to application, and from 
screen to screen, and in some cases may not be available at all. Action 
keys activate the items that appear directly above them on the screen. 
In most cases the right action key  opens the menu, and the left 
action key  activates a specific command, such as New or Edit. 
Remember that action key functions vary from screen to screen, so be 
sure to check the onscreen label before pressing the action keys. 

Tip
When text is 
highlighted, you can 
press Backspace to 
delete the highlighted 
text.

Left action key Right action key

Left action key 
activates this 
command

Right action key 
activates this 
command
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Moving around the screen CHAPTER 2

Selecting menu items
In many applications, a menu provides access to additional features. 
The menu is hidden until you press Menu . To get the most out of 
your smartphone, it’s a good idea to familiarize yourself with the 
additional features available through the menu in various applications.

1. Press Menu  to display an 
application’s menu.

2. Press Up  or Down  to highlight a 
menu item.

3. If an arrow appears next to a menu item, 
press Center or Right  to display 
additional options for that item, and then 
press Up  or Down  to highlight a 
menu item. To return to the main menu 
without making a selection, press Left .

4. Press Center to select the menu item, or press Left  or Menu  
to close the menu and cancel your selection.

Selecting options in a shortcut menu
Most applications also provide access to context-sensitive, shortcut 
menus—similar to the right-click menus on a computer. The shortcut 
menu options vary based on the highlighted selection.

Did You Know
You can select most 
menu items by 
pressing a key on the 
keyboard. To quickly 
access a menu item, 
press Menu followed 
by the underlined 
letter in the menu 
item’s name. 
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1. Scroll to the item where you want to 
open the shortcut menu.

2. Press and hold Center to open the 
shortcut menu.

3. Press Up  or Down  to highlight a 
menu item.

4. Press Center to select the menu item or 
press Left  to cancel your selection.

Selecting options in a list
Lists let you select from a range of options. 
You can identify whether a list is available 
when you select the field. If a rectangle 
appears around the field along with a 
downward-pointing arrow, a list is available. 
Lists are different from the menus described 
earlier in this section. 

To select from a list, do any of the following:

• Use the 5-way to highlight the field, and 
then press Center to display the items in 
the list. Press Up  or Down  to 
highlight the item you want, and then 
press Center to accept your selection.

• Use your stylus to tap the arrow, and then 
tap the item in the list.

• To exit the list and cancel your selection, 
press Left .

Tip
You can also tap and 
hold an item with the 
stylus to open the 
shortcut menu.

Tip
When selecting fields 
you might not see the 
downward pointing 
arrow until you press 
Center. 

Did You Know
In fields where you 
see a downward 
pointing arrow but no 
rectangle, you must 
tap the arrow with 
the stylus to expand 
the field. 
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Using the keyboard CHAPTER 2

Using the keyboard

Understanding the keyboard backlight
Your smartphone includes a keyboard backlight for low light conditions. 
The keyboard backlight activates automatically when the screen turns 
on. It turns off automatically when the screen turns off or when you are 
on a call or playing music in the background for longer than the time 
specified in Backlight Settings. The backlight also turns off when an 
application’s power-saving features turn it off.

Entering lowercase and uppercase letters
By default, the first letter of each sentence or field is capitalized and the 
remaining text you enter is lowercase. To enter other uppercase letters, 
do one of the following: 

Tip
When using the 
keyboard, most 
people find it easiest 
to hold the 
smartphone with two 
hands and to use the 
tips of both thumbs 
to press the keys.

Tip
You can change the 
backlight shut-off 
interval. Press Start 
and select Settings. 
Select the System 
tab, and then select 
Backlight. On the 
Battery Power tab, 
set shut-off interval.

Tip
You can turn off the 
first letter 
capitalization setting. 
For details see 
“Setting input 
options” on 
page 169.

Action key Action key
Phone/Send

Start

Power/End

OK

Backspace

Option

Shift

Space

Return

Shift

Alt



数码说明书之家—WWW.54GG.COM
24 Using Your Treo 700w Smartphone

CHAPTER 2

• Press Shift , and then enter a letter. You don’t need to press and 
hold Shift while entering a letter.

• Press Shift  twice to turn on Caps Lock, and then enter a series of 
letters. When Caps Lock is on, this symbol appears at the bottom of 
the screen: . To turn off Caps Lock, press Shift  again. 

Entering numbers, punctuation, and symbols 
Numbers, punctuation, and symbols appear above the letters on 
the keys. To enter these characters, do one of the following: 

• Press Option , and then press the key of the desired character. 
You don’t need to hold Option while pressing the key.

• Press Option  twice to turn on Option Lock, and then press the 
desired keys to enter a series of characters. When Option Lock is on, 
this symbol appears at the bottom of the screen: . To turn off Option 
Lock, press Option  again. 

Entering other symbols and accented characters
You can enter symbols and accented characters that don't appear on 
the keys using the alternate characters list.

1. Press Alt  to display the alternate character list.
2. Narrow the list by pressing the key that corresponds to the 

character you want. For example, to enter an é, press e. See the 
table on the next page for a list of corresponding characters.

3. Press Up  or Down  to highlight the desired character.
4. Press Center to insert the character.

Tip
The alternate 
characters are 
grouped according to 
their similarity to the 
corresponding key. 
For example, the 
alternate characters 
available for the e key 
are é, è, ë, and ê. If 
you press the wrong 
key, press Backspace 
to return to the full list 
of alternate 
characters. You can 
then press another 
key.
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Symbols and accented characters 

Press Alt 
 and 

enter... 

to select... Press Alt 
 and 

enter... 

to select... Press Alt 
 and 

enter... 

to select...

a á à ä â ã å æ o ó ò ö ô œ õ 0 °
A Á À Ä Â Ã Å Æ O Ó Ò Ö Ô Œ Õ 1

b or B ß p or P ¶ 2

c ç ¢ © r or R ® 3

C Ç ¢ © s ß Šs §

e é è ë ê S ß ŠS §

E É È Ë Ê t or T ™ $  £ ¥ ¢

i í ì ï î u ú ù ü û ! ¡

I Í Ì Ï Î U Ú Ù Ü Û ? ¿

l or L £ x or X x ¤ ; :-) :-( ;-)

n ñ y   ÿ . , ' " @ + 
- * / # ( or 
) 

: & _ • % = ÷ ̂   
£ ¥ ¢ [ ] { } < > « » 
© ® ° ~ \ Ø µ |N Ñ Y   Ÿ
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Opening and closing applications

Opening applications
You can access all the applications on your smartphone through the 
Start menu:

1. Press Start  to open the 
Start menu. 

2. Use the 5-way navigator to 
highlight the application 
you want to use. To view 
additional applications, 
select Programs.

3. Press Center to open the 
selected application.

Closing applications
You can have several applications open at once, so you don’t need to 
exit an application to open another one. In most cases, applications 
close automatically when available memory is low, but you can also 
close applications manually.

1. Press Start  and select Settings. 
2. Select the System tab, and then select Memory .
3. Select the Running Programs tab. 
4. Do one of the following:

• Select the application you want to close, and then select Stop 
to close it. 

• Select Stop All to close all of your open applications.

Tip
With the Start menu 
open, you can enter 
the underlined letter in 
the application’s name 
to open it. For 
example, enter “h” to 
open Help.

Did You Know
You can open specific 
applications by 
pressing Option and 
then pressing Phone/
Send, Start, or OK on 
the front of your 
smartphone. For 
example, to open 
Memory Settings, 
press Option + OK. 
You can customize the 
applications assigned 
to these button 
combinations; see 
“Reassigning 
buttons” on page 168 
for details.
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Using your Today screen
Your Today screen is your home base. From your Today screen you can 
quickly look up a contact, dial a phone number or speed dial entry, see 
your latest calendar appointments, see the number of unread email 
messages, and even display a web page. 

To access your Today screen, press Phone/Send . 

• Title bar and status info: See “What are all those icons?” on 
page 34 to learn about the icons that appear in this area.

• Dial Lookup field: Begin typing the name or number you want to 
look up. See “Dialing by contact name” on page 37 for more info. 

• Google Lookup field: Enter a word you want to find on the Internet 
and press Center to begin the search (data services connection 
required).

• Speed dial entries: Select the picture or button you want to dial. 
See “Defining speed dial buttons” on page 49 to create your own.

Tip
If you press Phone/
Send while a number 
is highlighted, your 
device will dial the 
number. If a number 
is highlighted, 
deselect the number, 
or use the Start menu 
to access the Today 
screen.

Tip
You can select a 
picture for your 
Today screen 
background and 
select which items 
appear in the Today 
screen. See “Today 
screen settings” on 
page 157 for details.

Did You Know
You can turbocharge 
your Today screen by 
purchasing third-
party plug-ins that 
add even more 
features. 

Title bar and
status info

Dial Lookup field

Google Lookup field

Speed dial
entries
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Synchronizing contacts and other info
Each time you connect your smartphone to your computer, it 
automatically synchronizes the items that are set to sync. You can 
customize the sync settings (see “Setting synchronization options” on 
page 146) or use the default settings to synchronize your info from the 
following applications:

1. Connect your smartphone to your 
computer. You should hear the 
ActiveSync® tone.

2. Look for the ActiveSync icon  at 
the top of your smartphone’s screen 
and the ActiveSync icon  in the 
taskbar on your computer.
• If you don’t see the ActiveSync 

icon, make sure the desktop 
synchronization software that 
came with your smartphone is 
running on your computer. 

• If you have any problems 
synchronizing, see “Synchronization (ActiveSync® software)” on 
page 201 for troubleshooting suggestions.

Before You Begin[ ! ]
To synchronize your 
contacts and other 
personal information, 
you must first install 
the software from the 
CD that came with 
your smartphone. 
See “Installing the 
desktop 
synchronization 
software” on page 15 
for instructions.

Tip
Consider purchasing 
and installing a 
backup program to 
preserve your data 
and settings if your 
smartphone is ever 
lost or stolen. A 
backup and restore 
program will also 
protect your data 
during a hard reset. 
Visit www.palm.com/
mytreo700wVerizon 
for information on 
receommended 
backup and respire 
programs.

http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
http://www.palm.com
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Battery life
Battery life depends on individual usage. When used as a smartphone, 
your smartphone battery provides up to 4.75 hours of talk time or up to 
230 hours of standby time. 

Maximizing battery life
You can increase your smartphone’s battery life by following a few easy 
guidelines. Remember that battery life depends on how you use your 
smartphone.

• Charge your smartphone whenever you’re at your desk, or charge it 
overnight each day. The battery in your smartphone has a much 
longer useful life when it is topped off frequently, versus charging it 
after it is fully drained.

• Your smartphone’s wireless features (phone, email, messaging, and 
web) generally consume more power than the organizer features. 

• If you spend a lot of time using the camera (if included), games, 
media players, eBooks, or other applications, keep an eye on the 
battery icon and charge when necessary.

• If you don’t plan to use the wireless features on your smartphone for 
a while, put it into Flight mode. (see “Turning Wireless Services On/
Off” on page 181). You can forward calls to a different number or let 
all calls be picked up by voicemail (see “Forwarding calls” on 
page 47). To see if your smartphone is in Flight Mode tap the phone-
off icon .

Before You Begin[ ! ]
You must charge your 
smartphone fully 
before using it the 
first time. Wait until 
the indicator light 
turns solid green, 
which may take up to 
four hours.

Tip
If the battery is fully 
drained, it may take a 
few moments for the 
indicator light to turn 
on while charging.

» Key Term
Flight Mode: The state 
when your phone, the 
Bluetooth® feature, 
and all wireless 
accessories, such as a 
Wi-Fi® network card 
(sold separately), are 
all turned off. 
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• As with any mobile phone, if you are in an area with no wireless 
coverage, your smartphone searches for a signal, which consumes 
power. If you cannot move to an area of better coverage, temporarily 
turn off your phone (see “Turning your phone on and off” on 
page 11). 

• Turn off your smartphone’s Bluetooth® wireless technology feature 
when you do not need to make a Bluetooth connection.

• Turn down the screen brightness (see “Adjusting the brightness” on 
page 166).

• Set your screen to turn off automatically after a shorter period of 
inactivity (see “Viewing and optimizing power settings” on 
page 180). 

• Keep your battery away from direct sunlight and other sources of 
heat. Temperatures over 120 degrees Farenheit (50 degrees Celsius) 
can permanently reduce the capacity and life span of any lithium 
ion battery.

Did You Know
If the battery drains 
to the point where 
your smartphone 
doesn’t turn on, your 
smartphone stores 
your info safely until 
you recharge the 
battery. To avoid 
draining the battery, 
we recommend that 
you charge and 
synchronize every 
day, especially if you 
use your 
smartphone often.
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Where to learn more

For a quick introduction
• Quick Tour: The Quick Tour highlights many of your smartphone’s 

features. It is already installed on your smartphone, and you can 
open it at any time. Press Start , select Programs, and then select 
Quick Tour . 

While using your smartphone
• Help: Many of the built-in applications include on-device Help, so 

that you can learn about the tasks you can perform in that 
application. To access Help, go to the application or screen you want 
help with, press Start , and select Help. 

• Online support from Palm: For up-to-date downloads, 
troubleshooting, and support information, check out 
www.palm.com/us/support/Treo700wVerizon.

If you need more information
• Books: Many books on Windows Mobile devices are available in 

local or online book retailers (look in the computers section), or visit
www.palm.com/mytreo700wVerizon.

• Online forums: Consult online Treo 700w smartphone user 
discussion groups to swap information and learn about 
topics you may find nowhere else. Visit
www.palm.com/us/support/Treo700wVerizon for details.

http://www.palm.com/us/support/Treo700wVerizon
http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
http://www.palm.com/us/support/Treo700wVerizon
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• Verizon Wireless Customer Care: For questions about your 
mobile account or features available on the network, contact Verizon 
Wireless Customer Care or visit www.verizonwireless.com for the 
latest information and help.

http://www.verizonwireless.com
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Using Your Phone

Phone overview
You can make and receive calls and store speed dial entries right from 
your Today screen. Be sure you know how to turn on your phone before 
reading this section (see “Turning your phone on and off” on page 11).

Accessing your Today screen
Press Phone/Send .

Tip
If you press Phone/
Send while a number 
is highlighted, your 
device will dial the 
number. If a number 
is highlighted, 
deselect the number, 
or use the Start menu 
to access the Today 
screen.
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What are all those icons?
You can monitor the status of several items using icons at the top of 
your Today screen:
0

0

You missed an incoming call.

0

You have a voicemail message.

0

You have a new email, text, or multimedia message.

0

An error occurred during synchronization.

0

You have more than one of the conditions listed above.

0

Your phone is on. The bars display the signal strength. The 
stronger the signal, the more bars appear. If you are 
outside a coverage area, no bars appear.

0

Your phone is off.

0

You are outside a Verizon Wireless coverage area and 
roaming on another mobile service provider’s network.

0

A voice call is in progress.

0

You are in an area that supports 1xRTT data services.

0

You are in an area that supports high-speed data services.

Tip
To display the 
remaining battery 
power, tap the battery 
icon. To close the 
battery status 
window, select Hide.

» Key Term
1xRTT (Single carrier 
[1x] radio 
transmission 
technology): A 
wireless technology 
that can provide fast 
data transfer and 
Internet access with 
speeds of up to 
144Kbps. 

» Key Term
EVDO (Evolution Data 
Optimized): A 
wireless broadband 
technology that is 
designed for very 
high-speed data 
transfer with speeds 
of up to 600Kbps. 
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0

A data call is in progress. You can make calls, but you 
cannot receive calls (incoming calls go to voicemail).

0

A high-speed data call is in progress. You can still make or 
receive calls.

0

Your phone is on and an EVDO or 1xRTT data connection 
is dormant. You can still make or receive calls.

0

Your phone is on and an EVDO or 1xRTT data connection 
is dormant. You can still make or receive calls.

0

Your Palm® Treo™ 700w is connected to a computer or 
network which is providing a data connection.

0

A data connection is not available or your phone is off.

0

Your smartphone’s battery is low.

0

Your smartphone’s battery is charging.

0

Your smartphone is connected to a power outlet and the 
battery is fully charged.

Network 
name

Your phone is on and you are in a Verizon Wireless 
coverage area. If you are outside a coverage area, No 
service or Roaming appears instead. When you turn off 
your phone, Phone Off appears instead.
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0
Voice privacy is preventing over-the-air eavesdropping. 
Appears during a call when this option is turned on and 
available on the Verizon Wireless network.

0

Location privacy is off and your location is available to the 
Verizon Wireless network and other applications. 

0

The Bluetooth® wireless technology status indicator 
appears in gray when this feature is off, in blue when this 
feature is on, and in reverse blue when your smartphone is 
communicating with another Bluetooth device. 

0 A call is in progress and your smartphone is connected to 
a Bluetooth headset or car kit. 

Tip
Data services may not 
be available when 
you are roaming on 
partner networks.

Tip
To quickly turn the 
Bluetooth feature on 
and off, tap the 
Bluetooth icon to 
access the Bluetooth 
Settings screen.
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Making calls
Your smartphone offers several ways to make phone calls. Try them all 
and you’ll discover which methods you prefer.

Dialing with the keyboard
1. Go to your Today screen (see “Accessing your Today screen” on 

page 33).
2. Using the numbered keys on the keyboard, enter a phone number. 
3. Press Phone/Send  to dial.

NOTE: You do not need to press Option to access the numbers on the 
keyboard. However, when dialing short numbers, such as 411, the 
number may conflict with a contact name. If this occurs, press 
Option  to avoid starting a contact lookup. You can always dial 911 
without pressing Option first.

Dialing by contact name
You can look up contacts quickly by entering just a few letters of a 
contact’s name or phone number directly from your Today screen. 
Before you can dial a call by contact name, you must create some 
contacts (see “Adding a contact” on page 55) or import them by 
synchronizing (see “Synchronizing contacts and other info” on 
page 28). 

1. Go to your Today screen (see “Accessing your Today screen” on 
page 33). 

Before You Begin[ ! ]
Make sure your phone 
is on (see “Turning 
your phone on and 
off” on page 11) and 
that you’re inside a 
coverage area.

Tip
To see a contact’s 
address, company, 
and other details, 
highlight the name 
and press Center.

Tip
To start another 
Contacts search, press 
Backspace to delete 
letters you’ve entered.
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2. Using the keyboard, begin entering one 
of the following for the contact you want 
to call:
• First name (JOH for John)
• Last name (SMI for Smith)
• First initial, a space, and then last initial 

(J S for John Smith)
• First name and last name 

(JOH SMI for John Smith)
• Phone number (you don’t need to press 

Option to access the number keys)
For example, entering SM finds both Smilla Anderson and John 
Smith. Entering SM A finds only Smilla Anderson.

3. Select the number you want to dial.
4. Press Phone/Send  to dial.

Dialing with a speed dial button 
Before you can use a speed dial button, you 
must create some speed dial entries. See 
“Defining speed dial buttons” on page 49. 

You can access your speed dial buttons by 
doing any of the following:

• Select a speed dial button with the 5-way, 
and then press Center.

• Tap a speed dial button with the stylus. 

• Press and hold a Quick Key that you assign 
to the speed dial button.

Did You Know
After you look up a 
contact, you can 
select how you want 
to communicate with 
that person. Press 
and hold Center, and 
then select the 
communication 
method you want 
to use.

Did You Know
You can dial an 
alternate number for 
a contact with a 
speed dial entry. 
Highlight the speed 
dial button, press and 
hold Center, and then 
select a number from 
the shortcut menu. 

Tip
You can customize 
the default speed dial 
buttons. See “Editing 
a speed dial button” 
on page 51.
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To see more speed dial buttons, highlight the picture speed dial area 
and press Right or Left repeatedly, or highlight the text speed dial area 
and press Up, Down, Right, or Left.

Dialing by company name
1. Press Start  and select Contacts.
2. Press Menu  and select View By > 

Company.
3. Press Phone/Send  to go to your Today 

screen.
4. Using the keyboard, begin entering the 

first few letters of the company name.
5. Select the number you want to dial.
6. Press Phone/Send  to dial.

Dialing from a web page or message
Your smartphone recognizes most phone 
numbers that appear in web pages or in text, 
email, or multimedia messages. 

1. Use the 5-way to highlight the phone 
number you want to dial in the web page 
or text message.

2. Press Center to open the Dial dialog box.
3. Press Phone/Send  to dial.

Tip
You can hide your 
speed dial buttons on 
your Today Screen 
and still use your 
Quick Keys to call a 
speed dial number.

Tip
If you can’t dial a 
phone number 
directly from a web 
page or a message, 
then highlight the 
number, press and 
hold Center, and 
select Copy. Open the 
Dial Pad, and then 
press and hold Center 
to Paste. Press Phone/
Send to dial.
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Redialing a recently called number
• To dial the last number you called: 

Go to your Today screen, and then press 
and hold Phone/Send .

• To select from your most recently 
dialed numbers: Go to your Today 
screen, press Phone/Send , highlight 
the number or contact name you want to 
call, and then press Phone/Send  to dial. 

• To select from a chronological list of 
calls: Go to your Today screen, press 
Phone/Send , and then select Call Log. 
Highlight the number you want to call, and 
then press Call  to dial. 

Dialing using the onscreen Dial Pad
1. Go to your Today screen. 
2. Press Phone/Send  and then select 

Dial Pad from the menu.
3. Tap the onscreen Dial Pad to enter the 

number.
4. Press Phone/Send  to dial.

Tip
You can also access 
the Call Log and Dial 
Pad from the Today 
screen by pressing 
Menu and selecting 
Call Log or Dial Pad. 

Did You Know
You can paste 
numbers directly into 
the Dial Pad. Copy a 
number from another 
application, switch to 
Dial Pad, and then 
press and hold Center 
to paste the number.

Tip
Make sure a number is 
not highlighted before 
you press Phone/
Send. If you press 
Phone/Send while a 
number is 
highlighted, your 
device will dial the 
number.
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Receiving calls
To receive calls, your phone must be on. This is different from using 
your smartphone in Flight mode (see “Turning Wireless Services On/
Off” on page 181).

To answer a call, do one of the following:

• Press Phone/Send .

• Press Answer .

• If the headset is attached, press the headset button.

To ignore a call and send it to voicemail, do one of the following:

• Press Power/End .

• Press Menu  and select Ignore.

To silence the ringer while your smartphone is ringing:

• Press the Volume button or any key on your smartphone except 
Phone/Send, Power/End, or the 5-way.

• To immediately silence all system sounds including the ringer, slide 
the ringer switch to Sound Mode Off .

When you silence the ringer, you can either answer the call or let it ring 
through to voicemail. 

Tip
See a picture of the 
person calling you! 
Learn how to assign a 
caller ID picture in 
“Assigning a picture 
and ringtone ID to a 
contact” on page 160.

Did You Know
You can also ignore a 
call and send a text 
message. Press Menu 
and select Ignore with 
text message. 

Tip
If music is playing 
when a call arrives, 
the smartphone rings 
softly. You can answer 
the phone as you 
normally would. The 
audio pauses during 
your call. 
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Using voicemail

Setting up voicemail
1. Go to your Today screen.
2. Press and hold 1 on the keyboard to dial 

Verizon Wireless’s voicemail system.
3. Follow the voice prompts to set up 

your voicemail.

Voicemail notification
When you have a new voicemail message, a 
notification screen appears. To hear your 
message now, press Listen . To retrieve 
your message later, press Dismiss . 
When you have unretrieved voicemail 
messages, a Voicemail icon  appears at 
the top of your screen.

Retrieving voicemail messages
1. Go to your Today screen.
2. Press and hold 1 on the keyboard to dial Verizon Wireless’s 

voicemail system.
3. Enter your voicemail password using the keyboard, or press Extra 

Digits  if you defined this option (see “Creating a speed dial 
button” on page 49 for details).

4. Select Play  to listen to your messages.

Did You Know
When a Voicemail 
icon appears at the 
top of the screen, 
you can tap this icon 
to retrieve your 
voicemail.

Tip
You do not need to 
press Option to enter 
numbers, *, or # 
while on an active 
call.

Tip
If you have trouble 
accessing a 
voicemail system, try 
changing the Dialpad 
tone setting. See 
“Selecting your call 
settings” on 
page 161.
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Managing active calls
When you make or receive a call, the active call info appears on your 
Today screen. 

During a call, you can do any of the following:

• Put the call on hold: Press Hold . To take the call off hold. 
Press Off Hold .

• Use the built-in speakerphone: Press Menu  and select 
Speakerphone. To return to the earpiece, press Menu  again and 
select Speakerphone off.

• Mute the microphone so you can’t be heard: Press Menu  
and select Mute. To turn the microphone back on, press Menu  
again and select Cancel Mute.

• Switch to another application: Press Start  and select the 
application.

Tip
When a call lasts 
longer than one 
minute, the screen 
turns off. Press any 
key, except Power/
End, to wake up the 
screen.

Did You Know
You can send and 
receive text messages 
during a call. This is a 
great way to stay 
connected with 
colleagues during a 
long call.

Current duration of call

Caller’s name and number
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Ending a call
Do one of the following:

• Press Power/End. .

• Press the headset button (if the headset is attached).

Returning to an active call from another application
You can use many other applications on your smartphone while holding 
a phone conversation, including the organizer and SMS features. You 
cannot browse the web or send and receive email or MMS messages 
while on a voice call.

From any application, press Phone/Send  to return to your Today 
screen.

Saving phone numbers
After you complete a call, you are prompted to add the number if it is 
not already in your Contacts list. 

• To create a new contact for this number, select Create New Contact.

• To add this number to an existing contact, select Copy and Add, and 
then select a contact name.

• To decline adding the number, press Dismiss .

• To permanently disable the Add Contact prompt, select Don’t show 
this again.

Tip
You can also save 
contact info from 
other applications, 
such as Messaging.

Tip
If an incoming call 
uses caller ID 
blocking, you do not 
see the Add Contact 
prompt.
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If you don’t add a number right away, follow these steps to add it later: 

1. Go to the Call Log (see “Redialing a recently called number” on 
page 40). 

2. Highlight the number you want to save. 
3. Press and hold Center to open the shortcut menu, and then select 

Save to Contacts.
4. Enter the information for the entry.
5. Press OK .
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More ways to manage calls
Your Treo 700w smartphone offers many advanced telephone features, 
including call waiting, three-way calling, and call forwarding. 

Making a second call
You can make a second call while your first call is still active. When you 
dial a second number, the first call is automatically placed on hold. 

To dial a second number, use any of the methods described in “Making 
calls” on page 37). If you’re dialing by contact name or with the 
keyboard, you must first use the 5-way to select the Dial Lookup field.

When two calls are active, your Today screen includes two call status 
sections, each representing one of the calls. 

Answering a second call (call waiting)
When you’re on a call and you receive a 
second call, the call waiting notification 
appears. You can do any of the following:

• Place the current call on hold and 
answer the new call: Press Answer  
or Phone/Send .

• Send the new call to voicemail: Press 
Menu  and select Ignore.

• Send the new caller a text message: 
Press Menu  and select Ignore with text message.

• Hang up both calls: Press Power/End .

Did You Know
When the second call 
is outgoing, you can 
conference the two 
calls, but you cannot 
swap between them.

When the second call 
is incoming, you can 
swap between the 
two calls, but you 
cannot conference 
them.

When two calls are 
active and you press 
Power/End, you hang 
up both calls. To 
return to the first call, 
wait for the person on 
the second call to 
hang up.
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Making a conference call
When the second call is outgoing, you can join two calls in a conference 
session. Additional charges may apply and minutes in your mobile 
account may be deducted for each active call. Please contact Verizon 
Wireless for more information. 

1. Put the first call on hold, and then place a 
second call.

2. Press Conference ; this joins the two 
active calls in a conference.

3. When you’re done, press End 
Conference ; this ends the second 
call and returns you to the first call. If 
you’re ready to hang up both calls, press 
Power/End  instead.

Forwarding calls
You can forward calls to another phone number. Please check with 
Verizon Wireless about availability and pricing of forwarded calls; 
additional charges may apply.

1. Go to your Today screen.
2. Dial *72 followed by the number where you want to forward your 

calls. For example: *72 415-555-1234. 
3. Press Phone/Send  to dial.
4. When you’re ready to turn off call forwarding, dial *73, and then 

press Phone/Send .

Tip
If *72 and *73 do 
not turn call 
forwarding on and 
off, please contact 
Verizon Wireless to 
obtain the forwarding 
codes for your area.

After you turn on call 
forwarding, call your 
smartphone to 
confirm that call 
forwarding is active.
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Viewing minutes usage
1. Go to the Call Log (see “Redialing a recently called number” on 

page 40). 
2. Press Menu  and select Call Timers to view voice minutes or 

Data Log to view data minutes. 
3. (Optional) To reset the counters to zero, select Reset.
4. Press OK . 

Tip
Keep in mind that your 
billing statement may 
vary slightly from the 
information you see 
onscreen. Usage is 
charged based on 
your calling plan, and 
calling plans vary.
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Defining speed dial buttons
Your smartphone lets you create both picture and text speed dial 
buttons. 

Creating a speed dial button
You can create up to 20 picture buttons and 50 text buttons. 

1. Go to your Today screen.
2. Press Menu  and select New 

Speed Dial. 
3. Do one of the following:

• Select Link to contact, select the contact 
you want to link to this button, and then 
select the number you want to dial with 
this button.

• Select Label and enter a name for this 
button, and then select Number and 
enter the phone number you want to dial with this button.

4. (Optional) Enter a Quick Key. When the Today screen is showing, 
you can press and hold the Quick Key to instantly dial this number

5. If this button is linked to a contact entry with a picture, select either 
Text Speed Dial or Picture Speed Dial to indicate which type of 
button you want to create.

Tip
To add a special 
ringtone, assign a 
ringtone to the 
contact associated 
with the speed dial 
button, and then link 
the speed dial button 
to that contact.

Tip
Quick Keys can be 
letters or numbers, 
but you can’t use both 
the letter and number 
for the same key. For 
example, the 
voicemail Quick Key is 
1. The letter 
equivalent for that key 
is E, so you cannot 
assign E as a Quick 
Key to another speed 
dial button.
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6. (Optional) Select the Advanced tab and set 
any of the following options:
• Extra Digits: Defines additional 

numbers to dial, such as a password or 
extension. In addition to numbers, you 
can enter the following symbols: star 
(*) and pound (#). To enter a one 
second pause, enter a comma (,). 

• Dial extra digits automatically: 
Dials predefined Extra Digits 
immediately after dialing the phone 
number. If you do not check this box, you need to press Extra 
Digits  to dial these digits.

• Show voice mail buttons: Displays the voicemail playback 
controls after you dial this speed dial number. When this option 
is checked, you can enter numbers below each control to tailor 
the controls to your voicemail system.

 Plays the previous message.
 Saves the current message.
 Plays the current message.
 Deletes the current message.
 Repeats the current message.
 Plays the next message.

7. Press OK . 
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Editing a speed dial button
1. Go to your Today screen.
2. Highlight the speed dial button you want to edit.
3. Press and hold Center to open the shortcut menu, and then select 

Edit Speed Dial. 
4. Make the desired changes.
5. Press OK . 

Deleting a speed dial button
1. Go to your Today screen.
2. Highlight the speed dial button you want to delete.
3. Press and hold Center to open the shortcut menu, and then select 

Edit Speed Dial. 
4. Press Delete .
5. Select Yes to confirm deletion.

Arranging your speed dial buttons
1. Go to your Today screen.
2. Press Menu  and select Speed Dial 

Options.
3. Highlight the button you want to move.
4. Press Option  + Left  or Right  to 

move the button in that direction.

Tip
The playback controls 
for the Verizon 
Wireless Voicemail 
speed dial button are 
already set up for the 
Verizon Wireless 
voicemail system.
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Using a phone headset
You can connect a phone headset for hands-free operation. If you need 
to use your smartphone while driving and this is permitted in your area, 
we recommend using a phone headset or a hands-free car kit (sold 
separately).

The headset button is context sensitive and it performs different actions 
based on the situation. You can press the headset button to perform any 
of the following tasks:

• Answer an incoming call

• Answer a call waiting call

• Hang up all calls

Tip
To transfer a call 
from a wired headset 
to a Bluetooth 
headset that is within 
range and with which 
you’ve previously set 
up a partnership 
(Bluetooth headset 
required, sold 
separately), unplug 
the wired headset 
and press the button 
on the Bluetooth 
headset. To return to 
the handset or a 
wired headset during 
a call, press Menu 
and select Cancel 
Bluetooth.

Did You Know
If you have both a 
compatible 
Bluetooth headset 
and car kit, the one 
you connected to 
your smartphone last 
becomes the active 
device.

Microphone

Speaker

Headset button
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Headset specifications
Your smartphone works with headsets that have a 2.5mm, 3-pin 
connector. When in doubt, ask the third-party headset manufacturer if 
the product is compatible with Palm Treo 700w smartphones. If you 
hear a headset buzz or poor microphone performance, your headset 
may be incompatible with your smartphone.

Your Treo 700w smartphone is also compatible with many headsets and 
car kits enabled with Bluetooth wireless technology version 1.1 or 1.2. 
Please note, however, that you cannot use a Bluetooth headset to listen 
to MP3 files on your smartphone. 

For a list of compatible hands-free devices with Bluetooth wireless 
technology, go to: www.palm.com/mytreo700wVerizon.

To learn how to set up and connect to Bluetooth devices, see 
“Connecting to devices with Bluetooth® wireless technology” on 
page 97.

Tip
You can use the 
headset that came 
with your 
smartphone or 
compatible third-
party headsets.

Did You Know
To hear stereo 
through the jack (such 
as music), you need 
to use a stereo 
adapter or other 
accessory (sold 
separately). For info 
on compatible audio 
accessories, visit 
www.palm.com/
mytreo700wVerizon. 

Tip
The headset designed 
for Treo 180/270/300 
smartphones is not 
compatible with the 
Palm Treo 700w 
smartphone.

http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
http://www.palm.com
http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
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Staying Organized

Contacts

Adding a contact
1. Press Start  and select Contacts.
2. Press New .
3. Use the 5-way navigator to move between 

fields as you enter information.
4. To add a caller ID picture that displays 

when that person calls, select Picture, 
and then select Camera and take a 
picture, or select an existing picture from 
the Thumbnail screen. 

5. To assign the entry to one or more 
categories, select Categories and then check the categories under 
which you want this entry to appear.

6. To add a note to an entry, select the Notes tab.
7. To assign a ringtone to the entry, select Ring tone and select a tone.
8. After you enter all the information, press OK . 

Before You Begin[ ! ]
If you have many 
contacts to enter, it’s 
best to enter them in 
Microsoft Outlook on 
your computer and 
then sync. See 
“Synchronizing 
contacts and 
other info” on 
page 28 for details.

Tip
You can also open 
Contacts from your 
Today screen. Press 
Menu and select 
Contacts.

Tip
Be sure to enter 
mobile numbers and 
email addresses in the 
correct fields. 
Otherwise the 
Messaging 
application can’t find 
this info when you 
address a message 
and the Calendar 
application can’t find 
your contacts to invite 
them to meetings.
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Viewing or changing contact information
1. In the Contacts list (name view), begin entering one of the following 

for the contact you want to view or edit:
• First name
• Last name
• Phone number

2. Select the entry you want to open.
3. Press Menu  and select Edit.
4. Make changes to the entry as necessary.
5. Press OK .

Deleting a contact
1. In the Contacts list, highlight the contact you want to delete.
2. Press Menu  and select Delete Contact.
3. Select Yes.

Customizing Contacts
1. Go to the Contacts list.
2. Press Menu  and select Options.
3. Set any of the following options:

• Show alphabetical index: Displays the alphabetical index at 
the top of the Contacts list. You can use this index to find a 
contact.

• Show contact names only: Lets you fit more names on the 
Contacts list by hiding everything but the contact’s name.

• Area code: Sets the default area code for new contact entries.
4. Press OK .

Tip
In the Contacts list, 
press Up and Down to 
move to the previous 
or next contact.

Did You Know
You can find a contact 
by company name. 
Press Menu and select 
View By > Company. 
Select a company 
name to see the 
contacts who work 
there.

Tip
To view a particular 
group of contacts, 
press Menu, select 
Filter, and then select 
the category you want 
to view.
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Calendar

Displaying your calendar
1. Press Start  and select Calendar.
2. Press Menu  and select View.
3. Select one of the following views:

• Agenda: Shows your daily schedule in list format. Upcoming 
appointments are bold, past appointments are dimmed.

• Day: Shows your daily schedule in day-planner format.
• Week: Shows your schedule for an entire week.
• Month: Shows your schedule for a whole month. 

 A morning appointment. 
 An afternoon appointment. 
 There are both morning and evening appointments. 
 An all day event.

• Year: Shows a calendar for a 6-month period.
4. Use the 5-way to move to another day, week, month, or year (based 

on the current view).

Before You Begin[ ! ]
If you have several 
appointments to 
enter, it’s most 
efficient to enter them 
in Microsoft Outlook 
on your computer 
and then synchronize 
your smartphone 
with your computer. 
For more information, 
see “Synchronizing 
contacts and 
other info” on 
page 28.
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Creating an appointment
1. Press Start  and select Calendar.
2. Press Menu  and select New 

Appointment.
3. Enter a Subject (description) and a 

Location.
4. Select Starts and select the starting date 

and time.
5. Select Ends and select the ending date 

and time.
6. Press OK . 

Creating an untimed event
An untimed event, such as a birthday, anniversary, or vacation does not 
occur at a particular time. These events appear as banners at the top of 
your calendar; they don’t occupy blocks of time. 

1. Press Start  and select Calendar.
2. Press Menu  and select New 

Appointment.
3. Enter a Subject (description).
4. Select the starting and ending dates.
5. Select All Day, and then select Yes.
6. Press OK . 

Tip
To pencil in an 
appointment, open 
the appointment, 
select Status, and then 
select Tentative.

Did You Know
An untimed event can 
last longer than a day.
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Scheduling a repeating appointment
1. Create an appointment or untimed event, and then select it.
2. Press Edit .
3. Select Occurs, and then select a repeat pattern. To create a repeat 

pattern, select Edit pattern and follow the onscreen instructions. 
4. Press OK .

Adding an alarm reminder to an event
1. Create an event, and then select it.
2. Press Edit .
3. Select Reminder, and then select Remind Me.
4. Enter the number of minutes, hours, days, or weeks before 

the event you would like to receive the alarm.
5. Press OK .

Tip
To enter a birthday or 
an anniversary, create 
an untimed event that 
repeats every year.

Tip
You can also add an 
alarm when you 
create the event. 

Type of time units

Number of time units
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Sending a meeting request
You can email meeting invitations to contacts who use Outlook or 
Outlook Mobile. 

1. Create an event, and then select it.
2. Press Edit . 
3. Select Attendees, and then select the name of the contact you want 

to invite. To invite other attendees, select Add and select the names. 
4. Press OK .

The next time you synchronize, the meeting request is sent to the 
attendees. When attendees accept your meeting request, the meeting is 
automatically added to their schedules. When you receive their 
response, your calendar is updated as well.

Marking an event as sensitive
If other people have access to your Outlook calendar on your computer 
and you don’t want them to see an appointment, you can mark that 
appointment as private to hide it from other Outlook users.

1. Create an event, and then select it.
2. Press Edit .
3. Select Sensitivity, and then select one of the following:

• Private: Displays the event on your smartphone and on your 
computer. Meeting attendees or recipients see “Please treat this 
as Private” near the top of an open appointment. If you sync with 
Exchange Server, other users who can access your folders can’t 
see your private events, they see private events as unavailable 
time slots. 

Before You Begin[ ! ]
Create contact entries 
with email addresses 
for the people you 
want to invite to a 
meeting. You can’t 
access contact entries 
without email 
addresses from your 
calendar.

Tip
If you don’t see an 
option on the screen, 
press Down to scroll 
to other options. For 
example, when 
editing an event, you 
don’t see the 
Sensitivity option 
until you scroll toward 
the bottom of the 
entry.
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• Personal: Displays the event on your smartphone and on your 
computer. Meeting attendees or recipients see “Please treat this 
as Personal” near the top of an open appointment. 

• Confidential: Displays the event on your smartphone and on 
your computer. Meeting attendees or recipients see “Please treat 
this as Confidential” near the top of an open appointment. 

4. Press OK .

Organizing your schedule
Use categories to view different types of events. 

1. Create an event, and then select it.
2. Press Edit .
3. Select Category, and then check the 

categories which apply to this event. To 
add a new category, press New , 
enter the category name, and then press 
OK .

4. Press OK  two more times.
5. After you assign events to categories, 

press Menu  and select Filter.
6. Select the type of events you want to view.

Deleting an event
1. Highlight the event you want to delete.
2. Press Menu  and select Delete Appointment.
3. Select Yes.
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Customizing Calendar
1. Press Menu  and select Options.
2. On the General tab, set any of the 

following options:
• 1st day of week: Sets Sunday or 

Monday as the first day of the week 
for all Calendar views.

• Week view: Sets whether five, six, or 
seven days appear in Week View.

• Show half hour slots: Sets whether 
time slots appear in one hour or half-
hour increments in Day View and Week View.

• Show week numbers: Sets whether week numbers (1–52) 
appear in Week View.

3. Select the Appointments tab and set any 
of the following options:
• Set reminders for new items: Sets 

whether a reminder is automatically 
added to new events and how long 
before the event the reminder appears. 
You can override this setting for 
individual events.

Tip
Not all icons appear in 
all Calendar views.



数码说明书之家—WWW.54GG.COM
Using Your Treo 700w Smartphone 63

Calendar CHAPTER 4

• Show icons: Sets which icons appear next to events. 
 The event has a reminder.
 The event repeats in a specified pattern.
 The event has a note attached.
 A location has been assigned to the event.
 The event is a meeting.
 The event is marked private.

• Send meeting requests via: Sets the Messaging method used 
to send meeting requests: email, MMS, or SMS.

4. Press OK .
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Tasks 
You can use Tasks to remind you of tasks you need to complete and to 
keep a record of completed tasks. 

Adding a task
1. Press Start  and select Programs.
2. Select Tasks .
3. Press New .
4. Enter a description of the task as the Subject.
5. Set any of the following: 

• Priority: Sets the priority level for this 
task. Later you can arrange your tasks 
based on the importance of each task.

• Status: Indicates whether the task is 
now completed.

• Starts: Specifies when the task 
begins.

• Due: Sets the due date for the task.
• Occurs: Indicates if the task repeats 

at regular intervals and how often it 
repeats.

• Reminder: Sets an alarm for this task and indicates when you 
want to be reminded.

• Categories: Assigns the task to one or more categories.
• Sensitivity: Marks this task as Normal, Personal, Private, or 

Confidential.
• Notes: Lets you enter additional text for the task.

6. Press OK .

Tip
You can also add a 
task by selecting the 
Tasks entry bar at the 
top of the screen.
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Checking off a task
1. Select the task you want to check off.
2. Press Edit .
3. Select Status and select Completed.
4. Press OK .

Organizing your tasks
1. In the Tasks list, press Menu  and 

select Filter.
2. Select which tasks you want to view: All Tasks, Recently Viewed, 

No Categories, Active Tasks, Completed Tasks, or a specific 
category, such as Business or Personal.

3. Press Menu  and select Sort By.
4. Select the sort method: Status, Priority, Subject, Start Date, or 

Due Date.

Tip
You can also mark a 
task complete by 
tapping the check box 
next to the task on the 
Tasks list.

Did You Know
Overdue tasks appear 
in red.
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Deleting a task
1. Highlight the task you want to delete.
2. Press Menu  and select Delete Task.
3. Select Yes.

Customizing Tasks
1. Go to the Tasks list.
2. Press Menu  and select Options.
3. Set any of the following options:

• Set reminders for new items: Automatically adds a reminder 
to new tasks. The default reminder is set to 8:00 on the morning 
the task is due. You can override this setting for individual tasks.

• Show start and due dates: Displays task start and due dates in 
the Tasks list.

• Show Tasks entry bar: Displays the Tasks entry bar at the top 
of the Tasks list.

4. Press OK .
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Notes
Notes are a great way to capture thoughts, questions, and meeting 
notes on your Palm Treo 700w smartphone. 

Creating a note
1. Press Start  and select Programs. 
2. Select Notes .
3. Press New .
4. Do one of the following:

• Type the text with the keyboard. 
• Write the text with the stylus.
• Draw a sketch with the stylus, 

crossing at least three ruled lines.
5. Press OK .

Recording a voice note
You can create a new voice note or add a recording to an existing note. 

1. Press Start  and select Programs.
2. Select Notes .
3. To add a recording to a note, open the 

note you want to add the recording to. To 
create a new voice note, skip this step.

4. Press Menu  and select View 
Recording Toolbar.

5. Select  to begin recording. 

Tip
To quickly create a 
recording, press the 
Side button. When 
you hear the beep, 
begin your recording. 
Release the button 
when you are 
finisheDd.

Did You Know
You can add several 
voice notes within a 
single note.
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6. Speak into your smartphone's microphone or hold it close to 
another sound source.

7. When you finish recording, select  to stop recording. A Recording 
icon appears in the note or note list, depending on where you 
recorded the note. 

8. Press OK .

Creating a note from a template
1. Go to the Notes list. 
2. Select the Show list in the upper-left, and then select Templates.
3. Open the template you want to use.
4. Enter the information.
5. Press OK .
6. Rename the note and move it to the appropriate folder. See 

“Organizing your notes” on page 68 for details.

Organizing your notes
You can rename your notes, move notes to another folder, and move 
notes between your smartphone and an expansion (storage) card.

1. Go to the Notes list and highlight a note you want to move.
2. Press Menu  and select Rename/Move.
3. Select Name, and then enter a new name for the note.
4. Select Folder, and then select the folder you want to store the note.
5. Select Location, and then select Main memory or Storage Card.
6. Press OK .

Tip
To play a recording, 
select the voice note 
in the Notes list or 
open the note 
containing the 
recording and select 
the Recording icon.

Tip
To create a new 
template, open the 
note you want to save 
as a template. Press 
Menu and select 
Rename/Move. Select 
Name, and then enter 
a name for the 
template. Select the 
Show list, and then 
select Template. 
Press OK.
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7. Select the Show list in the upper-left, and then select the folder you 
want to view.

8. Select the Sort By list in the upper-right, and then select whether 
you want to sort your notes by Name, Date, Size, or Type.

Deleting a note
1. Go to the Notes list and highlight the note you want to delete.
2. Press Menu  and select Delete.
3. Select Yes.

Customizing Notes
1. Go to the Notes list.
2. Press Menu  and select Options.
3. Set any of the following options:

• Default mode: Sets the default entry mode to Writing or 
Typing.

• Default template: Sets the default template for new notes.
• Save to: Sets the default location where new notes are stored.
• Record button action: Sets whether the Side button opens the 

Notes application or stays in the current application.
4. Press OK .

Tip
To create a new folder, 
go to the Notes list, 
select the Show list in 
the upper-left, and 
then select Add/
Delete. Select New, 
enter a name for 
the folder, and then 
press OK.
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Calculator
You can use Calculator for basic arithmetic 
calculations, such as addition, subtraction, 
multiplication, and division. 

Performing calculations
1. Press Start  and select Programs.
2. Select Calculator .
3. Enter numbers and perform calculations, 

including the following:
 Clears the last digit in a multi-digit 

entry.
 Clears the current calculation or the displayed number.
 Calculates the reciprocal of a number.
 Calculates percentage.
 Calculates the square root of a number.
 Switches a number between negative and positive.

Using the Calculator memory
• To store a number, select the box to the left of the entry box. An M 

appears in the box. 

• To add the displayed number to the number stored in memory, 
select . 

• To display the number stored in memory, select . 

• To clear the memory, select . 

Tip
You can tap the 
screen or use the 
keyboard to input 
numbers.

Did You Know
When you store a 
number in memory, it 
replaces the one that 
is currently stored.

Tip
To paste a number 
you copied in another 
application, press 
Edit and select Paste. 
To copy a number, 
press Edit and select 
Copy. You can paste 
the copied number in 
another application.

Tip
For more advanced 
calculations, use 
Excel Mobile. See 
“Excel Mobile” on 
page 128 for details.
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Sending and receiving messages 
and email
You can use the Messaging application to exchange email, brief text 
messages (SMS), and multimedia messages (MMS) with other mobile 
devices and email addresses that support these forms of messaging. 
You can also exchange instant messages (IM) with MSN Pocket. Before 
you use your smartphone to send or receive messages, consult Verizon 
Wireless for pricing and availability of email, text, multimedia, and IM 
messaging services.

Creating and sending a text message
Each text message can hold up to 160 characters. To save time, you can 
select from predefined My Text phrases, such as “Call me” or “On my 
way.” You can add your own My Text phrases, and if you prefer, you can 
enter the full message text too.

1. Go to your Today screen.
2. Press Messaging .
3. Press Left  until you see Text Messages in the title bar.
4. Press New .

Before You Begin[ ! ]
Make sure your 
phone is on (see 
“Turning your phone 
on and off” on 
page 11) before you 
send or receive 
messages. 

Did You Know
When addressing a 
message, you can 
enter the first few 
numbers of a 
contact’s mobile 
phone number or the 
contact’s first and last 
initials separated by 
a space.

Tip
To address a mes-
sage to multiple re-
cipients, separate the 
addresses with a 
semicolon (;). If you 
address a single text 
or multimedia mes-
sage to three people, 
you are billed for 
three messages.
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5. Do one of the following to address the 
message:
• If the recipient’s name and mobile 

number are in your Contacts list, 
press Center, enter the first few letters 
of the first or last name, and then 
select the name.

• If the recipient’s name and mobile 
number are not in your Contacts list, 
enter the full mobile number. 

6. Enter your message, or press 
Menu , select My Text, and then select a predefined phrase 
you want to insert. 

7. (Optional) Press Menu  and select Spell Check.
8. (Optional) Press Menu  and select Message Options. Enter a 

callback number and then select OK.
9. Press Send .

Creating and sending a multimedia message
Multimedia messages consist of pictures, videos, text, and sounds 
presented as one or more slides. Even if your smartphone does not 
include a camera, you can still send, receive, and view pictures and 
videos. You can include any of the following items: 

Ringtones

• MIDI

Did You Know
You can send and 
receive text messages 
even while you are on 
a phone call. This is 
easiest when using a 
hands-free headset or 
the speakerphone.

Tip
Some symbols can’t 
be used in text 
messages. Invalid 
characters are 
automatically 
replaced by the 
Messaging 
application.

Tip
To add a new My Text 
phrase, select Edit My 
Text Messages in the 
list. 
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Sound clips

• WAV
• QCELP

Pictures

• JPEG
• GIF
• BMP

Videos

• 3GPP2

1. Go to your Today screen.
2. Press Messaging .
3. Press Left  until you see MMS in the title bar.
4. Press New .
5. Do one of the following to address the 

message:
• If the recipient’s name and mobile 

number or email address are in your 
Contacts list, press Center, select Add 
Recipient, enter the first few letters of 
the recipient’s first or last name, and 
then select the recipient’s name.

• If the recipient’s name and mobile 
number or email address are not in 
your Contacts list, enter the full mobile number or email address. 

• If you want to upload a picture or video to your Verizon Wireless 
PIX Place account, press Center, and then select PixPlace.

Did You Know
A multimedia 
message can contain 
up to 350KB that 
consists of multiple 
items (up to 16 
slides). 

Tip
While creating a 
message, select the 
arrows at the bottom 
of the screen to move 
between slides.
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6. Select Subject and enter a title for the message.
7. Select New Slide.
8.  Press Center and select one of the following:

• Add Picture: Lets you insert a picture. You can take the picture 
with the built-in camera or insert an existing picture.

• Add Video: Lets you insert a video. You can capture a video 
with the built-in camera or insert an existing video clip. If you 
insert a video, you cannot add a sound to the same slide; to send 
a sound, add another slide to your message.

• Add Sound: Lets you record a message, such as a voice caption 
for a picture, or insert an existing sound, such as a ringtone. You 
can add one sound per slide; to send more than one sound in a 
message, add another slide to your message. If you capture a 
picture with the built-in camera and save it with a voice caption, 
the voice caption does not count as a sound file. 

9. Enter a text caption or message for the item you inserted.
10. Select Next  and repeat steps 8–9 to add other items in this 

message.
11. (Optional) Select Play  to view the message as the recipient will 

see it.
12. When you’re done creating the message, press OK .
13. Press Send .

Setting up an email account
You can use your smartphone to access several types of email 
accounts. Before you set up your email account on your smartphone, 
you must determine which type of account you want to access, as the 
steps vary for each of the following account types:

Did You Know
If you are out of a 
coverage area or if 
your phone is off, your 
outgoing messages 
go into the Outbox. 
When you return to a 
coverage area, your 
pending messages are 
sent automatically 
and transferred to the 
Sent folder.

Before You Begin[ ! ]
If your email account 
requires a VPN 
connection to 
establish a secure 
connection, you must 
install a VPN 
application on your 
smartphone before 
you can access 
your email. See 
“Connecting to a 
VPN” on page 186 
for more info.
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• Exchange Server: Enables you to wirelessly synchronize your email 
and other information directly with the information stored on a 
Microsoft Exchange 2003 Server.

• Wireless Sync: Enables you to use a Verizon Wireless Sync account 
to wirelessly synchronize your email and other information with the 
information stored on your computer (Verizon Wireless Sync account 
required, additional charges may apply).

• IMAP or POP: Enables you to send and receive email messages with 
a corporate email account or an account that you have with an 
Internet service provider (ISP).

• Hotmail: Enables you to send and receive email messages with an 
MSN Hotmail account. See“Using Pocket MSN” on page 90 for 
information on setting up an MSN Hotmail account.

Setting up an Exchange Server email account
You can use your smartphone to sync directly with Exchange Server. 
You may have already set up your Exchange Server email settings when 
you installed the ActiveSync® desktop software. If you did not set up an 
Exchange Server email account, follow the steps in this section to set up 
an account now.

1. Press Start  and select Programs.
2. Select ActiveSync .
3. Press Menu  and select Add Server Source. 
4. Enter the Server address, and then press Next . 
5. Enter your username, password, and domain. 

Tip
If you already set up 
an Exchange Server 
account, Add Server 
Source does not 
appear on the menu; 
Configure Server 
appears on the menu 
instead.

Tip
The Exchange Server 
settings are case 
sensitive. Be sure to 
enter uppercase and 
lowercase letters 
properly.

Tip
Ask your network 
administrator if it is 
OK to store your 
corporate email 
password on your 
smartphone. You 
may need to enter 
your password each 
time you access your 
email for increased 
security.
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6. If you want to enter your password each time you access this 
account, do not check the Save password box. If you want your 
password entered automatically, check this box.

7. (Optional) Select Advanced to set the rules for fixing sync conflicts.

8. Press Next  and check the boxes for 
the types of information you want to 
synchronize with Exchange Server. 

9. (Optional) Highlight one of the 
information types and select Settings to 
change the synchronization settings for 
that type of information. 

10. Press Finish . 

Tip
If you have problems 
sending mail, try 
entering using the 
following settings:

SMTP server: 
smtp.vzwmail.net

Username: (9-digit 
phone 
number)@vzmail.net

Password: (Your 
www.vtext.com 
password)
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Setting up a Wireless Sync email account
Wireless Sync lets you sync your email and other information when 
you’re away from your computer. To use Wireless Sync, you must first 
install the desktop synchronization software that came with your 
smartphone, and you must subscribe to Verizon Wireless’s Wireless 
Sync feature (additional charges may apply).

1. If you haven’t already done so, go to 
http://www.wirelesssync.vzw.com and follow the onscreen 
instructions to do the following:
• Create your Wireless Sync account
• Indicate which email accounts you want to use with this feature
• Install the Wireless Sync desktop software

2. Press Start  and select Programs.
3. Select Wireless Sync .
4. Select Sync near the top of the screen.
5. When prompted, scribble on the screen to generate a unique 

encryption key for your smartphone. Continue scribbling until the 
progress bar fills and synchronization continues.

6. When the First Synchronization dialog box appears, do one of the 
following based on the type of email account you set up:
• Corporate email or Both: Select Refresh.
• Internet email: Select Merge.

7. When the Authentication dialog box appears, enter the password 
for your Wireless Sync account.

Before You Begin[ ! ]
Make sure your phone 
is on (see “Turning 
your phone on and 
off” on page 11).

Tip
By default, wireless 
synchronization 
occurs whenever 
information changes 
in Outlook. To 
customize your 
Wireless Sync 
settings, select Setup 
at the bottom of the 
screen, and then 
select Push/
ReadySync.

http://http://www.wirelesssync.vzw.com
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Setting up an IMAP or POP email account
You can send and receive email messages with an email account that 
you have with an Internet service provider (ISP), an email account that 
you access using a VPN server connection (such as a work account), or 
any other IMAP (Internet Message Access Protocol) or POP email 
account. 

1. Go to your Today screen.
2. Press Messaging .
3. Press Menu  and select Tools > New Account.
4. Enter the email address that you want to set up, and then press 

Next .
5. Wait until the Status box displays Completed, and then press 

Next .
6. Enter your name, username, and password.
7. If you want to enter your password each time you access this 

account, do not check the Save password box. If you want your 
password entered automatically, check this box.

8. Press Next .
9. Select the Account type list, and then select the protocol for this 

account.

Before You Begin[ ! ]
Work with your 
system administrator 
to gather the 
following info:

• Account type (POP3 
or IMAP)

• Mail server name 
for receiving mail

• Mail server name 
for sending mail

• Your username and 
password

• Port number (if 
required by server)

• Any special security 
requirements
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10. Enter a name for this account, and then press Next .

11. Enter the name of the Incoming mail and 
Outgoing mail servers and the Domain.

12. (Optional) Select Options to select 
download settings for this account.

13. Press Finish .
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Creating and sending an email message
1. Go to your Today screen.
2. Press Messaging .
3. Press Left  until you see the email account you want to use in the 

title bar.
4. Press New .
5. Do one of the following to address the 

message:
• If the recipient’s name and email 

address are in your Contacts list, 
enter the first few letters of the 
recipient’s first or last name, and then 
select the recipient’s name.

• If the recipient’s name and email 
address are not in your Contacts list, 
enter the full phone number or email 
address. 

6. Select Subject and enter a title for the message.
7. Enter your message, or press Menu , select My Text, and then 

select a predefined phrase you want to insert. 
8. (Optional) Do any of the following:

• Press Menu  and select Insert. Select the type of item you 
want to attach, and then select the file or record a voice note. 

• Press Menu  and select Spell Check.
• Press Menu  and select Message Options. Select the Priority 

list, select a setting for the message, and then press OK .
9. Press Send .

Tip
Not ready to send 
that message yet? 
You can save it 
without sending it. 
While creating a 
message, press 
Menu and select Save 
to Drafts. To access 
the draft, select the 
Show list in the 
upper-left, and then 
select Drafts. 

Did You Know
You can also access 
the Messaging 
application from the 
Start menu.
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Using an online address book
Many email servers, including servers running Exchange Server, can 
verify names with an online address book, also called a directory 
service. After you create and enable an email account, Messaging 
checks your contact list and then the directory service to verify names 
that you enter in the To, Cc, and Bcc fields. 

1. In the message list, press Menu  and select Tools > Options.
2. Select the Address tab. 
3. Select the address book you want to check for email addresses, and 

then select Add. 
4. Enter the name of the Directory service.
5. Enter the Server name.
6. If your server requires authentication, check the box, and then enter 

your username and password. 
7. (Optional) Check the Check name against this server box to enable 

this directory service.
8. Select OK.

Receiving text and multimedia messages
When your phone is on and in a wireless coverage area, you 
automatically receive new text messages. For multimedia messages, 
you can set your smartphone to automatically download new messages 
or to notify you that messages are ready to download. You can also 
set your smartphone to notify you when a new text or multimedia 
message arrives.

Before You Begin[ ! ]
Ask your network 
administrator for the 
name of the directory 
service and the server, 
and whether 
authentication is 
required to access an 
online address book.

Tip
To delete a directory 
service, highlight it, 
press and hold Center, 
and select Delete.

Tip
When you sync your 
Outlook E-mail 
account, disable your 
online address books 
to avoid errors. Press 
Menu and select Tools 
> Options. Select 
Address and uncheck 
the Check name 
against this server 
box. 



数码说明书之家—WWW.54GG.COM
82 Using Your Treo 700w Smartphone

CHAPTER 5

The new message notification may include any of the following options:

• View: Opens the message so you can view its full contents.

• Download: Downloads the rest of the message from the server. 

• Reply: Opens a message addressed to the sender’s phone number.

• Dismiss: Closes the notification and puts the message in your Inbox.

• Menu: Opens a menu where you can select other options.

Viewing/playing a multimedia message
1. Go to your Today screen.
2. Press Messaging .
3. Press Left  until you see MMS in the title bar.
4. From the Inbox, select the message you 

want to view. 
5. If you’re viewing the message for the first 

time, playback begins automatically. 
Otherwise, select an item to play.
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6. Do any of the following:
• Go the previous or next slide: Tap Previous  or Next .
• Pause or resume playback: Tap Pause  or Play . 
• Save the item that is playing: Press Menu  and 

select Save.
• Go to the top of the message: Press Menu  and select 

Message Overview.
• Reply to the message: Press Menu  and select Reply or 

Reply All.
• Call the sender: Press Menu  and select Call Sender.
• Save the message as a template for other messages: Press 

Menu  and select Save to Template.
7. Press OK .

Synchronizing your default email account
To send and receive messages for your default email account, simply 
synchronize your smartphone with your computer. See “Setting the 
synchronization schedule” on page 148 for details. During 
synchronization, new messages are copied to your smartphone’s Inbox, 
and messages in the smartphone’s Outbox are sent.

Synchronizing your other email accounts
To send and receive email messages for additional email accounts, such 
as an Internet Service Provider (ISP) account or an account that you 
access using a VPN server connection (typically a work account), follow 
these steps:

1. Go to your Today screen.
2. Press Messaging .

Tip
Your computer must 
be connected to the 
Internet when you 
sync your email.
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3. Press Left  until you see the account you want to download in the 
title bar.

4. Press Menu  and select Send/Receive to synchronize your 
smartphone with your email server.

Receiving attachments
1. Select the attachment (below the subject) to mark it for download.
2. Synchronize the email account that contains the message as 

described in the previous sections.
3. Select the attachment to open it.

If you have an Outlook E-mail account and want to download 
attachments automatically, do the following: 

1. Press Start  and select Programs.
2. Select ActiveSync .
3. Press Menu  and select Options. 
4. Select E-mail, and then select Settings.
5. Check the Include file attachments box. 
6. Press OK .

To automatically download attachments from an IMAP4 email account 
(typically an ISP account) or an account that you access using a VPN 
server connection (typically a work account), do the following: 

1. Go to your Today screen.
2. Press Messaging .
3. Press Menu  and select Tools > Options.
4. On the Accounts tab, select the IMAP4 account name. 

Did You Know
By default, email 
messages you send 
are saved in the Sent 
folder. If you want to 
save memory on your 
smartphone, you can 
turn this option off. In 
the Messaging list, 
press Menu and 
select Tools > 
Options. Select 
Message, and then 
uncheck the Keep 
copies of sent items 
in Sent folder box.
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5. Press Next  until you reach Server information, and then select 
Options. 

6. Press Next twice, and then select Get full copy of messages and 
When getting full copy, get attachments. 

Using links in messages
When you receive a text message that contains a telephone number, 
email address, or URL, you can dial the number, send an email 
message, or go to the web page immediately. Your smartphone 
automatically opens the appropriate application from the link.

1. Select a message in the list.
2. Select the phone number, email address, or URL (appears as 

underlined blue text).

Forwarding a message
1. Open the message you want to forward.
2. Press Menu  and select Forward.
3. Address the message and enter any text you want to add.
4. Press Send .

Did You Know
Embedded images 
and objects cannot be 
received as 
attachments, unless 
you have an IMAP4 
email account with 
TNEF disabled. Note 
that TNEF must be 
enabled to receive 
meeting requests.

Tip
To store attachments 
on an expansion card, 
press Menu, select 
Tools > Options. Select 
Storage and then 
check the Store 
attachments on a 
storage card box.



数码说明书之家—WWW.54GG.COM
86 Using Your Treo 700w Smartphone

CHAPTER 5

Managing your messages
The status icons that appear next to each message in the Inbox and 
Outbox indicate the following:

 An unread text message.

 An unread message with pictures or videos. 

 An unread message with sound. 

 A read text message. 

 A read message with pictures or videos.

 A read message with sound.

 An urgent message. This icon appears below the message size on 
the right side of the screen.

 A message that was delivered (Sent folder only). 

You can rearrange the messages in any folder or account. 

1. Go to the Messaging account you want to arrange.
2. Select the Sort by list in the upper-right, and then select the sort 

method you want to use.

You can delete several messages at once from any folder.

1. Go to the Messaging account you want to delete the 
messages from.

2. Highlight the message(s) you want to delete. To select multiple 
messages, tap and drag the stylus across the messages. 

3. Press Menu  and select Delete.
4. Select Yes to move the items to the Deleted Items folder.

Tip
Unread messages 
appear in bold. 
Messages you’ve 
read appear in 
plain text. 

Did You Know
If you are working 
offline, messages that 
you deleted from the 
server are deleted 
from your 
smartphone the next 
time you connect or 
according to the 
options you selected.

Tip
To permanently 
remove messages 
from the Deleted 
Items folder, press 
Menu and select 
Tools > Empty 
Deleted Items.
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Adding a signature to your messages
You can use a different signature with each Messaging account.

1. Go to the Messaging list.
2. Press Menu  and select Tools > Options.
3. On the Accounts tab, select Signatures.
4. Select the account you want to create a 

signature for.
5. Check the box to add this signature to new 

messages you create with this account.
6. (Optional) Check the box to add this 

signature to messages you reply to or 
forward with this account.

7. Select the default signature text and enter 
the signature text you want to use.

8. Press OK .

Customizing your Messaging settings
1. Go to the Messaging list.
2. Press Menu  and select Tools > 

Options.
3. Select the Message tab and set any of the 

following options:
• When replying to e-mail, include 

body: Indicates if the body of a 
message you received appears in your 
response to that message.



数码说明书之家—WWW.54GG.COM
88 Using Your Treo 700w Smartphone

CHAPTER 5

• Keep copies of sent items in Sent folder: Indicates if 
messages you send are stored in the Sent folder.

• After deleting or moving a message: Specifies what you 
want to appear after you delete or move a text or email message.

4. Select the Address tab and set any of the following options:
• In Contacts, get e-mail addresses 

from: Indicates whether you want to 
check Contacts in addition to any 
directory services for email addresses.

• Verify names using these address 
books: Indicates which directory 
services you want to check for email 
addresses.

• Add: Lets you add directory services 
to the list of address books.

5. Select the Storage tab and set any of the 
following options:
• Store attachments on storage 

card: Indicates whether you want to 
automatically store email attachments 
on an expansion card.

• Empty deleted items: Indicates 
whether you want to automatically 
empty the Deleted folder, and when 
you want this to occur.

6. Press OK .
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Customizing your multimedia messaging settings
1. Go to the Messaging list.
2. Press Menu  and select Tools > 

Options.
3. On the Accounts tab, select MMS.
4. Set any of the following options: 

• Automatically Collect Messages: 
Indicates if you want to automatically 
receive multimedia messages.

• Confirm Message Deletion: 
Indicates if you want deletion 
confirmation messages to appear.

Customizing your text messaging settings
1. Press OK . 
2. Go to the Messaging list.
3. Press Menu  and select Tools > 

Options.
4. On the Accounts tab, select Text 

Messages.
5. If you want to receive a notification when 

your text messages are delivered, check 
this box.

6. Press OK . 
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Using Pocket MSN
Pocket MSN provides quick access to the following:

• MSN Hotmail: Lets you read, write, send, and delete email. You can 
also manage your Hotmail folders.

• MSN Messenger Contacts list: Lets you see who’s online and 
exchange instant messages (IM). Subscribe to status updates for 
selected contacts so you’re notified when they’re online.

• Options: Lets you customize your Pocket MSN experience.

Signing in to Pocket MSN
1. Press Start  and select Pocket MSN.
2. Select MSN Mobile Home.
3. Select Sign in.
4. Enter the email address and password 

for your Passport account or your 
Hotmail account. 
• To create a Passport (IM) account, go 

to www.passport.com.
• To create a Hotmail account, go to 

www.hotmail.com.

Before You Begin[ ! ]
You must subscribe 
to data services from 
Verizon Wireless.

Did You Know
You can add Pocket 
MSN to your Today 
screen. See 
“Selecting which 
items appear on your 
Today screen” on 
page 158 for details.

Tip
When you set up a 
Pocket MSN Hotmail 
account, you can 
access that account in 
the Messaging 
application. To access 
your instant 
messages, use the 
MSN application or 
the MSN plug-in on 
the Today screen.

http://www.passport.com
http://www.hotmail.com
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Browsing the web
Internet Explorer Mobile provides quick and easy access to web pages. 
You can view most sites you use on your computer, including those 
with security and advanced features, such as JavaScript and frames. To 
browse the web, you must subscribe to data services from Verizon 
Wireless. 

Viewing a web page
By default, Internet Explorer Mobile scales web page content to fit your 
smartphone screen so that you can view most of the information 
without scrolling left or right.

1. Make sure your phone is on (see 
“Turning your phone on and off” on 
page 11).

2. Press Start  and select Internet 
Explorer.

3. Highlight the address line, enter the 
address of the web page you want to 
view, and then press Center. 

4. Press Menu , select View, and then 
select any of the following:
• One Column: Arranges web pages into one column that is as 

wide as the screen, so that you don’t have to scroll horizontally. 
• Default: Maintains a layout similar to what you see on a desktop 

computer, but it makes items smaller and arranges the content 
so that you can see most of it without scrolling horizontally. 

• Desktop: Keeps the same layout and size as on a desktop 
computer, which requires both horizontal and vertical scrolling.

Did You Know
You can also start a 
web search from your 
Today screen by 
selecting the Google 
Lookup field, entering 
the item you want to 
find, and then 
pressing Center. 

Tip
To return to a recently 
viewed page, select 
the address line list, 
and then select the 
web address.

Tip
If you browse to a 
secure web page, the 
Lock icon in the 
address line appears 
closed instead of 
open.



数码说明书之家—WWW.54GG.COM
92 Using Your Treo 700w Smartphone

CHAPTER 5

• Full Screen: Hides the status and navigation areas and fills the 
entire screen with the web page. To exit full screen mode, press 

, or tap and hold anywhere on the screen and uncheck 
Full Screen.

• Show Pictures: Shows or hides pictures on web pages. Hiding 
pictures speeds up the time it takes to load pages. 

5. Do any of the following:
• To view the previous page, press Back .
• To refresh the page with the latest content from the Internet, 

press Menu  and select Refresh.
• To scroll through the page in One Column View or Default View, 

press Up  or Down . In Desktop View, press Up , Down , 
Left , or Right  to scroll in all directions.

• To follow a link to another web page, press Up  or Down  to 
highlight the link, and then press Center to go to the selected 
page. You can also tap the link on the screen with your stylus.

• To adjust the size of the text on web pages, press Menu , 
select Zoom, and then select the size you want.

• To view a web page’s properties, press Menu  and select 
Tools > Properties.

6. Press OK  to close Internet Explorer Mobile.

Did You Know
You can send email 
from a web page. 
Email addresses 
appear as links on 
web pages. After you 
configure an email 
application on your 
smartphone, you can 
select an email link to 
create a message to 
that address.

Tip
To send a link, press 
Menu and select Tools 
> Send Link via E-
mail. Select the 
Messaging account 
you want to use to 
send the link.
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Creating a favorite
Favorites let you bookmark a web page so that you can instantly access 
it without entering the web address. 

1. Go to the page you want to mark as 
a favorite. 

2. Press Menu  and select Add to 
Favorites.

3. (Optional) Select Name and enter a 
different description.

4. (Optional) Select the folder where you 
want to create the favorite.

5. Select Add.

Viewing a favorite
1. Press Start  and select Internet Explorer.
2. Press Favorites .
3. Select the page you want to view in the list.

Tip
Create the folders 
where you want to 
store your favorites 
first. Once you create a 
favorite, you can’t 
move it to another 
folder.

Tip
To delete a favorite or 
folder, press Menu 
and select Favorites. 
Select the Add/Delete 
tab, highlight the item 
you want to delete, 
and then select Delete. 
Select Yes to confirm 
deletion, and then 
press OK.
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Organizing your favorites
You can create folders to organize your favorites. For example, you can 
store travel links in one folder, stock links in another, and business links 
in a third folder.

1. Press Start  and select Internet Explorer.
2. Press Menu  and select Favorites.
3. Select the Add/Delete tab.
4. Select New Folder.
5. Enter a name for this folder, and then select Add. 
6. Press OK .

Downloading files and images from a web page
You can download files that are usable on your smartphone, such as 
new applications, MIDI ringtones, or pictures that are specifically 
tagged for download. 

1. Go to the page that contains the link to the file you want to 
download.

2. Press Left  or Right  to highlight the link to the file.
3. Press and hold Center, and then select Save As to download a file, 

or select Save Image to download an image.
4. Select Name and enter a new name for the file. 
5. Select the Folder list, and then select the folder where you want to 

save the file. 
6. Select the Location list, and then select where you want to store the 

file: Main memory or Storage card. 
7. Press OK .

Did You Know
You can select the 
Downloads favorite to 
access the Verizon 
Wireless downloads 
page.

Tip
If Internet Explorer 
Mobile does not 
recognize a 
smartphone number 
as dialable, you can 
copy the phone 
number (as text) and 
paste it into the Phone 
Dial Pad.
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Copying text from a web page
You can copy text from a web page and paste it in other applications. 

1. Use the stylus to highlight the text you want to copy.
2. Press Menu  and select Edit > Copy. 
3. Go to the application in which you want to paste, and then position 

the cursor where you want to paste the text.

4. Press Menu  and select Edit > Paste. 

Using the History list
The History list stores the addresses of the pages you visited recently.

1. Press Menu  and select History. 
2. (Optional) Select the Show list in the upper-left, and then select how 

you want to sort the History list.
3. Select the web page you want to view.

Customizing your Internet Explorer Mobile settings
1. Press Menu  and select Tools > Options. 
2. On the General tab, set any of the 

following options:
• Home Page: Sets the page that 

appears when you open Internet 
Explorer Mobile. To use the page you 
were on when you opened the menu, 
select Use Current. To select the 
original home page, select Use Default.

• Encoding: Sets the character set for 
the web pages you view.

Did You Know
The security 
certificates and 128-bit 
SSL strong encryption 
let you browse secure 
sites, such as online 
shopping, banking, 
and email. Remember, 
some secure sites also 
require specific 
browsers, and may 
not work with Internet 
Explorer Mobile. Ask 
the organization for an 
alternate access point 
that is compatible with 
Internet Explorer 
Mobile.
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3. Select the Memory tab and set any of the 
following options:
• Save links to pages visited in the 

past: Sets how many days of activity 
the History list stores.

• Clear History: Empties the History 
list.

• Delete Files: Removes web files that 
you synchronized with your computer.

4. Select the Security tab and set any of the 
following options:
• Allow cookies: Sets whether your 

smartphone accepts cookies (small files 
containing info about your identity and 
preferences). The page sends the file 
and stores it on your smartphone. 

• Clear Cookies: Deletes any cookies 
stored on your smartphone.

• Warn when changing to a page 
that is not secure: Sets whether a 
message appears when you switch 
from a secure to one that is not secure.

• Warn when page content is blocked due to security 
settings: Sets whether a message appears when you attempt to 
open a page that does not meet your smartphone’s security 
standards.

5. Press OK .

Tip
Internet Explorer 
Mobile supports 
JavaScript, Secure 
Sockets Layer (SSL), 
and cookies, but does 
not support plug-ins 
(Flash, Shockwave, 
etc.) or Java applets.
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Connecting to devices with Bluetooth® 
wireless technology
With your smartphone’s built-in Bluetooth® wireless technology, you 
can connect to a number of Bluetooth devices such as a headset, hands-
free car kit, or GPS receiver, as well as to other phones, handhelds, or 
piconets. For a list of hands-free devices with Bluetooth wireless 
technology that are compatible with your smartphone, go to: 
www.palm.com/mytreo700wVerizon.

If your computer is enabled with Bluetooth wireless technology, you 
can also synchronize wirelessly.

Setting up a Bluetooth connection
After you set up a connection with a Bluetooth device, you can 
communicate with that device whenever it is within range (about 
30 feet) and your smartphone’s Bluetooth feature is turned on. 

1. If necessary, prepare the device you want 
to connect with to accept a new 
connection. Check the device’s 
documentation for details.

2. Go to your Today screen, and then tap 
Bluetooth .

3. Check the Turn on Bluetooth box to turn 
on your smartphone’s Bluetooth feature.

Did You Know
If you’re using a 
hands-free Bluetooth 
device and it is within 
range (30 feet), your 
smartphone routes all 
calls to the hands-free 
device instead of your 
smartphone’s 
earpiece. When a call 
comes in, your 
smartphone rings and 
the car kit or headset 
beeps. Even if you pick 
up the call on your 
smartphone earpiece, 
the call goes to the 
headset or car kit.

Tip
Your smartphone does 
not support Bluetooth 
wireless connections 
with A2DP devices, 
such as stereo 
headsets.

http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
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4. Select the Devices tab, and then select 
New Partnership.

5. Wait for your smartphone to search for 
devices and to display the device list.

6. Select the device you want to connect 
with, and then press Next .

7. Enter an alphanumeric passkey between 
1 and 16 characters long, and then press 
Next .

Some Bluetooth devices 
have a built-in passkey; others let you 
choose the passkey. See the documentation 
for the Bluetooth device for more info.

8. If the passkey is not built-in, enter the 
same passkey on the Bluetooth device, 
and then press Finish .

9. If you’re connecting to a headset or 
hands-free car kit, check the Hands Free 
box, and then press Finish . 

10. If you’re connecting to a GPS device, press Finish , select the 
COM Ports tab, select the GPS device you selected in step 6, and 
then select New Outgoing Port. Press Finish .

11. Press OK .
12. If you’re connecting to a GPS device, enter your GPS Settings (see 

“Setting up a GPS device” on page 178). Be sure to select the same 
port you selected in step 10. 

IMPORTANT[ ! ]

Did You Know
The Bluetooth icon on 
your Today screen 
indicates the status of 
your smartphone’s 
Bluetooth feature: 
Gray = Bluetooth off
Blue = Bluetooth on
White = Connected to 
a Bluetooth device
Headset = Call in 
progress with a 
Bluetooth headset or 
car kit.

Tip
If you no longer want 
to automatically 
connect with a device, 
go to the Bluetooth 
Settings screen and 
select Devices. 
Highlight the 
connection you want 
to remove, press and 
hold Center, and then 
select Delete.
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You can now communicate with this device whenever it is within range 
(about 30 feet) and your smartphone’s Bluetooth feature is turned on 
(see steps 1 and 2 earlier in this section).

Sending information over a Bluetooth connection
You can send an individual entry or file.

1. Make sure the receiving device is ready to receive a Bluetooth 
connection.

2. Highlight the entry or file you want to send.
3. Press Menu  and select Beam… (the menu item changes 

names based on the type of item you highlighted).
4. Select the receiving device in the list.

When the transmission is complete, “Done” appears next to the name 
of the receiving device.

Receiving information over a Bluetooth connection 
1. Go to your Today screen, and then tap Bluetooth .
2. Check the Turn on Bluetooth box to turn on your smartphone’s 

Bluetooth feature.
3. If you already set up a connection with the transmitting device, your 

smartphone is ready to receive the info. If you haven’t set up a 
connection, check the Make this device discoverable to other 
devices box to let the device find your smartphone and request a 
connection.

4. When your smartphone is receiving info, a notification tells you that 
a transmission is in progress. To stop the transmission, press 
Cancel ; to close the notification, press Dismiss .

Tip
Check your battery 
level before 
establishing a 
Bluetooth connection. 
If the battery level is 
low, you can’t make a 
Bluetooth connection.

Tip
If you have trouble 
receiving info over a 
Bluetooth connection, 
press Start and select 
Settings. Select the 
Connections tab, and 
then select Beam. 
Make sure the Receive 
all incoming beams 
box is checked.
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Synchronizing over a Bluetooth connection
1. Set up your computer for Bluetooth wireless communication. See 

the documentation that came with your computer for details. In 
most cases your computer must support the Virtual Serial Port 
profile and this profile must be turned on.

2. Set up ActiveSync on your computer for Bluetooth wireless 
communication. See ActiveSync Help on your computer for details.

3. Go to your Today screen, and then tap Bluetooth .
4. Check the Turn on Bluetooth box to turn on your smartphone’s 

Bluetooth feature.
5. Press Start  and select Programs.
6. Select ActiveSync .
7. Press Menu  and select Connect via Bluetooth.
8. If this is the first time you’re making a Bluetooth connection to this 

computer, follow the onscreen prompts to set up a Bluetooth 
partnership with this computer. 

9. Select Sync.
10. When synchronization is finished, press Menu  and select 

Disconnect Bluetooth. 
11. (Optional) Go to your Today screen, tap Bluetooth , and then 

uncheck the Turn on Bluetooth box to conserve power by turning off 
your smartphone’s Bluetooth feature.

Before You Begin[ ! ]
Make sure your 
computer is equipped 
with Bluetooth 
wireless technology 
and that you installed 
the synchronization 
software on the CD 
that came with your 
smartphone.

Tip
Wi-Fi® routers, 
microwaves, and 
wireless telephones 
using the 2.4GHz 
band may interfere 
with Bluetooth 
connections. For best 
results, move away 
from this equipment 
when making a 
Bluetooth 
connection.
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Beaming information with IR
Your smartphone is equipped with an IR (infrared) port that lets you 
beam information to another device with an IR port. The IR port is 
located on the top of your smartphone, between the antenna and the 
ringer switch, behind the small dark shield. 

Tip
For best results, the 
path between the two 
devices must be clear 
of obstacles, and both 
devices kept 
stationary. If you have 
difficulty beaming, 
shorten the distance 
and avoid bright 
sunlight.

The type of 
information you can 
beam depends on the 
type of device you are 
beaming to. Windows 
mobile devices are 
always compatibile 
with the Treo 700w 
smartphone.
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Beaming a record
1. Highlight the entry or file you want to beam.
2. Press Menu  and select Beam… (the menu item changes 

names based on the type of item you highlighted).
3. Point the IR port on your smartphone directly at the IR port of the 

receiving device.
4. When the name of the receiving device appears, select it to begin 

the transfer.
5. Wait for “Done” to appear next to the name of the receiving device 

before you continue using your smartphone.

Receiving beamed information
1. Turn on your screen.
2. Point your smartphone’s IR port directly at the IR port of the 

transmitting device.
3. When the Receiving Data message appears, select Yes to receive 

the beam.

Synchronizing over an infrared connection
1. Set up your computer to receive infrared beams. See ActiveSync 

Help on your computer for details.
2. Point your smartphone’s IR port directly at the IR port on your 

computer.
3. On your smartphone, press Start  and select Programs.
4. Select ActiveSync .
5. Press Menu  and select Connect via IR.
6. Select Sync.

Tip
If you can’t receive 
beamed info, press 
Start and select 
Settings. Select the 
Connections tab, and 
then select Beam. 
Make sure the Receive 
all incoming beams 
box is checked. If you 
still can’t receive info, 
try a soft reset (see 
“Resetting your 
smartphone” on 
page 191).
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Playing Media Files

Pictures & Videos
Your Palm® Treo™ 700w smartphone comes with an easy-to-use, built-
in, 1.3-megapixel camera with 2x digital zoom (camera not included with 
all smartphones). You can use the camera to take and view pictures and 
videos and send them to your friends and family. To add a personal 
touch to your smartphone, use your pictures as your Today screen 
background, and as caller ID images, or use your videos to create video 
ringtones.

If your Treo smartphone doesn’t have a built-in camera, then the 
sections about taking pictures and videos don’t apply to you. Even if 
your smartphone does not have a camera, you can still receive and view 
pictures and videos, send pictures and videos to other people as 
attachments or multimedia messages, and use pictures to personalize 
your smartphone (such as wallpaper or picture caller ID; see “Assigning 
a picture and ringtone ID to a contact” on page 160 for details). You can 
also move pictures and videos to a computer by synchronizing your 
smartphone with your computer. 

Taking a picture
By default, pictures are stored in the My Pictures folder on your 
smartphone. If you want to store your pictures on an expansion card, 
see “Customizing your Camera settings” on page 109 to change where 
pictures are stored. For information on accessing your pictures on your 
computer, see “Viewing pictures and videos on your computer” on 
page 111.

Did You Know
Pictures are captured 
and stored in 16-bit 
color, JPG format. 
Resolution settings 
range from 
1280 x1024 to 160 x 
120 pixels (1.3-
megapixels to VGA). 
You can change the 
change the default 
setting, see 
“Customizing your 
Camera settings” on 
page 109 for details. 
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1. Press Start  and select Pictures & Videos. 
2. Select Camera .
3. Press Menu . If you see Still Mode 

on the menu, select it. If you don’t see 
Still Mode, skip this step.

4. Adjust the position of your smartphone 
until you see the subject you want to 
photograph on the screen.

5. (Optional) Adjust any of the following:
• Zoom: Press Up , to zoom in or 

Down  to zoom out.
• Brightness: Press Right  to increase the brightness or Left  to 

decrease the brightness.
• Resolution: Press Menu  and select Resolution to change 

the image quality.
6. Press Center to capture the picture.
7. Wait for the picture to render, and then do one of the following:

• Press Camera  to take another picture.
• Press OK  to return to the Thumbnails View. 

Recording a video
Videos can be any length, provided you have ample storage space 
available.By default, videos are stored in the My Pictures folder on your 
smartphone. If you want to store your videos on an expansion card, see 
“Customizing your Camera settings” on page 109 to change where 
videos are stored. For information on accessing your videos on your 
computer, see “Viewing pictures and videos on your computer” on 
page 111. 

Tip
You can also adjust 
the zoom and 
brightness by 
pressing Menu and 
selecting Zoom or 
Brightness.

Did You Know
Videos are captured 
and stored in 3G2 
format. Video 
resolution settings 
range from 352 x 288 
to 176 x 144 pixels. 

Tip
If you don’t like a 
video you recorded, 
delete it. See 
“Deleting a picture or 
video” on page 108 for 
details.
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1. Press Start  and select Pictures & Videos.
2. Select Camera .
3. Press Menu  and select Video Mode.
4. Adjust the position of your smartphone until you see the subject 

you want to record on the screen.
5. (Optional) Adjust any of the following:

• Brightness: Press Right  to increase the brightness or Left  to 
decrease the brightness.

• Resolution: Press Menu  and 
select Quality to change the video 
resolution.

6. Press Center to start recording.
7. When you’re done recording, press 

Stop  or Center to stop recording.
8. (Optional) To review the video, press 

Thumbnails , highlight the video, 
and then press Center. Press OK  to 
return to the Thumbnail View. 

Viewing a picture or video
1. Press Start  and select Pictures & Videos.
2. Select the picture or video you want to view. For more info on 

viewing videos, see “Playing media files on your smartphone” on 
page 113.

3. Press OK  to return to the Thumbnail View.

Tip
To view pictures or 
videos in a different 
folder, select the 
Show list in the 
upper-left, and then 
select the album you 
want to view. 

Did You Know
Your smartphone has 
a self-portrait mirror 
next to the camera 
lens on the back of 
your smartphone. 
Use the mirror when 
you’re taking a 
picture or video and 
you want to be in the 
picture too.
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Viewing a slide show
1. Press Start  and select Pictures & Videos.
2. Press Menu  and select Play Slide Show. The slide show plays 

automatically.
3. Press Center to display the slide show toolbar, which you can use to 

Rotate , Play , Pause , Reverse , Forward , and Stop  
the slide show.

Sending a picture or video
You can send a picture or video to other picture-enabled mobile 
smartphones or to an email address.

1. Press Start  and select Pictures & Videos.
2. Highlight the picture or video you want to send. 
3. Press Menu  and select Send.
4. Select the email or MMS account you want to use to send the 

picture or video.
5. When the Messaging application opens, address and send the 

message. (See “Creating and sending a multimedia message” on 
page 72 for details.)

Creating a video ringtone
You can save a video that you record as a ringtone.

1. Press Start  and select Pictures & Videos.
2. Highlight the video you want to use as a ringtone. 
3. Press Menu  and select Save to Contact Ring Tone.
4. Select the contact you want to assign the ringtone to.

Tip
You can also press 
Right and Left on the 
5-way to move 
forward or backward 
through the slides.

Did You Know
You cannot send 
copyrighted pictures 
or videos that appear 
with a Lock icon in the 
Thumbnail View.

Tip
You can also send 
pictures and videos as 
email attachments. 
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Organizing pictures and videos
You can move or copy pictures and videos to other folders or between 
your smartphone and an expansion card.

1. Press Start  and select Pictures & Videos.
2. Highlight the picture or video you want to move or copy. 
3. Do one of the following:

• To move the picture or video to another location, press Menu 
 and select Edit > Cut.

• To keep the picture or video in two locations, press Menu  
and select Edit > Copy.

4. Select the Show list in the upper-left, and select the location where 
you want to place the picture or video you selected in step 3.

5. Press Menu  and select Edit > Paste.

You can also view a specific folder or expansion card and arrange the 
pictures and videos by name, date, or size.

1. Press Start  and select Pictures & Videos.
2. Select the Show list in the upper-left, and then select the folder you 

want to view.
3. Select the Sort By list in the upper-right, and then select the sort 

method: Name, Date, or Size.
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Using a picture as the Today screen background
1. Press Start  and select Pictures & Videos.
2. Highlight the picture you want to use.
3. Press Menu  and select Set as Today Background.
4. Select the Transparency level list and select the appropriate level. 

Use a higher percentage for a more transparent picture and a lower 
percentage for a more opaque picture.

5. Press OK  to return to the Thumbnail View.

Editing a picture
1. Press Start  and select Pictures & Videos.
2. Highlight the picture you want to edit.
3. Press Menu  and select Edit.
4. Do any of the following: 

• To rotate a picture 90 degrees counterclockwise, select Rotate. 
• To crop a picture, press Menu  and select Crop. Tap and 

drag the stylus to highlight the area to crop. Tap outside the box 
to stop cropping. 

• To adjust the brightness and contrast levels of a picture, press 
Menu  and select AutoCorrect. 

Deleting a picture or video
1. Press Start  and select Pictures & Videos.
2. Highlight the picture or video you want to delete. 
3. Press Menu  and select Delete.
4. Select Yes. 

Tip
To undo an edit, press 
Menu and select 
Undo. To cancel all 
unsaved edits you 
made to the picture, 
select Revert to 
Saved.
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Customizing your Camera settings
1. Press Start  and select Pictures & Videos. 
2. Press Menu  and select Options.
3. On the General tab, set any of the 

following options:
• Use this picture size: Sets the size 

of pictures you send with the 
Messaging application.

• When rotating a picture, rotate 90 
degrees: Sets the direction in which 
pictures rotate.

4. Select the Slide Show tab and set any of 
the following options:
• During slide shows, optimize for 

viewing: Sets whether pictures are 
optimized for portrait or landscape 
format during slide shows.

• Play screensaver when connected 
to my PC and idle for 2 minutes: 
Sets whether the pictures in your My 
Pictures folder are used as a 
screensaver when your smartphone is 
connected to your computer and 
ActiveSync® software is not running.

Tip
If your smartphone 
does not have a built-
in camera, the Camera 
and Video options do 
not apply to you.
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5. Select the Camera tab and set any of the 
following options:
• Save files to: Determines if pictures 

and videos are stored on your 
smartphone or on an expansion card.

• Type filename prefix: Assigns a 
name to a series of pictures to be 
captured, such as Seattle001, 
Seattle002, and so on. 

• Still image compression level: 
Sets the default size for newly 
captured pictures.

6. Select the Video tab and set any of the 
following options:
• Include audio when recording 

video files: Turns the microphone on 
and off so that you can record videos 
with or without sound.

• Time limit for videos: Limits the 
length of videos you record. You can 
also select the No limit option. 

7. Press OK  to return to the 
Thumbnail View.
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Viewing pictures and videos on your computer
When you synchronize your smartphone, your pictures and videos are 
copied to your desktop computer. You can view pictures in JPEG, GIF, 
BMP, and PNG format and videos in 3G2, 3GP, and WMV format. You 
can also send them to friends using your desktop email application. 

• To find all synchronized pictures & videos, look in C:\Documents and 
Settings\<Username>\My Documents\Treo My Documents

Did You Know
You can also 
download animated 
GIF files and view 
them in Internet 
Explorer Mobile. 
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Windows Media Player Mobile
Windows Media Player Mobile can play music, audio, and video files 
that are stored on your smartphone or on an expansion card (sold 
separately) in any of the following file formats:

• WMA 

• WMV 

• MP3

• 3G2

• 3GP

You can listen to these music, audio, and video files through the 
speaker on the back of your smartphone or through a stereo headphone 
(3.5mm xstereo headphone adapter or 2.5mm stereo headphone 
required, sold separately).

Transferring media files to your smartphone
Use the Sync feature in the desktop version of Windows Media Player 
10 to transfer digital music, audio, video, and playlist files from your 
computer to an expansion card or your smartphone. Using Sync 
ensures that the files and album art transfer correctly.

1. On your computer, open Windows Media Player 10.
2. (Optional) Insert a 32MB or larger expansion card into your 

smartphone.
3. Connect your smartphone to your computer with the USB 

sync cable. 

Tip
For tips on using the 
desktop version of 
Windows Media 
Player, go to the Help 
menu in Windows 
Media Player 10 on 
your computer.

Tip
Be patient; 
transferring media 
files to an expansion 
card can take several 
minutes.
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4. When the Device Setup Wizard opens on your computer, 
click Automatic. 

5. Check the Customize the playlists that will be synchronized box.
6. Select the playlists you want to sync.
7. Click Finish to begin the transfer. The next time you connect your 

smartphone to your computer while the desktop version of 
Windows Media Player 10 is running, synchronization starts 
automatically.

Playing media files on your smartphone
1. Press Start  and select Windows Media.
2. Press Menu  and select Library.
3. Select the Library list in the upper-left, and then select the library 

you want to use.
4. Select the item you want to play (such as a song, album, or 

artist name).
5. Press Play .
6. Use any of the following onscreen controls during playback:

 Plays the current file.
 Pauses the current file.
 Skips to the beginning of the current file or to the previous file.
 Skips to the next file.

 Sets the point from which playback begins. Tap and drag the 
slider to change the current position.

 Increases the volume level.
 Decreases the volume level.
 Turns the sound on or off.

Tip
To play a file that is not 
in a library, go to the 
Library screen, press 
Menu, and select 
Open File. 

Tip
To play a file from the 
web, on the Library 
screen, press Menu 
and select Open URL. 
Select URL and enter 
the website address, 
or select History and 
select a site you’ve 
visited before.

Tip
To repeat the current 
song, press Menu and 
select Repeat Song.



数码说明书之家—WWW.54GG.COM
114 Using Your Treo 700w Smartphone

CHAPTER 6

 Displays a video using the full screen.
 Displays a website where you can find music and videos to play.
 Indicates the rating of the current file. Select the star to change 

the rating.
7. Press Menu  and select any of the following during playback:

• Library: Displays the Library screen so you can select a different 
song to play.

• Shuffle/Repeat > Shuffle: Plays the Now Playing playlist in 
random order. A check appears next to this command when it 
is on.

• Shuffle/Repeat > Repeat: Plays the Now Playing playlist 
repeatedly. A check appears next to this command when it is on.

• Stop: Ends playback.

Working with libraries
A library represents each of the storage locations available to Windows 
Media Player Mobile, so you should have two libraries: My Device and 
My Storage Card. Each library contains links to the media files in that 
location. Windows Media Player Mobile usually updates your libraries 
automatically, but you can also manually update a library to add links 
to any files that you recently copied to your smartphone or an 
expansion card. 

1. Press Start  and select Windows Media.
2. Press Menu  and select Library.
3. Press Menu  and select Update Library.
4. Wait for the files to be added, and then select Done.

Did You Know
When you update a 
library, it 
automatically 
updates video files 
(WMV, 3GP, and 3G2) 
and audio files 
(WMA, MP3, QCP, and 
WAV).

Tip
To delete an item 
from a library, press 
and hold Center on 
the item to open the 
shortcut menu, and 
then select Delete 
from Library. Select 
Yes to confirm 
deletion.
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Working with playlists
A playlist is a list of media files that play in a specific order. You can use 
playlists to group audio and video files together for convenient 
playback. For example, in the desktop Player, you can create a playlist of 
upbeat songs for when you exercise and a playlist of soothing songs for 
a long flight. When you synchronize, your favorite playlists are 
automatically copied to your smartphone. Your playlists appear in your 
libraries (in the My Playlists category). 

A temporary playlist, called Now Playing, appears on the Now Playing 
menu. It lists the currently playing file, as well as any files that are 
queued up to play next. You can add to, modify, or clear the files on the 
Now Playing playlist.

1. Go to the Now Playing screen: 
• If you are on the Library screen, select the Now Playing category. 
• If you are on the Playback screen, select Now Playing.

2. Do any of the following:
• To move a file up or down one slot, 

highlight the file, and then select Move 
Up  or Move Down .

• To add a file, select Add , press 
Menu , and then select Queue Up.

• To delete a file from the playlist, 
highlight the file, and then select 
Remove .

• To view more info about a file, highlight 
the file and select Properties .

• To remove all items from the Now Playing playlist, press Menu 
 and select Clear Now Playing.

Did You Know
You can also move a 
file in the Now Playing 
playlist by tapping 
and dragging it to a 
new position.

Tip
If you move files 
between your 
smartphone and an 
expansion card, be 
sure to update your 
libraries, or you won’t 
be able to see the files 
in their new location.
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Customizing Windows Media Player Mobile
1. If necessary, go to the Playback screen by pressing OK  to close 

the current screen.
2. Press Menu  and select Options.
3. On the Playback tab, set any of the 

following options:
• Show time as: Sets whether the time 

remaining or time elapsed appears in 
the Playback screen.

• Pause playback while using 
another program: Sets whether 
playback continues if you switch to 
another application.

• Resume playback after a phone 
call: Sets whether playback continues 
after you finish a phone call.

4. Select the Video tab and set any of the following options:
• Play video in full screen: Sets whether videos automatically 

play in full screen format.
• Shrink to fit window: Sets whether videos are automatically 

scaled to fit the Playback screen.
5. Select the Network tab and set any of the following options:

• Protocol: Enables and disables the available protocols. You 
must select at least one protocol.

• Internet Connection Speed: Sets the speed of your network 
connection.

Did You Know
You can also 
customize your 
smartphone so that 
pressing and holding 
the Side button on the 
side of your 
smartphone opens 
Windows Media 
Player Mobile. See 
“Reassigning 
buttons” on page 168 
for details.
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6. Select the Library tab and set whether you want to see the Library 
or Playback screen when you open Windows Media Player Mobile.

7. Select the Skins tab and select Previous or Next to set the player’s 
background.

8. Select the Buttons tab to change any of the 
available button settings:
• To assign a button, highlight the item 

you want to set, select Assign, and then 
press the button you want to use for 
that item.

• To restore an item’s factory setting, 
highlight the item and select Reset.

• To unassign an item, highlight the item 
and select None.

9. Press OK .

Did You Know
If you close the 
Windows Media 
Player window, your 
music continues to 
play in the 
background.
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Staying Productive

Word Mobile
You can create and edit documents and templates and save them as 
DOC, RTF, TXT, and DOT files. You can also edit Word documents and 
templates that you create on your computer. However, keep in mind that 
some of the information and formatting may be lost when you save the 
document on your smartphone.

The following features are not supported in Word Mobile:

• Backgrounds

• Bi-directional text

• Document protection

• Metafiles

• Artistic page borders (lined page borders are supported)

• Password-protected files (remove password protection on your 
computer before opening the file on your smartphone)

• Shapes and text boxes

• Smart tags

The following features are partially supported in Word Mobile: 

• Picture bullets (regular bullets are supported.)

• Revision marks (documents appear as though all revisions were 
accepted; if the document is saved, revision marks are lost) 

Tip
To copy a file from 
your computer to 
your smartphone, 
open My Computer 
or Windows Explorer 
on your computer, 
copy the file into the 
Mobile Device folder, 
and then sync.
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• Table styles (some or all of the formatting is lost if the document 
is saved) 

• Underline styles (unsupported styles are mapped to one of the four 
supported styles: regular, dotted, wavy, or thick/bold/wide) 

• Legacy Pocket Word files (you can open PSW files, but if you edit a 
file, you need to save it in DOC, RTF, TXT, or DOT format) 

The following features are not supported on your smartphone, but they 
remain in the file so that when you open the file on your computer, they 
appear as expected: 

• Fonts and font sizes (original fonts are listed on your smartphone but 
are mapped to the closest font available.) 

• Footnotes, endnotes, headers, footers

• Lists (indented lists are mapped to the closest indentation level 
supported by Word Mobile.)

• Page breaks (although undisplayed, all page breaks, except a break 
placed at the end of a document, are retained in the document.) 

Creating a document
1. Press Start  and select Programs.
2. Select Word Mobile .
3. Press New .
4. Enter the text of the document.
5. Press OK  to save the file.

Did You Know
When you save a new 
document, it is 
automatically named 
after the first several 
words in the file.



数码说明书之家—WWW.54GG.COM
Using Your Treo 700w Smartphone 121

Word Mobile CHAPTER 7

Opening an existing document
1. Press Start  and select Programs.
2. Select Word Mobile .
3. In the document list, select the document you want to open.

Creating a document from a template
1. Go to the documents list. 
2. Select the Show list in the upper-left, and then select Templates.
3. Open the template you want to use and enter the information.
4. Press OK .
5. Rename the document and move it to the appropriate folder. See 

“Organizing your documents” on page 124 for details.

Finding or replacing text in a document
1. Open the document containing the text you want to find.
2. Press Menu  and select Edit > Find/Replace.
3. Select Find what and enter the text you want to find.
4. (Optional) Check the Match case box to find text that matches the 

capitalization in the text you entered step 3.
5. (Optional) Check the Match whole words only box to find only full 

words that match the text you entered in step 3.
6. Select Find to locate the first instance of the text you entered in step 

3, or select Replace and enter the replacement text.
7. Select Next to find the next instance of the text, or select Replace to 

replace it. To replace all instances of the text, select Replace All. 
8. When you see a message that the search is done, press OK .

Tip
If you don’t see 
Templates in the 
Show list, select 
More Folders to 
access this folder.

Tip
To create a new 
template, open the 
document you want 
to save as a template. 
Press Menu and 
select Rename/Move. 
Select Name, and 
then enter a name for 
the template. Select 
the Show list, and 
then select Template. 
Press OK.
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Moving or copying text
1. Open the document containing the text you want to move or copy.
2. Highlight the text you want to move or copy.
3. Press Menu  and select Copy to copy the text, or select Cut to 

move the text.
4. Open the document where you want to insert the text and position 

the insertion point where you want the text to appear.
5. Press Menu  and select Paste.

Saving a copy of a document
1. Open the document you want to copy.
2. Press Menu  and select File > Save As.
3. Select Name and enter a new name for the file.
4. Select the Folder list, and then select the folder where you want to 

save the file.
5. Select the Type list, and then select the format in which you want to 

save the file.
6. Select the Location list, and then select whether you want to store 

the file on your smartphone or an expansion card.
7. Select Save.

Formatting text
1. Open the document you want to format.
2. Highlight the text you want to format.
3. Press Menu  and select Format > Font.

Tip
To zoom in or out, 
open a document, 
press View, select 
Zoom, and then select 
the zoom level.

Tip
If a document was 
previously saved on a 
computer, any 
unsupported 
formatting may be 
lost when you save 
the file.
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4. Set any of the following options for the highlighted text:
• Font: Sets the typeface.
• Font color: Sets the color.
• Size: Sets the point size. 
• Bold: Indicates whether the text appears normal or thick. 
• Italics: Indicates whether the text appears upright or slanted.
• Underline: Indicates whether the text appears with an 

underscore.
• Highlight: Indicates whether the text appears with a 

yellow highlight.
• Strikethrough: Indicates whether the text appears with a 

line through it. 
5. Press OK  to return to the document.

Formatting paragraphs and lists
1. Open the document you want to format.
2. Position the insertion point in the paragraph you want to format.
3. Press Menu  and select Format > Paragraph.
4. Set any of the following options:

• Alignment: Aligns the text with the left, right, or center of the 
paragraph.

• List: Creates a bulleted or numbered list.
• Indentation: Changes the paragraph margins. 

— Left: Sets the left margin for the entire paragraph. 
— Right: Sets the right margin for the entire paragraph.
— Special: Lets you indent the first line or set a hanging indent.
— By: Sets the size of the Special indentation. 

5. Press OK  to return to the document.

Tip
You can also use the 
Formatting toolbar to 
create a list and to 
align text. To indent 
text in lists, you must 
use the Formatting 
toolbar. 
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Checking spelling in a document
1. Open the document you want to check.
2. Press Menu  and select Tools > Spelling.
3. If an unknown or misspelled word is encountered, do one of the 

following:
• Select the correct word in the list if the word is spelled 

incorrectly. 
• Select Ignore if the word is spelled correctly. 
• Select Add to add a new word to the spelling dictionary.

Organizing your documents
You can rename your documents, move your documents to another 
folder, and move your documents between your smartphone and an 
expansion (storage) card.

1. Go to the documents list.
2. Press Menu  and select Rename/Move.
3. Select Name, and then enter a new name for the document.
4. Select the Folder list, and then select the folder you want to move 

the document to.
5. Select the Location list, and then select Main memory or 

Storage card.
6. Press OK .
7. Select the Show list in the upper-left, and then select the folder you 

want to view.
8. Select the Sort By list in the upper-right, and then select the 

sort method.

Tip
To check the spelling 
of specific text, 
highlight it before 
you select the 
Spelling command.

Tip
To create a new 
folder, go to the 
documents list, select 
the Show list in the 
upper-left, and then 
select the Add/Delete 
tab. Select New, enter 
a name for the folder, 
and then press OK.
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Deleting a document
1. Go to the documents list.
2. Highlight the document you want to delete.
3. Press Menu  and select Delete.
4. Select Yes.

Customizing Word Mobile
1. Go to the document list.
2. Press Menu  and select Options.
3. Set any of the following options:

• Default template: Sets the default template for new 
documents.

• Save to: Sets the default location where new documents 
are stored.

• Display in list view: Sets the types of files that appear in the 
documents list.

4. Press OK .
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PowerPoint Mobile
With PowerPoint Mobile, you can open and view slide show 
presentations created on your computer. Many presentation elements 
such as slide transitions, animations, and URL links are also supported. 
PowerPoint features not supported on your smartphone include the 
following: 

• Notes written for slides 

• Rearrangement or editing of slides

• Files created in PPT format earlier than PowerPoint '97

• HTML files in HTM and MHT formats

Playing a presentation
1. Press Start  and select Programs.
2. Select PowerPoint Mobile .
3. In the presentation list, highlight the presentation you want to play.
4. Press Center.
5. Do any of the following:

• Press Right  to advance to the next slide or Left  to view the 
previous slide. 

• Press Menu , select Go to Slide, and select the slide you 
want to view.

• Select Next or Previous to play animations.
•  Press Menu , select Zoom In, and then select  to zoom in 

or  to zoom out. To scroll within the current slide, tap and drag 
the slide. To return to the slide show, select .

• Press Menu  and select End Show.

Tip
To copy a file from 
your computer to your 
smartphone, open My 
Computer or 
Windows Explorer on 
your computer, copy 
the file into the Mobile 
Device folder, and 
then sync.

Tip
If a presentation is set 
up as a timed slide 
show, the slides 
advance 
automatically. 
Presentations pause 
during zooming.
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Setting presentation playback options
1. Open the presentation for which you want to change the settings.
2. Press Menu  and select Show Options.
3. On the Orientation tab, select the orientation you want. To select the 

orientation that best fits your smartphone’s screen, select Default.
4. Select the Playback tab, and check the Override playback options for 

all files box.
5. Set any of the following options:

• Show without animation: Turns off builds and other 
animations.

• Show without slide transition: Turns off transition effects 
between slides. 

• Use slide timings, if present: Enables the timings recorded 
with each slide in a presentation. 

• Loop continuously: Advances to the first slide after playing the 
last slide in a presentation. 

6. Press OK .

Tip
To turn the 
presentation into a 
continuously looping 
slide show, check 
both the Use timings, 
if present, and the 
Loop continuously 
boxes.

Did You Know
You can purchase 
SDIO presentation 
modules that let you 
project your 
PowerPoint 
presentations 
through an LCD 
projector.
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Excel Mobile
With Excel Mobile you can create and edit workbooks and templates on 
your smartphone. You can also edit workbooks and templates that you 
create on your computer. However, keep in mind that you may lose 
some of the information and formatting when you save the workbook 
on your smartphone.

Note the following formatting considerations: 

• Alignment: Vertical text appears horizontal. 

• Borders: Appear as a single line. 

• Cell patterns: Patterns applied to cells are removed. 

• Fonts and font sizes: The original font is listed on your smartphone 
and mapped to the closest font available. Original fonts reappear on 
your computer. 

• Number formats: Microsoft Excel 97 conditional formatting 
displays in Number format. 

• Formulas and functions: Unsupported functions are removed, and 
only the returned value of the function appears. Formulas containing 
the following are also converted to values: 

• An array or array argument, for example, =SUM({1;2;3;4}) 
• External link references or an intersection range reference
• References past row 16384 are replaced with #REF! 

• Protection settings: Most protection features are disabled but not 
removed. However, password protection is removed. You must 
remove the password protection in Excel on your computer before 
opening the file on your smartphone. 

Tip
For simple 
calculations, use the 
Calculator 
(see“Calculator” on 
page 70). 

Tip
To copy a file from 
your computer to your 
smartphone, open My 
Computer or Windows 
Explorer on your 
computer, copy the file 
into the Mobile Device 
folder, and then sync.
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• Zoom settings: Worksheet-specific zoom settings are not retained. 
The zoom setting applies to the entire workbook. 

• Worksheet names: Names that refer to other workbooks, arrays, 
array formulas, or intersection ranges are removed from the name 
list, causing those formulas to be resolved as “#NAME?” All hidden 
names are not hidden. 

• AutoFilter Settings: AutoFilters that cause rows to be hidden are 
supported. Use the Unhide command to display hidden rows. Other 
AutoFilters are removed, but you can use the AutoFilter command in 
Excel Mobile to perform similar functions.

• Chart Formatting: All charts are saved as they appear in Excel 
Mobile. Unsupported chart types are changed to one of these 
supported types: Column, Bar, Line, Pie, Scatter, and Area. 
Background colors, gridlines, data labels, trend lines, shadows, 3D 
effects, secondary axes, and logarithmic scales are turned off. 

The following features aren't supported in Excel Mobile and are 
removed or modified when you open a workbook on your smartphone:

•  Hidden, dialog, and macro sheets 

• VBA modules 

• Text boxes

• Drawing objects and pictures

• Lists

• Conditional formats and controls 

• Pivot table data (is converted to values) 
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Creating a workbook
1. Press Start  and select Programs.
2. Select Excel Mobile .
3. Press New .
4. Highlight a cell where you want to enter text or other info. 
5. Enter the info in the cell, and then press Enter .
6. Repeat steps 4 and 5 to enter the remaining info.
7. Press OK  to save the file.

Creating a workbook from a template
1. Go to the workbook list. 
2. Select the Show list in the upper-left, and then select Templates.
3. Open the template you want to use and enter the information you 

want to include in the template.
4. Press OK .
5. Rename the workbook and move it to the appropriate folder. See 

“Organizing your documents” on page 124 for details.

Viewing a workbook
1. Press Start  and select Programs.
2. Select Excel Mobile .
3. In the workbook list, select the workbook you want to view.
4. Press View , and then select any of the following:

• Full Screen: Shows as much data as possible on the screen. To 
return to the normal view, select Restore in the upper-right. 

Tip
When you save a new 
workbook, it is 
automatically named 
and placed in the 
workbook list.

Tip
To insert a symbol, 
place the insertion 
point where you want 
the symbol. Press 
Menu and select Insert 
> Symbol. Highlight 
the symbol you want 
to insert, and then 
select Insert.

Tip
To create a new 
template, open the 
workbook you want to 
save as a template. 
Press Menu and select 
Rename/Move, and 
then enter a name for 
the template. Select 
Folder, and then select 
Template. Press OK.
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• Zoom: Sets the magnification level so that you can easily read 
the worksheet.

• Sheet: Lets you switch to a different worksheet.
• Split: Divides the window into two scrollable areas. To move the 

split bar, tap and drag the split bar. To remove the split bar, select 
View > Remove Split. 

• Freeze Panes: Locks rows and columns so they remain visible 
while you scroll. Highlight the cell at the juncture you want to 
lock before you select this command. To unlock the rows or 
columns, select View > Unfreeze Panes. 

• Toolbar: Sets whether the toolbar appears onscreen.
• Status Bar: Sets whether the status bar appears onscreen.
• Show: Sets whether headings and scroll bars appear onscreen.

Calculating a sum
1. Press View  and select Toolbar.
2. Highlight the cell where you want to insert the sum.
3. Select . 
4. Tap and drag the stylus across the cells you want to add. 
5. Press Enter .

Entering a formula
1. Highlight the cell where you want to enter the formula.
2. Enter an = sign followed by any values, cell references, name 

references, operators, and functions. 
Example: =(B4/25)+100=Revenue-Expenses 

3. Press Enter . 

Tip
To jump to a cell or 
region, press Menu 
and select Edit > Go 
To. Select Cell 
reference or name 
and enter the target 
cell info or select 
Current region. Select 
OK.

Did You Know
You can also switch 
worksheets by 
selecting the sheet list 
at the bottom of the 
screen.
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Inserting a function
1. Open the workbook where you want to 

insert the function.
2. Press Menu  and select Insert > 

Function.
3. Select the Category list, and then select 

the type of function you want to insert.
4. Select the Function list, and then select the 

specific function you want to insert.
5. Select OK.

Entering a sequence automatically
1. Highlight both the cells containing the info 

you want to automate and the adjacent 
destination cells. 

2. Press Menu  and select Edit > Fill. 
3. Select the Direction list, and then select 

the direction you want to populate.
4. Select the Fill type list, and then 

select Series. 
5. Select the Series type list, and then select 

the type of series you want. If you select 
Date or Number, enter a Step value increment. 

6. Select OK. 

Tip
Select Autofill as the 
series type to quickly 
fill cells with repetitive 
data such as numbers 
or repeated text. 
Autofill takes the 
content of the first cell 
in the highlighted row 
or column and copies 
it down or across the 
rest of the selection.
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Adding cells, rows, and columns
1. Open the workbook you want to add to.
2. Highlight the area where you want to insert elements.
3. Press Menu  and select Insert > Cells.
4. Select how you want to insert the elements:

• Shift cells right: Inserts a new cell. The highlighted cell and all 
cells on its right move one column to the right. 

• Shift cells down: Inserts a new cell. The highlighted cell and all 
cells below it move down one row. 

• Entire row: Inserts a new row. The entire row in which the 
highlighted cell is located and all rows below it move down 
one row.

• Entire column: Inserts a new column. The entire column in 
which the highlighted cell is located and all columns to its right 
move one column to the right.

5. Select OK.

Formatting cells
1. Open the workbook you want to format.
2. Highlight the cells you want to format.
3. Press Menu  and select Format > Cells.
4. Select any of the following:

• Size: Sets the row height and column width.
• Number: Sets the type of information the cells contain.
• Align: Sets whether text wraps within the highlighted cells, and 

sets horizontal and vertical alignment position.

Tip
To add a new 
worksheet, press 
Menu and select 
Format > Modify 
Sheets. Select Insert, 
enter a name for the 
worksheet, and then 
press OK. To change 
the order of the 
worksheets, highlight 
a worksheet you want 
to move, and then 
select Move Up or 
Move Down. Press OK 
to finish.

Tip
To name the 
highlighted cell or 
range of cells, press 
Menu and select 
Insert > Define Name. 
Enter the name and 
select Add. Press OK.
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• Font: Sets the typeface, color, size, and style attributes.
• Borders: Turns borders on and off for various cell edges, and 

sets the border and background colors.
5. Press OK .

Formatting rows and columns
1. Open the workbook you want to format.
2. Highlight the rows or columns you want to format.
3. Press Menu , and then select Format > Row or Format> 

Column.
4. Select any of the following:

• AutoFit: Adjusts the size of the highlighted rows or columns to 
their contents.

• Hide: Hides the highlighted rows or columns.
• Unhide: Displays hidden rows or columns in the highlighted 

area.

Renaming a worksheet
1. Open the workbook containing the worksheet you want to rename.
2. Press Menu  and select Format > Modify Sheets.
3. In the Sheets list, highlight the worksheet you want to rename.
4. Select Rename, enter a new name for the worksheet, and then press 

OK  twice.

Did You Know
You can adjust the 
column and row size 
by tapping and 
dragging the right 
edge of the column or 
the bottom edge of the 
row. To automatically 
fit rows and columns 
to their contents, 
double-tap the lower 
edge of the row 
heading or the right 
edge of the column 
heading.
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Sorting info in a worksheet
1. Highlight the cells you want to sort.
2. Press Menu  and select Tools > Sort.
3. Select the Sort by list, and then select the primary sort column.
4. Check or uncheck the Ascending box to indicate if you want to sort 

in ascending or descending order.
5. (Optional) Select the Then by lists, and then select second and third 

level sorting options.
6. Check or uncheck the Exclude header row from sort box to indicate 

if you want to sort the header row.
7. Select OK.

Filtering info in a worksheet
1. Highlight the cells that contain the info you want to filter.
2. Press Menu  and select Tools > AutoFilter. A list appears at the 

top of each related column.
3. Select one of the new lists, and then select a filter. This hides all 

rows that do not include the selected filter. 
4. (Optional) Select the other lists, and then select other filters.

Creating a chart
1. Open the workbook you want to create a chart from.
2. Highlight the cells you want to include in the chart.
3. Press Menu  and select Insert > Chart.
4. Select the type of chart, and then press Next .

Did You Know
You can also create 
custom filters where 
you specify 
comparisons. Select 
the filter lists, and 
then select Custom.

Tip
To display all rows 
again, select the filter 
lists, and then select 
All. To turn off 
filtering, press Menu 
and select Tools > 
AutoFilter again.
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5. Confirm the area you want the chart to include, and then press 
Next .

6. Select the data layout, and then press Next .
7. Check the boxes to indicate whether the first row and column 

represent labels.
8. Select whether you want the chart to appear as a separate 

worksheet within the current workbook, or as part of the current 
worksheet. 

9. Press Finish .

Formatting or changing a chart
1. Open the workbook that contains the chart you want to format.
2. Open the chart.
3. Press Menu  and select Format > Chart.
4. Select any of the following:

• Titles: Sets the title of the chart and headings, whether a legend 
appears, and the placement of the legend.

• Scale: Sets the minimum and maximum scales for charts with 
an x or y axis.

• Type: Sets the chart style. You can use this setting to convert 
your chart to a different format.

• Series: Lets you add, modify, format, or delete related data 
points without affecting the info in your worksheet.

5. Press OK .
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Finding or replacing info in a workbook
1. Open the workbook containing the info you want to find.
2. Press Menu  and select Edit > Find/Replace.
3. Select Find what and enter the info you want to find.
4. (Optional) Check the Match case box to find text that matches the 

capitalization in any text you entered step 3.
5. (Optional) Check the Match whole words only box to find only full 

words that match any text you entered in step 3.
6. Select Find to locate the first instance of the info you entered in step 

3, or select Replace and enter the replacement info.
7. Select Next to find the next instance of the info, or select Replace to 

replace it. To replace all instances of the info, select Replace All. 
8. When you see a message that Excel is done searching, 

press OK .

Organizing your workbooks
You can rename your workbooks, and move them to another folder and 
between your smartphone and an expansion (storage) card.

1. Go to the workbook list.
2. Press Menu  and select Rename/Move.
3. Select Name, and then enter a new name for the workbook.
4. Select the Folder list, and then select the folder you want to move 

the workbook to.
5. Select the Location list, and then select Main memory or Storage 

card.
6. Press OK .
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7. Select the Show list in the upper-left, and then select the folder you 
want to view.

8. Select the Sort By list in the upper-right, and then select the sort 
method.

Deleting cells, rows, and columns
1. Open the workbook containing the elements you want to delete.
2. Highlight the area you want to delete.
3. Press Menu  and select Edit > Delete Cells.
4. Select how you want to remove the elements:

• Shift cells left: Deletes the highlighted cells and moves all cells 
on their right one column to the left. 

• Shift cells up: Deletes the highlighted cells and moves all cells 
below them up one row. 

• Entire row: Deletes the entire row in which the highlighted cells 
are located, and moves all rows below it up one row. 

• Entire column: Deletes the entire column in which the 
highlighted cells are located, and moves all columns on their 
right one column to the left. 

5. Select OK.

Tip
To delete a workbook, 
go to the workbook list 
and highlight the 
workbook you want to 
delete. Press Menu and 
select Delete. Select 
Yes to confirm.

Tip
To delete a worksheet, 
press Menu and select 
Format > Modify 
Sheets. Highlight the 
worksheet you want to 
delete, and then select 
Delete. Select Yes, and 
then press OK to finish.
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Customizing Excel Mobile
1. Go to the workbook list.
2. Press Menu  and select Options.
3. Set any of the following options:

• Template for new workbook: Sets the default template for 
new workbooks.

• Save new workbooks to: Specifies where new workbooks are 
stored.

• Files to display in list view: Sets which types of files appear in 
the workbook list.

4. Press OK .

Did You Know
Excel Mobile adjusts 
formulas to reflect the 
new cell locations. 
However, a formula 
that refers to a 
deleted cell displays 
the #REF! error value.
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Managing Files and 
Applications

Finding information
With the built-in search features on your smartphone, you can find 
information quickly:

• Lookup: Helps you find and dial your contacts by name or phone 
number. See “Dialing by contact name” on page 37 for details.

• Search: Looks through the text in all the applications on your 
smartphone.

• File Explorer: Lets you browse through the files and folders on your 
smartphone or an expansion card.

Using Search
Search for files and other items stored in the My Documents folder on 
your smartphone or on an expansion card. You can search by file name 
or by words located in the item. For example, you can search for words 
within notes, appointments, contacts, and tasks. 
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1. Press Start  and select Programs.
2. Select Search .
3. Select Search for, and then enter the file 

name, word, or other info you want to 
find. 

4. Select the Type list, and then select the 
kind of information you want to find. 

5. Press Search . 
6. Use the 5-way to select and view an item 

from the results of the search.

Exploring files and folders
File Explorer lets you browse the contents of folders on your 
smartphone. The root folder on your smartphone is named My Device. 
My Device is similar to My Computer on your computer. 

1. Press Start  and select Programs.
2. Select File Explorer .
3. Select the Show list in the upper-left, and then select the folder you 

want to explore. 
4.  Do any of the following:

• To open an item, select it. 
• To quickly delete, rename, copy, beam, or email an item, 

highlight the item, press and hold Center to open the shortcut 
menu, and then select the appropriate command. 

• To highlight multiple items, tap and drag the stylus. 

Do not delete any files that you cannot identify. These 
files may be required for your smartphone to function properly.

Tip
If you’ve looked for an 
item before, select the 
Search for list, and 
then select the item in 
the list. 

Did You Know
You can sort the 
contents of a folder by 
name, date, size, or 
type. Select the Sort 
by list in the upper-
right, and then select 
the sort method.

Tip
The storage card 
symbol appears next 
to the names of files 
that are stored on an 
expansion card.

IMPORTANT[ ! ]
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Installing applications
Your Palm® Treo™ 700w smartphone comes with several built-in and 
ready-to-use applications. You can also install any of the additional 
software included on the Windows Mobile Getting Started Disc as well 
as other third-party applications that are compatible with Windows 
Mobile 5.0 devices, such as business software, games, and more. To 
learn more, go to www.palm.com/mytreo700wVerizon.

Applications you download to your computer are likely to be in a 
compressed format such as ZIP. If the file is compressed, you need to 
use a decompression utility on your computer, such as Winzip, before 
you install applications on your smartphone. 

These instructions tell you how to install basic files onto your 
smartphone. Some software uses an installer or wizard to guide you 
through the process. Consult the documentation that came with the 
software for details.

Installing applications from the Internet
You can install Windows Mobile applications directly from the Internet, 
using Internet Explorer Mobile. Applications you download to your 
smartphone install automatically.

1. Make sure your phone is on (see “Turning your phone on and off” 
on page 11).

2. Press Start  and select Internet Explorer.
3. Go to the page that contains the link to the application you want to 

download.
4. Press Left  or Right  to highlight the link to the file, and then 

press Center to start the download process.

Tip
If an application does 
not have a Microsoft 
Mobile to Market 
certificate, you will 
see a message 
indicating that the 
application is 
untrusted. If this 
occurs, you can 
indicate whether you 
want to continue the 
installation.

Be sure to select and 
install software for 
PocketPC Phone 
edition. 
PPC smartphone 
edition is not 
compatible with your 
Treo 700w 
smartphone.

http://www.palm.com/software
http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
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Installing applications from your computer
1. Open My Computer or Windows Explorer on your computer. 
2. Copy the application file(s) into the  Mobile Device folder.
3. Connect your smartphone to your computer to synchronize and 

install the application(s) on your smartphone.

Installing applications onto an expansion card
1. Insert the expansion card into the expansion card slot (see 

“Removing and inserting expansion cards” on page 151).
2. Open the ActiveSync® window on your computer. 
3. Click Tools and select Explore Device.
4. Double-click My Windows Mobile-Based Device  to open the 

Mobile Device folder.
5. Copy the application file(s) into the Storage Card folder inside the 

Mobile Device folder.

Getting help with third-party applications
If a you encounter a problem with a third-party application (such as an 
error message), contact the application’s author or vendor. For general 
troubleshooting of third-party applications, see “Third-party 
applications” on page 211.

Before You Begin[ ! ]
To install an 
application from your 
computer to your 
smartphone, 
you must first install 
the ActiveSync 
software on 
your computer 
(see “Installing the 
desktop 
synchronization 
software” on 
page 15).
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Removing applications 
To free up memory on your smartphone, you can remove applications 
that you no longer use. You can remove only applications, patches, and 
extensions that you install; you cannot remove the built-in applications 
that reside in the ROM portion of your smartphone.

1. Press Start  and select Settings.
2. Select the System tab, and then select Remove Programs .
3. Highlight the application that you want to remove.
4. Select Remove.
5. Select Yes to confirm deletion.

Tip
Some applications 
are factory-installed 
on your smartphone 
and cannot be 
deleted. These are 
not listed in the 
Remove Programs 
list.
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Setting synchronization options

Selecting which info to sync
1. Press Start  and select Programs.
2. Select ActiveSync . 
3. Press Menu  and select Options.
4. Do any of the following: 

• Check the box next to any items you 
want to synchronize. If you cannot 
check a box, you might have to 
uncheck a box for the same 
information type elsewhere in the list. 

• Uncheck the box next to any items you 
want to stop synchronizing. 

• Select an item and then select Settings to customize the settings 
for that item. Settings are not available for all items.

Synchronizing with Exchange Server
You can sync directly with Exchange Server using a connection to either 
a wireless network or a computer. 

1. Press Start  and select Programs.
2. Select ActiveSync .
3. Press Menu  and select Configure Server. If you have not yet 

set up sync with Exchange Server, this says Add Server Source. 
4. Select Server address, enter the name of the server running 

Exchange Server, and then press Next . 

Tip
To stop synchronizing 
with one computer 
completely, select the 
computer name and 
then select Delete. 

Did You Know
You can also use the 
Sync Setup Wizard to 
set up your 
smartphone to 
synchronize remotely 
with Exchange Server. 
This wizard starts 
when you connect 
your smartphone to 
your computer after 
installing ActiveSync 
on your computer.
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5. Enter your name, password, and domain, and then press 
Next . To change the rules for resolving synchronization 
conflicts, select Advanced. 

6. Check the boxes next to the type of info that you want to 
synchronize with Exchange Server. 

7. Press Finish . 

Synchronizing with multiple computers
You can set up your smartphone to synchronize with more than one 
computer as well as Exchange Server. When synchronizing with 
multiple computers, the items that you synchronize appear on all of the 
computers with which they synchronize.

For example, if you set up to sync different items with two computers 
named C1 and C2, when you sync Contacts and Calendar on your 
smartphone with both computers, you see the following result: 

• The contacts and calendar appointments that were on C1 are now 
also on C2. 

• The contacts and calendar appointments that were on C2 are now 
also on C1. 

• The contacts and calendar appointments from both computers are on 
your device. 

NOTE: Outlook E-mail can synchronize with only one computer.
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Starting and stopping synchronization
If ActiveSync is running on your computer and you connect your 
smartphone to your computer, synchronization begins automatically. 
If you ever need to manually start or stop synchronization follow 
these steps:

1. Connect your smartphone to your computer (see “Connecting your 
smartphone to your computer” on page 15). If you are only 
synchronizing wirelessly with Exchange Server, you do not have 
to connect the device. 

2. Press Start  and select Programs.
3. Select ActiveSync .

Setting the synchronization schedule
You can schedule wireless synchronization to occur automatically at 
regular intervals. If you prefer to synchronize manually, do not turn on 
these settings.

1. Connect your smartphone to your computer (see “Connecting your 
smartphone to your computer” on page 15). If you are only 
synchronizing wirelessly with Exchange Server, you do not have to 
connect the device. 

2. Press Start  and select Programs.
3. Select ActiveSync .
4. Press Menu  and select Schedule.
5. Set any of the following options:

• Peak times: Sets the frequency for high-traffic time periods 
such as when you are at work or when email volume is high.

Did You Know
You can also connect 
your smartphone to 
your computer with an 
infrared (IR) or a 
Bluetooth® wireless 
connection.

Tip
If synchronization 
doesn’t start 
automatically, press 
Start and select 
Programs. Select 
ActiveSync and then 
select Sync to start 
synchronization. 

Tip
To end 
synchronization 
before it completes, 
select Stop. 
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• Off-peak times: Sets the frequency for low-traffic time periods 
such as late at night. 

• Use above settings while roaming: Sets the frequency while 
you are roaming outside the Verizon Wireless network. To 
minimize roaming charges, uncheck this box and synchronize 
manually while roaming.

• Send outgoing items immediately: Sets whether items are sent 
as soon as you select Send in the Messaging application, or 
whether they are held until the next synchronization. 

6. Press OK .

Tip
The auto shut off 
timer resets each time 
you synchronize. If 
your sync interval is 
shorter than the auto 
shut off interval, your 
smartphone doesn’t 
turn off.
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Using expansion cards
The expansion card slot on your smartphone enables you to add SD 
cards and MultiMediaCard cards to extend the storage capacity of your 
smartphone. For example, SD or MultiMediaCard expansion cards can 
store the following:

• Pictures 

• Videos

• MP3 audio files

• Email attachments

• Games

• eBooks

• Applications

• Databases

Your smartphone is also compatible with most SDIO cards—which let 
you add accessories, such as a Wi-Fi® network card or presentation 
module, to your smartphone. 

Expansion cards are sold separately. Your smartphone comes with a 
dummy card inside the expansion card slot, to protect the slot. When 
you do not have a functioning card inside the slot, reinsert the dummy 
card to protect the slot opening. 

Tip
Check with the card 
manufacturer to 
confirm compatibility 
before purchasing an 
SDIO card.

Tip
We recommend that 
you purchase 
preformatted 
expansion cards. To 
format a card on your 
own, you need to 
connect a card reader 
(sold separately) to 
your computer.
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Removing and inserting expansion cards
1. Press down and release the dummy card.
2. After you feel the expansion card slot eject the dummy card, 

remove the card from the slot.

3. To insert an expansion card, hold your smartphone with the screen 
facing you and the card with the label facing you. The notch on the 
card should be in the lower-left corner next to the antenna.

4. Insert the card into the expansion card slot until you feel it lock into 
place and hear the confirmation tone. 

Tip
SD cards are faster 
than MultiMediaCard 
cards for reading and 
writing information.
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Opening applications on an expansion card
After you insert an expansion card in the expansion card slot, you can 
open any of the applications stored on the expansion card.

1. Insert the expansion card into the expansion card slot. 
2. Press Start  and select Programs.
3. Select File Explorer.
4. Select the Show list in the upper-left, and then select Storage Card.
5. Select the application you want to open. 

Notch

Tip
In order to run an 
application on an 
expansion card, your 
smartphone must 
have enough free 
space in the internal 
memory to run the 
application.
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Saving files to an expansion card
You may find it helpful to automatically save the info on an expansion 
card. For example, when you create new Word Mobile documents, 
notes, Excel Mobile workbooks, pictures, videos, and audio files, you 
can save them directly to an expansion card. (Some applications may 
not support this feature.)

1. Insert an expansion card into the expansion card slot. 
2. Open the application you want to save the info from.
3. Press Menu  and select Options.
4. Select the Save to list, and then select Storage Card.
5. Press OK .

Moving info between your smartphone and an 
expansion card

1. Insert an expansion card into the expansion card slot. 
2. Open the application from which you want to move the info.
3. Go to the list view.
4. Press Menu  and select Rename/Move.
5. Select the Location list, and then select where you want to move the 

info: Storage Card or Main Memory.
6. Press OK .

Tip
If you don’t see the 
Save to list on the 
Options screen, look 
on the other tabs (if 
present). If you still 
can’t find a Save to 
list, the application 
may not support this 
feature.
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Copying or moving applications and files between 
your smartphone and an expansion card

1. Insert the expansion card into the expansion card slot. 
2. Press Start  and select Programs.
3. Select File Explorer.
4. Select the file or application you want to copy or move (see 

“Exploring files and folders” on page 142).
5. Press Menu  and select Edit > Copy or Edit > Cut.
6. Go to the folder where you want to place the selected item.
7. Press Menu  and select Edit > Paste.
8. Press OK .

Viewing available expansion card memory
You can view how much space is available on the expansion card that is 
currently in the expansion card slot.

1. Insert the expansion card into the expansion card slot. 
2. Press Start  and select Settings.
3. Select the System tab, and then select Memory .
4. Select the Storage Card tab.
5. Press OK .

Tip
Your applications are 
usually located in the 
My Device / Program 
Files folder.
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Exploring files on an expansion card
1. Insert the expansion card into the expansion card slot. 
2. Press Start  and select Programs.
3. Select File Explorer.
4. Select the Show list in the upper-left, and then select Storage Card.
5. Select the folder or files you want to view. 
6. Press OK .

Renaming an expansion card
If you change the contents of an expansion card, you may at some point 
want to rename the card to better match its contents.

1. Insert the expansion card into the expansion card slot. 
2. Press Start  and select Programs.
3. Select File Explorer.
4. Select the Show list in the upper-left, and then select My Device.
5. Highlight the current expansion card name (Storage Card by 

default).
6. Press Menu  and select Rename.
7. Enter a new name for the card.
8. Press OK .

Tip
Before copying 
information to or 
renaming the files or 
folders on an 
expansion card, or 
renaming the card 
itself, make sure the 
card is not write-
protected. See the 
instructions that 
came with your card 
for details.
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Customizing Your 
Smartphone

Today screen settings

Selecting your Today screen background
1. Press Start  and select Settings.
2. On the Personal tab, select Today .
3. On the Appearance tab, check the Use this 

picture as the background box.
4. Select Browse.
5. Select the picture you want to use.
6. Press OK .
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Selecting which items appear on your Today screen
1. Press Start  and select Settings.
2. On the Personal tab, select Today .
3. Select the Items tab.
4. Check the boxes next to the items you 

want to appear on your Today screen and 
uncheck any items that you want to hide.

5. (Optional) Select Options (if available) to 
configure the settings for the current item. 
Press OK  to return to Today Settings.

6. Press OK .

Tip
To change the color 
theme for your 
smartphone, select a 
new theme from the 
Appearance tab in 
Today Settings. 
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Phone settings

Selecting ringtones and vibrate settings
You can set different tones for different types of incoming phone calls 
and notifications.

1. Press Start  and select Settings.
2. On the Personal tab, select Sounds & Notifications .
3. Select the Notifications tab.
4. Select the Event list, and then select which type of call or 

notification you want to set the ringtone for:
• Phone: Known Caller: An incoming 

call from someone in your Contacts list 
or Speed Dial list.

• Phone: Missed call: A call you did not 
answer.

• Phone: Roaming: A call that comes in 
when you’re outside your home mobile 
network.

• Phone: Unknown Caller: An 
incoming call from someone identified 
by caller ID who is not in your Contacts 
list or Speed Dial list. 

• Phone: Voice mail: A new voicemail.
5. Select the Ring type list, and then select the ring style for the 

selected type of call.
6. Select the Ring tone list, and then select the sound for the selected 

type of call.

Before You Begin[ ! ]
Turn on your phone to 
access your Phone 
Settings. See “Turning 
your phone on and 
off” on page 11.

Did You Know
You can download 
MPEG4, MP3, MIDI, 
QCELP, and WAV 
ringtones directly to 
your smartphone (see 
“Downloading files 
and images from a 
web page” on 
page 94). You can also 
download ringtones to 
your computer and 
then email them to 
your phone.
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7. Check the Vibrate when… boxes to turn the vibrate feature on/off 
based on the ringer switch setting.

8. (Optional) Select Play to preview the sound.
9. Repeat steps 4–7 to select ringtones for other types of calls. 

10. Press OK .

Adjusting volume settings
• Call volume: While a call is in progress, press the Volume button (on 

the side of your smartphone) to adjust the call volume. 

• Music/Video volume: While playing music or a video, press the 
Volume button to adjust the music/video volume.

• Ringer volume: When a call is not in progress and you are not 
playing music or a video, press the Volume button to adjust ringer 
volume.

Assigning a picture and ringtone ID to a contact
1. Press Start  and select Contacts.
2. Highlight the contact you want to give a picture caller ID, and then 

press Center.
3. Highlight the contact’s name, press Edit , and then select Edit.
4. Select Picture.
5. Select Camera to take a picture and add it to this contact entry (if 

your smartphone includes a camera), or select an existing picture 
for this contact entry.

6. Select Ring tone and select a tone for this contact entry.

Tip
To record, preview, 
delete, and send 
sounds on your 
smartphone, select 
Manage. To record a 
sound, press Menu 
and select New 
Sound. To play a 
sound, select it. To 
delete a sound, 
highlight it and press 
Backspace. To send a 
sound, highlight it, 
press Menu and 
select Send Sound.
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Selecting your call settings
1. Press Start  and select Settings.
2. On the Personal tab, select Phone .
3. On the Phone tab, set any of the 

following options:
• Dialpad: Sets the style for the dial 

pad tones (DTMF) in the Phone 
application. 
— Short tones: Tones sound briefly 

as you dial.
— Long tones: Tones continue to 

sound until you release the key.
• TTY/TDD: Lets you configure your smartphone for use with a 

TTY/TDD device for people who are deaf or hard of hearing.
• After calls from numbers that are not in Contacts, ask if I 

want to add them: Indicates whether you are prompted to add 
contact entries for numbers that are not already in your 
Contacts list.

4. Press OK  to finish.

Before You Begin[ ! ]
Turn on your phone 
to access your Phone 
Settings. See 
“Turning your phone 
on and off” on 
page 11.

Tip
If you have trouble 
accessing a voicemail 
system, try changing 
the Dialpad tone 
setting.
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Selecting your privacy settings
1. Press Start  and select Settings.
2. On the Personal tab, select Phone .
3. Select the Services tab and set any of the 

following options:
• Voice Privacy: Prevents over-the-air 

eavesdropping when this option is 
turned on and this feature is available 
on the Verizon Wireless network.

• Location Privacy: Indicates whether 
your smartphone broadcasts your 
location at all times, or only during a 911 call.

4. Press OK  to return to Phone Settings.
5. Press OK  to finish.

Selecting your wireless band
The wireless band setting is preset for optimum performance. Do not 
change this setting unless instructed to do so by a Verizon Wireless 
representative.

1. Press Start  and select Settings.
2. On the Personal tab, select Phone .
3. Select the Network tab.
4. Select the Band selection list, and then 

select the band you want your 
smartphone to use to connect to the 
Verizon Wireless network.

5. Press OK  to finish.

Tip
For quick access to the 
Location Privacy 
setting, tap the 
Location Privacy icon 
on your Today Screen.
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System sound settings 
You can immediately silence all sounds on your smartphone, including 
smartphone ringtones, Calendar notifications, and system sounds. This 
does not mute the speaker during phone calls.

Setting the ringer switch
1. Slide the ringer switch to Sound Mode Off .
2. To hear all sounds again, slide the ringer switch to Sound Mode 

On .

When you slide the ringer switch back to the Sound Mode On position, 
it restores the previous sound settings. For example, if the smartphone 
ring volume is set to the loudest setting and you slide the ringer switch 
to Sound Mode Off, you do not hear the smartphone ring. When you 
move the ringer switch back to Sound Mode On, the smartphone ring 
volume is still set to the loudest setting.

Tip
If the ringer switch is 
set to no sound, the 
ringer setting 
overrides the sound 
settings and all 
sounds are turned off.

Did You Know
Your smartphone 
includes a silent alarm 
that can vibrate even 
when the ringer switch 
is set to Sound Mode 
Off. 

Sound
Mode Off

Sound 
Mode On
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Selecting Sounds & Notifications
1. Press Start  and select Settings.
2. On the Personal tab, select Sounds & Notifications .
3. On the Sounds tab, set any of the following options:

• Events: Turns sounds on/off for 
system warnings and error messages.

• Programs: Turns sounds on/off in the 
applications on your smartphone. 

• Notifications: Turns alarms and 
reminders on/off in the applications on 
your smartphone.

• Screen taps: Turns sounds associated 
with tapping the screen on/off, and sets 
the volume level when this sound is 
turned on.

• Hardware buttons: Turns sounds associated with pressing 
buttons on/off, and sets the volume level when this sound is 
turned on.
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4. Select the Notifications tab and set any of the following options:
• Event: Specifies which action you 

want to change the settings for. The 
remaining options vary based on the 
action you select.

• Play sound: Lets you turn the sound 
on/off for the selected event. To select a 
different sound select the list to the 
right of this setting, and then select a 
different sound. To preview the sound, 
select Play Sound, and then select Play.

• Repeat: Indicates whether the sound 
plays more than once, if turned on.

• Display message on screen: Indicates whether a notification 
message appears onscreen for the selected event.

• Vibrate: Indicates whether your smartphone vibrates to notify 
you about the selected event.

5. Press OK .

Tip
To record, preview, 
delete, and send 
sounds on your 
smartphone, select 
the Manage tab. To 
record a sound, press 
Menu and select New 
Sound. To play a 
sound, select it and 
press Play. To delete a 
sound, highlight it 
and press Backspace. 
To send a sound, 
highlight it, press 
Menu, and select 
Send Sound.
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Display and appearance settings

Adjusting the brightness
1. Press Option , and then press . 
2. Press Left  and Right  to adjust the brightness.
3. Press OK .

Changing the text size
1. Press Start  and select Settings.
2. Select the System tab, and then select Screen .
3. Select the Text Size tab. 
4. Press Left  and Right  to adjust the text size.
5. Press OK .

Setting display formats
1. Press Start  and select Settings.
2. Select the System tab, and then select 

Regional Settings .
3. On the Region tab, select a region from 

the list. The region selection sets the 
default format settings.

4. (Optional) Select any of the following tabs 
to customize the format settings:
• Number: Sets the decimal symbol and 

number of decimal places, the digit 
grouping symbol and group size, list separators, negative 

Tip
If text looks rough 
around the edges, 
open the Screen 
Settings screen and 
select Clear Type. 
Check the Enable 
Clear Type box, and 
then press OK.
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number sign symbol and format, leading zero display, and 
measurement system (metric vs. U.S.).

• Currency: Sets the currency symbol and position, the decimal 
symbol and position, digit grouping symbol and group size, and 
negative number format.

• Time: Sets the time style, separators, and AM and PM symbols.
• Date: Sets the short date style, separators, and long date style.

5. Press OK .

Aligning the screen
Occasionally, your screen can move out of alignment, causing the 
wrong feature to activate when you tap the screen. If this occurs, you 
need to align your smartphone screen.

1. Press Start  and select Settings.
2. Select the System tab, and then select Screen .
3. On the General tab, select Align Screen. 
4. Tap the screen where indicated.
5. Press OK .

Changing the system color scheme
1. Press Start  and select Settings.
2. On the Personal tab, and then select Today .
3. On the Appearance tab, select a theme in the list.
4. Press OK .

Tip
You can also set the 
background for your 
Today screen (see 
“Selecting your Today 
screen background” 
on page 157).
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Application settings

Arranging the Start menu
You can select which applications appear in 
the top level of the Start menu. You can still 
access the remaining applications by 
selecting Programs from the Start menu, and 
then selecting the application’s icon.

1. Press Start  and select Settings.
2. On the Personal tab, select Menus .
3. Check the boxes next to the applications 

you want to see in the Start menu. 
4. Press OK .

Reassigning buttons
Buttons Settings lets you select which 
applications are associated with many of the 
buttons and key combinations on your 
smartphone.

1. Press Start  and select Settings.
2. On the Personal tab, select Buttons .
3. On the Program Buttons tab, highlight the 

button or key combination you want to 
change in the Buttons list. The hardware 
buttons are mapped to the following 
button numbers:
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• Start  = Start Menu.
• OK  = OK/Close.
• Option  + Phone/Send  = Internet Explorer.
• Option  + Start  = Calendar.
• Option  + OK  = Task Manager.
• Side button = Windows Media.

4. Select the Assign a program list, and then select the application 
you want to assign to the button or key combination you selected in 
step 3.

5. Press OK .

Using voice commands
1. Assign a Voice Command button. See “Reassigning buttons” on 

page 168 for details.
2. Hold your device about 9" away, and then press and release the 

Voice Command button. A tone plays and a microphone icon 
appears at the top of your screen. 

3. In a clear voice say, the command. For example, to access Help, say 
“Help.” 

4. After Voice Command finishes speaking a microphone icon appears 
at the top of your screen; say your answer. For example, say 
“General” to access general Help topics.

Setting input options
1. Press Start  and select Settings.
2. On the Personal tab, select Input .
3. Select the Word Completion tab and set any of the following 

options:

Tip
To enter a suggested 
word, simply tap it. 

Tip
You can also press the 
Voice Command 
button during a 
question to interrupt. 
Once the microphone 
icon is visible you 
may say your answer.
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• Suggest words when entering text: 
Indicates whether word suggestions 
appear as you enter text. You can also 
specify how many letters you want to 
enter before a suggestion appears, 
how many suggestions you want to 
see, and whether a space appears after 
you insert a suggested word.

• Replace text as you type: Indicates 
whether the text you type adds to 
existing text or replaces it. This is 
similar to the Insert function on a computer keyboard.

4. Select the Options tab and set any of the following options:
• Voice recording format: Sets the format 

in which you save voice notes.
• Default zoom level for writing: Sets 

the initial size of text entered using 
onscreen writing methods.

•  Default zoom level for typing: Sets 
the initial size of text entered using the 
keyboard.

• Capitalize first letter of sentence: 
Sets whether the first letter of a 
sentence automatically appears in 
uppercase, without pressing one of the Shift keys.

• Scroll upon reaching the last line: Sets whether the display 
automatically scrolls when you select the last line of visible info.

5. Press OK .



数码说明书之家—WWW.54GG.COM
Using Your Treo 700w Smartphone 171

Locking your smartphone and info CHAPTER 9

Locking your smartphone and info
Your smartphone includes several features that help you protect your 
smartphone from inadvertent use and keep your information private. 
The built-in security software lets you use your smartphone for 
emergency calls, such as dialing 911, even if it is locked.

• Keyguard: Manually disables all buttons and the screen’s touch-
sensitive feature to prevent accidental presses in your briefcase or 
pocket.

• Auto-Keyguard and touchscreen lockout: Automatically enables 
Keyguard after a period of inactivity and lets you disable the screen’s 
touch-sensitive feature during an active call.

• Phone Lock: Requires a lock code to make calls.

• System password lock: Requires a password to see any 
information on your smartphone.

Using Keyguard
You can lock the keyboard so that you don’t accidentally press buttons 
or activate screen items while your smartphone is in a pocket or bag.

1. With your smartphone screen on, press Option  and Power/End 
 to enable Keyguard.

2. To disable Keyguard, press Center.

Using Auto-Keyguard and touchscreen lockout
Auto-Keyguard lets you automatically lock the keyboard after a period 
of inactivity.

1. Press Start  and select Settings.

Tip
To avoid accidentally 
pressing onscreen 
buttons while you’re 
holding your 
smartphone up to 
your ear to speak, you 
can disable the 
screen’s touch-
sensitive feature 
during active calls. 
When the screen’s 
touch-sensitive 
feature is disabled, 
you must use the 
5-way navigator to 
access items on the 
screen.
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2. On the Personal tab, select Keyguard .
3. Set any of the following options:

• Auto-Keyguard: Sets the period of 
inactivity that passes before the 
keyboard automatically locks, or 
disables the auto-keyguard feature.

• Disable touchscreen: Indicates 
whether the screen’s touch-sensitive 
feature is enabled during a call. 

4. Press OK .

Using Phone Lock
You can lock your smartphone to prevent unauthorized use of your 
mobile account. When your smartphone is locked, you must enter a lock 
code to place calls, except for emergency numbers.

1. Press Start  and select Settings.
2. On the Personal tab, select Phone .
3. Select the Security tab and set any of the 

following options:
• Auto-lock: Sets whether your 

smartphone locks automatically and 
when this occurs.

• Change passcode: Lets you assign or 
change the lock code used to unlock 
your smartphone. Your default lock 
code is the last four digits of your mobile phone number. If you 
change the lock code, select OK to accept your new code.

4. Press OK  to finish.

Tip
When Phone Lock is 
on, you can unlock 
your smartphone by 
going to the Today 
screen, entering your 
lock code, and then 
selecting Enter. You 
do not need to enter 
your password to 
answer a call.
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Using system password lock
To protect your personal information, you can lock the system so that 
you need to enter your password to access any of your information or 
use other features of your smartphone.

If you lock your system, you must enter the exact 
password to unlock it. If you forget the password, you need to perform 
a hard reset to resume using your smartphone. Performing a hard reset 
deletes all the entries in your smartphone. However, you can restore all 
previously synchronized info the next time you sync (see 
“Synchronizing contacts and other info” on page 28).

1. Press Start  and select Settings.
2. On the Personal tab, select Password .
3. On the Password tab, check the Prompt if 

device unused for box to turn on the 
password feature.

4. Select the first list, and then select how 
long a period of inactivity must pass 
before you are prompted to enter a 
password to unlock the system.

5. Select the Password type list, and then 
select a format for your password.

6. Select password and enter your 
password.

7. (Optional) Select the Hint tab and enter a hint to help you recall your 
password.

8. Press OK .

IMPORTANT[ ! ]
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Entering owner information
You can enter personal information that you want to associate with 
your smartphone, such as your name, company name, and phone 
number. You can also set whether you want this information to appear 
when you turn on your smartphone. If you lose your smartphone, this 
feature can help the person who finds it return it to you.

1. Press Start  and select Settings.
2. On the Personal tab, select Owner 

Information .
3. On the Identification tab, enter any of the 

contact information you want to include.
4. Select the Notes tab and then enter any 

additional text you want to include.
5. Select the Options tab and check the 

boxes to indicate which info (if any) you 
want to appear on the screen when you 
turn on your smartphone. 

6. Press OK .

Tip
You can also display 
your Owner 
Information on your 
Today screen. See 
“Selecting which 
items appear on your 
Today screen” on 
page 158 for details.
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Setting the date and time
Clock & Alarms Settings lets you set the time zone, time, and date for 
your home location and a location that you visit.

1. Press Start  and select Settings.
2. Select the System tab, and then select Clock & Alarms .
3. On the Time tab, select Home.
4. Select the first list, and then select the 

time zone for your home location.
5. Select the hour, and then press Up  or 

Down  to increase or decrease the hour 
setting. Repeat this process for the 
minute, seconds, and AM/PM settings.

6. (Optional) Select Visiting and set the info 
for a location that you visit often.

7. Press OK .
8. If prompted, select Yes to accept your 

changes.

Tip
By default your 
smartphone 
synchronizes the date 
and time with the 
Verizon Wireless 
network whenever 
your phone is on and 
you are inside a 
coverage area. You 
can disable this option 
in Clock & Alarms 
Settings by selecting 
More, and then 
unchecking the Enable 
local network time 
box. 

Tip
To set the display 
format for the date 
and time, see “Setting 
display formats” on 
page 166.
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Setting system alarms
System alarms let you set alarms that are not associated with a task or 
appointment. For example, you can use your smartphone as an alarm 
clock when you travel, or set alarms to remind you when it’s time to 
take medication or pick up the kids. 

1. Press Start  and select Settings.
2. Select the System tab, and then select 

Clock & Alarms .
3. Select the Alarms tab. 
4. Check a box to turn on that alarm.
5. Select the description next to the box you 

checked and enter a description for the 
alarm.

6. Select the days of the week you want the 
alarm to go off. You can select multiple 
days for each alarm.

7. Select the time you want the alarm to go off, and then press OK .
8. Select , check the boxes to select how you want the alarm to go 

off, and then press OK .
9. Press OK  to finish.

10. If prompted, select Yes to accept your changes.

Tip
To change the alarm 
sound, select the 
alarm sound icon, 
select the Play Sound 
list, and then select 
the alarm sound you 
want to use.

Tip
To delete a certificate, 
tap and hold the 
certificate in the list, 
and then select Delete 
from the shortcut 
menu.
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Managing identity certificates
Your smartphone may include preinstalled certificates. Certificates are 
digital documents that are used to authenticate and exchange 
information on networks. Certificates can be issued for a user, a device, 
or a service. 

1. Press Start  and select Settings.
2. Select the System tab, and then select Certificates .
3. Select any of the following:

• Personal: Displays certificates that establish your identity when 
you log in to a secured network, such as a corporate network. 

• Root: Displays certificates that identify the computers, such as 
servers, that you connect to. These certificates help prevent 
unauthorized users from accessing your smartphone and 
information.

4. Press OK  to finish.

Enabling error reporting
Error Reporting sends info that helps diagnose application errors for 
devices running Windows Mobile software. When an error is detected, a 
text file is created. You can review the file and choose whether you want 
it delivered to technical support. The information is used by 
programming groups at Microsoft for quality control and is not used for 
tracking individual users or installations for any marketing purpose. The 
info that is collected is technical info about the state of your system 
when the error occurred. No documents (or any info contained in them) 
are intentionally sent with the report. To ensure further security, the 
report is transmitted via a secure connection and is kept confidential 
and anonymous in a limited-access database. 

Tip
This error reporting 
method meets the 
privacy regulations of 
the European Union 
(EU) as well as the Fair 
Information Practice 
Principles of the 
Federal Trade 
Commission. To view 
the Fair Information 
Practice Principles, 
visit the Federal Trade 
Commission website 
at www.ftc.gov/

reports/privacy3/

fairinfo.htm.

http://www.ftc.gov/reports/privacy3/fairinfo.htm
http://www.ftc.gov/reports/privacy3/fairinfo.htm
http://www.ftc.gov/reports/privacy3/fairinfo.htm
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If your smartphone is connected to your computer when you send the 
error report, you are not billed for sending error reports—provided your 
computer is connected to the Internet. If you use the Verizon Wireless 
network to send an error report, data transfer charges apply. 

1. Press Start  and select Settings.
2. Select the System tab, and then select Error Reporting .
3. Select whether you want to enable or disable error reporting.
4. Press OK  to finish.

Setting up a GPS device
If you purchased an optional Global Positioning System (GPS) receiver, 
your smartphone can show your exact location on a map. 

1. Press Start  and select Settings.
2. Select the System tab, and then select GPS .
3. On the Programs tab, select the GPS program port list, and then 

select the port for applications to use to access GPS info. This port 
must also be selected in your GPS application’s configuration 
settings.

4. Select the Hardware tab.
5. Select the GPS hardware port list, and then select the port to which 

your GPS receiver is connected. This must be a different port from 
the one you set in step 4 as your program port. 

6. Select the Access tab and check the Manage GPS automatically box. 
This setting lets more than one application simultaneously access 
your GPS info.

7. Press OK  to finish.
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Viewing memory usage.
1. Press Start  and select Settings.
2. Select the System tab, and then select Memory .
3. Select any of the following tabs:

• Main: Displays the amount of memory assigned to your 
applications and info, as well as the amount of memory in use 
versus the available memory.

• Storage Card: Displays the amount of memory available on an 
expansion card that is inserted in the expansion slot on your 
smartphone.

• Running Programs: Lists the applications that are in use on 
your smartphone. To switch to an application, highlight it and 
select Activate. To close an application, highlight it and select 
Stop. To close all open applications, select Stop All.

4. Press OK  to finish.
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Viewing and optimizing power settings
1. Press Start  and select Settings.
2. Select the System tab, and then select Power .
3. On the Battery tab, view the power remaining in your battery. 
4. Select the Advanced tab and set whether your smartphone’s screen 

turns off automatically after a specified period of inactivity. You can 
assign different intervals for battery power and external power.

5. Press OK  to finish.

Tip
To conserve 
additional battery 
power, adjust the 
display backlight 
setting. Press Start 
and select Settings. 
Select the System tab, 
and then select 
Backlight. On the 
Battery Power tab, set 
whether the display 
backlight turns off 
automatically after a 
period of inactivity.
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Turning Wireless Services On/Off 
1. Press Start  and select Settings.
2. Select the System tab, and then select 

Power .
3. Select the Wireless tab and turn your 

smartphone’s wireless features on/off. 
4. Press OK  to finish.

You can also turn Wireless services on/off by 
tapping the the the signal-strength icon  at 
the top of the screen. 

Tip
In Flight Mode, all 
wireless features and 
accessories are 
turned off, including 
your phone, the 
Bluetooth® feature, 
and other 
accessories, such as a 
Wi-Fi® network card 
(sold separately). This 
is different than only 
turning your Phone 
off.

Tip
If you turn Flight 
Mode on, then all 
Wireless services are 
turned off. If you turn 
Flight Mode off, then 
all Wireless services 
are enabled. 



数码说明书之家—WWW.54GG.COM
182 Using Your Treo 700w Smartphone

CHAPTER 9

Connection settings

Setting up a Wi-Fi® connection
Many corporate organizations and public environments, such as coffee 
shops, airports, and libraries, offer access to a Wi-Fi network. A Wi-Fi 
network is a wireless local area network (WLAN) based on the 802.11 
standard. When you purchase an optional Wi-Fi SDIO card, you can use 
your smartphone’s built-in software to set up a Wi-Fi connection and 
quickly connect your smartphone to a Wi-Fi network when you’re within 
range of an accessible Wi-Fi network.

Some Wi-Fi networks are known as open networks because they 
broadcast their name (SSID). Networks that do not broadcast their SSID 
are known as closed networks. Both open and closed networks can be 
either encrypted or unencrypted. Follow the instructions for the type of 
network you want to connect to.

Connecting to an open network
Wi-Fi networks in public places are often open networks. Your 
smartphone automatically attempts to detect some network settings, so 
you can connect to an open network with minimal configuration.

1. Wake up your smartphone’s screen (see “Waking up the screen” on 
page 11).

2. Insert the Wi-Fi card into the expansion slot (see “Removing and 
inserting expansion cards” on page 151).

3. If the Multiple Networks Detected dialog box appears, select the 
network you want to connect to.

Tip
Turning off the 
Bluetooth® feature 
may improve your Wi-
Fi card performance. 
To turn the Bluetooth 
feature off, go to your 
Today screen, tap the 
Bluetooth icon, and 
then uncheck the Turn 
on Bluetooth box.

» Key Term
Wi-Fi access point 
(also called a hot spot) 
A network device with 
an antenna that 
provides wireless 
connections to a 
larger network.

» Key Term
SSID The name that 
identifies a Wi-Fi 
network. If a network 
does not broadcast its 
SSID, you must get 
the SSID from the 
network administrator 
in order to connect to 
the network.
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4. When the New Network Detected dialog box appears, select the 
type of network you want to connect to.

5. Press Connect  to connect to the network.
6. If prompted, enter the password provided by the network 

administrator.

Connecting to a closed network
Since closed networks have additional security features, your 
smartphone cannot detect the network’s settings; you must obtain the 
settings from the network administrator and enter the settings 
manually. You can also use these steps to manually create a connection 
with an open network.

1. Wake up your smartphone’s screen (see “Waking up the screen” on 
page 11), and then insert the Wi-Fi card into the expansion slot 
(“Removing and inserting expansion cards” on page 151).

2. Tap Wi-Fi  in the title bar.
3. Select the Settings link.
4. Select Network Cards .
5. Select Add New.
6. On the General tab, set the following:

• Network Name: Specifies the SSID 
provided by the network administrator.

• Connects to: Specifies whether this 
connections connects to the Internet or 
to Work. You may need to select Work 
to access a corporate intranet.

Did You Know
You can conserve 
battery power by 
removing the Wi-Fi 
card or turning off a 
Wi-Fi connection 
when you are not 
planning on using it 
for an extended 
period.
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• This is a device to device (adhoc) connection: Indicates 
whether you’re connecting to another device or to an access 
point (network).

7. Select the Network Key tab, and then set the following:
• Authentication: Sets the method 

used to identify devices that connect to 
the network.
— Open: Indicates the network is an 

unencrypted WEP network.
— Shared: Indicates the network is an 

encrypted WEP network that 
requires a key (password).

— WPA: Indicates the network is a 
WPA network that uses 802.1x 
protocols.

— WPA-PSK: Indicates the network is a WPA network that 
requires a pre-shared key (password).

• Data Encryption: Sets the encryption method. The options in this 
list vary based on your Authentication setting.
— Disabled: Turns data encryption off.
— WEP: Turns on the wired equivalent privacy encryption 

method.
— TKIP: Turns on the temporal key integrity protocol encryption 

method. This method is often used to encrypt WPA and WPA-
PSK connections.

• The key is automatically provided: Indicates whether you 
need to specify the Network key and Key index provided by your 
network administrator, or whether the network provides this 
information. The availability of these options varies based on 
your Authentication and Data Encryption settings.
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8. Select the 802.1x tab, and then set the 
following if available (the settings vary 
based on your settings on the other tabs):
• Use IEEE 802.1x network access 

controls: Lets you set these 
parameters if required by the network.

• EAP type: Specifies the extensible 
authentication protocol type.

9. Press OK .

Selecting a Wi-Fi network
After you set up a Wi-Fi connection, it’s easy to connect to that network. 
If you have access to multiple Wi-Fi networks, you can select which 
network you want to connect to. 

1. Wake up your smartphone’s screen (see “Waking up the screen” on 
page 11), and then insert the Wi-Fi card into the expansion slot 
(“Removing and inserting expansion cards” on page 151).

2. Tap Wi-Fi  in the title bar.
3. Select the Settings link.
4. Select Network Cards .
5. Select the name of the network you want to connect to. 

Tip
Insert the Wi-Fi card 
in your smartphone 
to automatically 
connect to the 
available Wi-Fi 
network you most 
recently connected 
to.
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Managing ISP settings
Your smartphone is already set up to connect to the Internet using a 
high-speed data connection on the Verizon Wireless network. To 
connect to the Internet, simply start Internet Explorer Mobile. 

For special situations, such as connecting to your ISP (Internet service 
provider) or a remote access server (RAS), you can set up another 
connection. Before you begin, obtain the following information from 
your ISP or system administrator: 

• ISP server phone number or access point

• Username

• Password 

1. Press Start  and select Settings.
2. Select the Connections tab, and then select Connections .
3. On the Tasks tab, select Manage existing connections.
4. Select the Modem tab. 
5. Highlight the connection you want to view or change, and then 

select Edit, or to create a new connection, select New.
6. Follow the onscreen instructions to edit or create the connection.

Connecting to a VPN
If you want to use your smartphone to access your corporate email 
account or other files on your corporate server, you may need to set up 
a VPN (virtual private network). A VPN enables you to log in to your 
corporate server through the company's firewall (security layer). 
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You need to set up a VPN to access a corporate server in either of the 
following two situations:

• Your company's wireless local area network (LAN) is outside the 
firewall.

• Your company's wireless LAN is inside the firewall, but you are 
accessing the network from outside the firewall (for example, from a 
public location or at home). 

Check with your company's system administrator to see if a VPN is 
required to access the corporate network. If you need a VPN, you must 
purchase and install a third-party VPN client to use this feature.

Before you begin setting up a VPN, ask your network administrator for 
the following information:

• Your username and password

• Your server’s domain name

• Your server’s TCP/IP settings 

• Your server’s host name or IP address

1. Install your third-party VPN client (see “Installing applications” on 
page 143). 

2. Press Start  and select Settings.
3. Select the Connections tab, and then select Connections .
4. On the Tasks tab, select Add a new VPN server connection.
5. Follow the onscreen instructions to enter the settings provided by 

your corporate system administrator.

Tip
To manually start a 
data connection on 
the Verizon Wireless 
network or another 
network, go to 
Connections Settings, 
on the Tasks tab, 
select Manage 
existing connections. 
Tap and hold the 
connection you want 
to start, and then 
select Connect from 
the shortcut menu. 

Some VPN servers 
require that you 
install specific VPN 
software on your 
smartphone. Go to 
www.palm.com/
mytreo700wVerizo
n for more 
information.
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Setting up a proxy server
1. Press Start  and select Settings.
2. Select the Connections tab, and then select Connections 
3. On the Tasks tab, select Set up my proxy server.
4. Check both the boxes near the top of the screen. 
5. Select Proxy server and enter the proxy server name. 
6. Press OK .

Ending a data connection
If your service plan includes minutes-of-use fees for data connections, 
you can reduce costs by ending the data connection when you’re done 
browsing the web.

1. Use the stylus to tap the data arrows  or  on the title bar.
2. Select Disconnect from the shortcut menu.

Tip
To change settings 
such as the port 
number, proxy server 
type, or credentials, 
select Advanced.
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Finding Help

Transferring info from another device
For information on transferring your info from a previous Windows 
Mobile device or from a Palm Powered® device to your new Palm® 
Treo™ 700w smartphone, visit www.palm.com/us/support/

Treo700wVerizon for instructions.

Do not use a backup utility to transfer your info to your 
new smartphone. This can cause your smartphone to malfunction.

Did You Know
You can purchase a 
third-party 
application that lets 
you run Palm® OS 
applications on your 
Treo 700w 
smartphone.

IMPORTANT[ ! ]

http://www.palm.com/us/support/Treo700wVerizon
http://www.palm.com/us/support/Treo700wVerizon
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Trouble installing the desktop software?
The Windows Mobile Getting Started Disc installs the software and 
drivers that let you synchronize with Microsoft Outlook for Windows. If 
you want to synchronize with a different personal information manager 
(PIM), you must install a third-party solution. Contact the PIM’s author 
or vendor to learn if software is available for your Treo 700w 
smartphone.

1. Shut down your computer, and then turn it on again.
2. Quit any active applications, including virus scanners and Internet 

security applications.
3. Make sure you’re installing the version of the software that came 

with your smartphone on the Windows Mobile Getting Started Disc. 
Other versions may not work with this smartphone.

4. Make sure your computer profile includes administrator rights to 
install software. In large organizations, these are usually granted by 
the system administrator.
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Resetting your smartphone

Performing a soft reset
A soft reset is similar to restarting a computer. If your smartphone is not 
responding or you have trouble synchronizing with your computer, a 
soft reset may help.

1. Use one hand to press the battery door release and use the other 
hand to slide the battery door downward to remove it from your 
smartphone.

2. Use the stylus tip to gently press the reset button on the back of 
your smartphone.

3. Wait for the progress bar on the Treo logo screen to fill before 
continuing to use your smartphone.

Tip
You can also do a soft 
reset by unplugging 
your smartphone from 
a power source (if 
connected) and then 
removing the battery 
and reinserting it.
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Performing a hard reset
A hard reset erases all information and third-party software on your 
smartphone. Never do a hard reset without first trying a soft reset. 
You can restore previously synchronized information the next time 
you sync. 

A hard reset can tell you whether a problem stems from your 
smartphone or from an application installed on it. If you do not 
experience the problem after you perform a hard reset, the problem 
may be related to software you installed. See “Third-party applications” 
on page 211 for suggestions on diagnosing third-party software issues.

1. Use one hand to press the battery door release and use the other 
hand to slide the battery door downward to remove it from your 
smartphone.

2. If the screen if off, press Power/End  to wake up the screen. 
3. While pressing and holding Power/End , use the tip of the stylus 

to gently press  and hold the reset button on the back of your 
smartphone.

4. Continue pressing and holding both buttons until the “Erase all 
data?” prompt appears. 

5. Press Up  to confirm the hard reset.
6. Wait for the progress bar on the Treo logo screen to fill before 

continuing to use your smartphone.

7. (Optional) Sync your smartphone with your computer to restore 
your previously synchronized info. If you use a backup utility, 
you may also need to restore a backup to recover additional info 
and settings.

Tip
Some third-party 
applications do not 
create a backup on 
your computer when 
you synchronize. If 
you do a hard reset, 
you may lose info in 
these applications 
and you need to 
reinstall the 
application after the 
hard reset. Please 
contact the developer 
to find out if your info 
is backed up during 
synchronization.
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Replacing the battery
Your smartphone comes with a replaceable battery. Be sure to use a 
replacement battery from Palm that is compatible with Palm Treo 700w 
smartphones. 

1. Press Power/End  to turn off the screen.
2. Use one hand to press the battery door release and use the other 

hand to slide the battery door downward to remove it from your 
smartphone.

3. Place a finger in the notch between the stylus and the battery and lift 
the battery up at a 45 degree angle.

4. Align the battery contacts with the phone contacts inside the battery 
compartment. 

5. Insert the battery into the compartment at a 45 degree angle, 
pressing it into place. Slide the battery door onto the back of the 
smartphone until it clicks into place.

Tip
Be sure to dispose of 
your old battery in an 
evironmentally 
responsible and legal 
way. In some areas, 
disposal in household 
or business trash is 
prohibited.

Did You Know
Your smartphone 
stores all your info 
even when you 
remove the battery.
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6. Wait for the screen to turn on, and then enable the network time or 
set the date and time when prompted.

Battery door 
release

Notch

Phone 
contacts

Battery 
contacts
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Performance

The applications are running slower than usual
1. Press Start  and select Settings.
2. Select System, and then select Memory .
3. Select Running Programs. 
4. Select Stop All to close all of your open applications.
5. Press OK .

If the previous steps don’t fix the problem, try doing a soft reset (see 
“Performing a soft reset” on page 191). If the problem persists, follow 
these steps to turn off the Voice Command setting, if it is enabled:

1. Press Start  and select Settings. 
2. Select Personal, and then select Voice Command .
3. Uncheck the Enabled box.
4. Press OK .
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Screen 

The screen appears blank
1. When the time period specified in Backlight Settings expires, the 

screen dims; one minute later, the screen automatically turns off. 
Press any key except Power/End to wake up the screen. Pressing 
Power/End hangs up the call.

2. Look closely at the screen. If you can see a dim image, try adjusting 
the screen brightness (see “Adjusting the brightness” on page 166). 

3. If that doesn’t work, perform a soft reset (see “Performing a soft 
reset” on page 191).

4. If that doesn’t work, connect your smartphone to the AC charger 
(see “Charging the battery” on page 9) and perform a soft 
reset again.

5. If that doesn’t work, perform a hard reset (see “Performing a hard 
reset” on page 192).

The screen doesn’t respond accurately to 
taps or activates wrong features

1. Make sure there is no debris trapped under the edges of the screen.
2. Start  and select Settings. 
3. Select the System tab, and then select Screen . 
4. On the General tab, select Align Screen.
5. Follow the onscreen instructions to align the screen.
6. Press OK .

Tip
To find carrying cases 
that protect the screen 
and other useful 
accessories, visit 
www.palm.com/

mytreo700wVerizon

http://
www.palm.com/mytreo700wVerizon
http://www.palm.com
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Network connection

Signal strength is weak
1. If you’re standing, move about 10 feet in any direction.
2. If you’re in a building, move near a window. Open any metal blinds.
3. If you’re in a building, move outdoors or to a more open area.
4. If you’re outdoors, move away from large buildings, trees, or 

electrical wires.
5. If you’re in a vehicle, move your smartphone so that it’s level 

with a window.

My smartphone won’t connect to the mobile network
1. Try the suggestions above for weak signals.
2. Turn off your smartphone and turn it on again (see “Turning your 

phone on and off” on page 11).
3. Perform a soft reset (see “Performing a soft reset” on page 191).

My smartphone seems to turn off by itself
If a system error and reset occur, the phone automatically turns on if it 
was on before the reset. However, if your smartphone can’t determine if 
your phone was on before the reset, it does not automatically turn on 
the phone (see “Turning your phone on and off” on page 11).

Tip
Become familiar with 
low coverage areas 
where you live, 
commute, work, and 
play, so you know 
when to expect signal 
strength issues.
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I can’t tell if data services are available 
The following icons appear in the title bar to indicate whether data 
services are available:

My smartphone won’t connect to the Internet
Your smartphone supports 1xRTT or EVDO wireless data networks. 
To connect to the Internet, you must subscribe to and subscribe to data 
services with Verizon Wireless. 

• Contact Verizon Wireless to verify that your subscription plan 
includes data services and that these services have been correctly 
activated. Verizon Wireless should also be able to tell you if there are 
any outages in your location. 

 or 
Your phone is on and an EVDO or 1xRTT network is within 
range. You can make or receive calls or open a data 
connection.

 or Your phone is on and an EVDO or 1xRTT data connection 
is dormant. You can still make or receive calls.

 or 

Your phone is on and an EVDO or 1xRTT data connection 
is active. If an EVDO data connection is active, you can still 
make or receive calls. If a 1xRTT data connection is active, 
you can still make calls, but you cannot receive calls 
(incoming calls go to voicemail). 

0

Your smartphone is connected to a computer or network 
which providing a data connection.

0

A data connection is not available or phone is turned off 
(the wireless connection is off).

» Key Term
1xRTT (Single carrier 
[1x] radio 
transmission 
technology): A 
wireless technology 
that can provide fast 
data transfer and 
Internet access with 
speeds of up to 
144Kbps. 

» Key Term
EVDO (Evolution Data 
Optimized): A wireless 
broadband technology 
that is designed for 
very high-speed data 
transfer with speeds of 
up to 600Kbps. 
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• Press and hold Power/End  to turn off your smartphone. Then 
press and hold the same button to turn it back on again.

• Perform a soft reset (see “Performing a soft reset” on page 191).

• Confirm that data services are correctly configured on your 
smartphone:

1. Start  and select Settings. 
2. Select the Connections tab, and then select Connections . 
3. On the Tasks tab, select Manage existing connections.
4. If Broadband Access appears in the list, press OK . If not, contact 

Verizon Wireless for assistance.

I can’t send or receive text or multimedia messages
• Make sure your phone is on (see “Turning your phone on and off” on 

page 11).

• Contact Verizon Wireless to verify that your plan includes messaging 
services, that these services have been correctly activated, and that 
they are available at your location (Verizon Wireless should be able to 
tell you if messaging services have been experiencing transmission 
delays).

• If possible, contact the recipient or sender of the message, and make 
sure the receiving device can handle the type of message you’re 
sending.

• If a text message arrives but does not display a notification, perform 
a soft reset (see “Performing a soft reset” on page 191).
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I can’t make or receive calls using a hands-free 
device with Bluetooth® wireless technology
Check all of the following:

• The Turn on Bluetooth box is checked in Bluetooth Settings.

• Your Bluetooth device is charged and turned on.

• Your smartphone is within range (30 feet) of the hands-free device.

• The Bluetooth Settings screen is closed.

• Move away from other devices using the 2.4 GHz radio frequency, 
such as cordless phones, microwaves, and Wi-Fi® equipment.

• Check the device specifications to ensure it is compatible with your 
smartphone.
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Synchronization (ActiveSync® software)
Synchronization lets you back up the information on your smartphone 
onto your computer. If you ever need to perform a hard reset or 
otherwise erase all your information on your smartphone, you can 
synchronize your smartphone with your computer to restore the info. 
To make sure you always have an up-to-date backup of your info, 
synchronize frequently.

Before you attempt to synchronize, make sure you’ve installed the 
desktop synchronization software from the Windows Mobile Getting 
Started Disc.

ActiveSync Desktop does not respond to sync attempt
As you complete the following steps, synchronize after each step. If the 
synchronization is successful, you do not need to complete the 
remaining steps. 

1. Verify that the USB sync cable is securely connected at all points 
(see “Synchronizing contacts and other info” on page 28).

2. Look for the ActiveSync icon  at the top of your smartphone’s 
screen and the ActiveSync icon  in the taskbar on your computer 
to make sure the ActiveSync software is running on your computer. 

3. Double-click the ActiveSync icon  in your taskbar. From the File 
menu, select Connection Settings. Make sure the Allow USB 
connections box is checked, and then click Connect.

4. Perform a soft reset (see “Performing a soft reset” on page 191).
5. Restart your computer and make sure ActiveSync is running.
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6. If problems persist and you’re synchronizing through a USB hub, try 
connecting the sync cable to a different USB port or directly to your 
computer’s built-in USB port. 

7. If you’re already synchronizing through a built-in USB port on the 
front of your computer, move the sync cable to a USB on the back of 
your computer (if your computer has USB ports in both places). 

8. Uninstall the desktop software that came with your smartphone, 
and then insert the Windows Mobile Getting Started Disc that came 
with your smartphone and repeat the installation process.

9. Verify with your computer hardware vendor that your operating 
system supports your internal USB controller.

Synchronization finishes but info doesn’t appear 
where it should
• With the included software, your smartphone can synchronize with 

the root folders of Contacts, Calendar, Tasks, and Notes. If you want 
to synchronize with a global Exchange Address Book, you must copy 
the addresses to your local Contacts list in Outlook (right-click the 
addresses and select Add to Personal Address Book). 

• Outlook subfolders and public folders are not accessible with the 
included software. You may wish to use a third-party solution 
instead.

• If you’re trying to synchronize offline, be sure to set your Outlook 
Calendar, Contacts, Notes, and Tasks to be available offline.

• If you’re still having problems, try the following:
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1. Make sure you’re synchronizing with the intended desktop personal 
information manager (PIM). The Windows Mobile Getting Started 
Disc lets you synchronize with Microsoft Outlook for Windows. If 
you use a different PIM, you need to install third-party software to 
synchronize. Consult the company that makes the PIM for more 
information.

2. Open ActiveSync on your computer, and make sure the necessary 
synchronization settings are set to synchronize the files.

3. Uninstall the ActiveSync software, reboot your computer, and then 
insert the Windows Mobile Getting Started Disc that came with your 
smartphone and repeat the installation process.

My appointments show up in the wrong time slot after I sync
1. Make sure that you installed the desktop software that came with 

your smartphone. If you're not sure whether this software is 
installed, reinstall it. 

2. Open Microsoft Outlook and correct the wrong entries.
3. Manually enter any information you've added to your smartphone 

since the last time you synchronized.
4. Synchronize your phone and your computer.

You should now be able to assign time zones to your events without 
encountering this problem.
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Email

I have problems using my account
Occasionally you may experience problems using an email account 
after you set it up. If you followed the account setup procedure and are 
experiencing problems using the account, verify that the account 
complies with your email provider’s requirements by following these 
steps:

• Verify both your password and your username for your email 
account.

• Some wireless service providers require you to be on their network 
to use your email account. If this is the case, be sure to use your 
provider's network as the connection type for the account.

• Some wireless service providers have other requirements specific to 
their service. For example, Yahoo! requires you to set up POP mail 
forwarding for your Yahoo! account to download email messages to 
your smartphone. Check with your service provider to see if any 
provider-specific requirements exist.

• Service provider settings frequently change. If your email account 
was working but you are currently experiencing problems, check with 
your service provider to see if any of the account settings have 
changed.
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I have problems sending and receiving email
Short periods of time when email is unavailable are common due to 
server problems or poor wireless coverage. If you have problems 
sending or receiving mail for an extended period of time, check with 
your ISP or email service provider to verify that the service is working 
properly. 

Auto Sync is not working
If Auto Sync is occurring and you turn your smartphone off or the 
connection to your email service provider is disconnected, the Auto 
Sync fails. 

I have problems sending email
If you are able to receive email messages but cannot send them, try 
these steps, in turn:

• Make sure your ISP or email provider allows you to access email on a 
smartphone. Some providers do not offer this option at all; other 
providers require an upgrade to access email on a smartphone.

• Turn on ESMTP. Many services require authenticated access, or 
ESMTP, to use their SMTP servers. 

• Enter the name of a different outgoing mail server for sending mail. 
Many ISPs, such as cable companies, require that you have an 
Internet connection to their network to send email through their 
servers. In this case, you can almost always receive email from these 
accounts, but if you want to send email, you must send it through 
another server.
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I have problems synchronizing messages on my
smartphone with messages on my computer
Make sure you have chosen the same settings for the account on both 
your smartphone and your computer. For example, if the account is set 
up on your smartphone to use the POP protocol, check the ActiveSync 
settings on your computer to make sure that POP is selected as the 
protocol for that account.

My vCard or vCal email attachment isn’t 
forwarding correctly
Microsoft Outlook provides several features that work with email client 
software on a Windows computer. For these features to work correctly, 
the email client software must be properly set up. Follow these steps to 
check the settings:

1. Click Start on your computer, and then select Settings.
2. Select Control Panel.
3. Select Internet Options, and then click the Programs tab.
4. Make sure that the email field is set to the correct email client 

software. 
5. Click OK.
6. Start the email client software and make sure it is configured as the 

default MAPI client. Consult the documentation for your desktop 
email application for more information.
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When I sync with my Exchange Server my 
info is not downloading to my smartphone
Check with your system administrator to obtain the name of the mail 
server that offers you wireless access to the corporate mail system. If 
you cannot obtain the name of this server (some companies do not give 
it out, because they do not want wireless access to their servers), you 
cannot use ActiveSync to synchronize with the Exchange Server.
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Web

I can’t access a page
First, make sure you have Internet access: Open Internet Explorer 
Mobile and try to view a web page you’ve loaded before. To ensure 
you’re viewing the page directly from the Internet, press Menu  
and select Refresh. After confirming your Internet connection, try to 
view the page in question again. If it comes up blank, press Menu  
and select Refresh.

If you’re still having trouble, the page may contain elements that are not 
supported by Internet Explorer Mobile, such as Flash, Shockwave, 
VBScript, WML script, and other plug-ins.

Some websites use a redirector to their true home page (for example, if 
you enter the address http://www.palm.com/support it may resolve to 
http://www.palm.com/us/support). If Internet Explorer Mobile can’t 
follow the redirect, try using a desktop browser to see the landing page 
of the redirector, and enter that address in Internet Explorer Mobile.

An image or map is too small on my smartphone screen
Internet Explorer Mobile has several viewing modes: One Column, 
Default, Desktop, and Full Screen. Switch to Desktop to see the full-size 
image (see “Viewing a web page” on page 91).

A secure site refuses to permit a transaction
Some websites don’t support certain browsers for transactions. Please 
contact the site’s webmaster to make sure the site allows transactions 
using Internet Explorer Mobile.

Tip
Your smartphone can 
open your email 
application when you 
select an email 
address on a web 
page. If nothing 
happens when you 
select the link, try 
setting up your email 
application first.
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Camera
If your smartphone does not have a built-in camera, then the 
information in this section about taking pictures does not apply to you. 

Here are some tips for taking good pictures with the built-in camera:

• Clean the camera’s lens with a soft, lint-free cloth.

• Take pictures in bright lighting conditions. Low-light images may be 
grainy, due to the sensitivity of the camera.

• Hold the camera as still as possible. You may want to support your 
picture-taking arm against your body or a stationary object (such as a 
wall).

• Keep the subject of the pictures still. Exposure time is longer with 
lower light levels, so you may see a blur.

• For best results, verify that you have the brightest light source 
coming from behind you, lighting the subject’s face. Avoid taking 
indoor pictures with the subject in front of a window or light.

• Make sure the subject is at least 18 inches away from the camera to 
ensure good focus.

Remember, when you synchronize, your Camera images are stored in 
the C:\Documents and Settings\<Username>\My Documents\Treo My 
Documents folder on your hard drive (see “Viewing pictures and videos 
on your computer” on page 111).

Did You Know
Pictures are 16-bit 
color. Resolution 
settings range from 
1280 x1024 to 160 x 
120 pixels (1.3 
megapixels to VGA). 
Video resolution 
settings range from 
352 x 288 to 176 x 144 
pixels. You can 
change the resolution 
setting by pressing 
Menu and selecting 
Resolution (still 
images) or Quality 
(video).
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The Camera preview image looks strange
Some third-party applications overwrite your smartphone’s color 
settings with their own 8-bit color settings. This can affect the Camera 
Preview Mode. Delete third-party applications one by one until the 
preview image improves.
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Third-party applications
Sometimes, third-party applications can cause conflicts on your 
smartphone. Third-party applications that modify wireless features may 
affect your smartphone’s performance and may require extra 
troubleshooting. Use caution when installing the following types of 
applications:

• Ringtone managers

• Caller ID applications

• Instant messaging

• Applications that modify when your phone or data connections turn 
on or off and how your phone behaves

If you recently installed an application and your smartphone seems to 
be stuck, try the following: 

1. Perform a soft reset (see “Performing a soft reset” on page 191).
2. Make sure the third-party application is compatible with the 

Windows Mobile version 5.0.2. operating system on your 
smartphone.

3. Delete the most recently installed application from your 
smartphone (see “Removing applications” on page 145).

4. If the problem persists, perform another soft reset.
5. If possible, synchronize or use a backup utility to back up your most 

recent info.
6. Perform a hard reset (see “Performing a hard reset” on page 192).
7. Synchronize or restore your backup to restore the info in your built-

in applications.

Tip
Remember, not all 
third-party 
applications were 
written with the Treo 
700w smartphone 
keyboard and 5-way 
navigator in mind. 
You may encounter 
strange behavior or 
errors in these 
applications if you use 
the keyboard and 5-
way navigator.
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8. If the problem is resolved, begin reinstalling your third-party 
applications one at a time.

9. If the problem recurs, delete the last application you installed and 
report the problem to its developer.

Getting more help
Contact the author or vendor of any third-party software if you require 
further assistance. 
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Error messages
Your smartphone is designed to minimize interruptions when a system 
error occurs. If a system error occurs, your smartphone automatically 
resets itself and resumes functioning as normal. If possible, it even 
turns your smartphone back on if it was on before the error occurred.

Sometimes, you might want to know more about an error. Your 
smartphone uses a special interface to show error messages in greater 
detail.

1. Go to the Dial Pad.
2. Enter #*377, and then press Phone/Send .
3. Review the screen with details about the conditions that lead up to 

the most recent automatic reset. 
4. Select OK.

Please note that third-party developers create their own error 
messages. If you do not understand an error message, please contact 
the developer of the application for help.
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Making room on your smartphone
If you store a large number of records, or install many third-party 
applications, the internal memory on your smartphone may fill up. Here 
are some common ways to clear space on your smartphone:

• Camera: Large size images take up a lot of memory. Move images to 
an expansion card or delete images from your smartphone (see 
“Viewing pictures and videos on your computer” on page 111).

• Messaging: Multimedia content and email attachments can 
consume excessive memory. Move multimedia content and 
attachments to an expansion card, or delete large files from your 
smartphone (see “Managing your messages” on page 86). You may 
also want to empty the deleted items folder.

• Internet: If you save links to pages you’ve visited in Internet Explorer 
Mobile, you may want to clear all recent pages (see “Customizing 
your Internet Explorer Mobile settings” on page 95).

• Third-party applications: You can delete infrequently used 
applications or move them to an expansion card (see “Copying or 
moving applications and files between your smartphone and an 
expansion card” on page 154). 

Also, remember that your smartphone includes an expansion card slot, 
and that you can store applications and information on expansion 
cards. However, you still need free memory on the smartphone itself to 
run applications from an expansion card.
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Voice quality CHAPTER 10

Voice quality

Is the other person hearing an echo?
• Try decreasing the volume on your smartphone to avoid coupling or 

feedback on the other person’s end. This applies to both the 
speakerphone and to the handset earpiece.

• Position the smartphone closer to your ear to prevent sound leaking 
back to the microphone. Keep your hand away from the microphone 
hole, which is on the lower-right side of your smartphone.

• If you’re using Speakerphone mode with your smartphone lying on a 
flat surface, try turning the smartphone “face down” (screen facing 
the surface). 

Are you hearing your own voice echo?
Ask the other person to turn down their volume or to hold the 
smartphone closer to their ear.

Is your voice too quiet on the other end?
Be sure to hold the bottom of the smartphone, or the hands-free 
microphone, close to your mouth. 

Check the signal strength indicator. If the signal is weak, try to find an 
area with better coverage.
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Glossary

ActiveSync®: The technology that exchanges and 
updates the information on your smartphone with 
the information on your computer.

Alt (alternative) : A keyboard key. Enter a letter 

on the keyboard, and then press Alt  to access 

variations such as international characters and symbols.

Auto-off interval: The time of inactivity that passes 
before the screen on your smartphone turns off. The 
wireless features on your smartphone are unaffected 
by this setting.

Beam: The process of sending or receiving an entry or 
application using the infrared port on your smartphone. 

Desktop software: A PIM application for 
computers, such as Microsoft Outlook, that helps you 
manage your personal information and keep your 
personal information synchronized with your 
smartphone.

EVDO (Evolution Data Optimized): A wireless 
broadband technology that is designed for high-speed 
data transfer.

Infrared (IR): A way of transmitting information using 
light waves. The IR port on your smartphone lets you 
transfer information between other IR devices within a 
short radius.

Lithium Ion (Li-Ion): The rechargeable battery 
technology used in Treo 700w smartphones. 

MMS (Multimedia Messaging System): An 
enhanced form of messaging that lets you send 
pictures, animations, and ringtones almost instantly.

My Mobile Devices: The component on your 
Windows computer that enables you to install 
applications and other information on your smartphone.

Option : The keyboard button that lets you access 

the alternative feature that appears above the letter on 
each key.

Phone Off: When your Phone is off, your smartphone 
is not connected to any mobile network.  You can still 
use the organizer and other features.

Phone/Send : The button on your smartphone 

that provides quick access to your Today screen. 
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PIM (personal information manager): A genre of 
software that includes applications such as Microsoft 
Outlook, Palm® Desktop software, Lotus Notes, and 
ACT!. PIMs generally store contacts, schedules, tasks, 
and memos. 

SMS (Short Messaging Service): The service that 
exchanges short text messages almost instantly 
between mobile devices. These messages can usually 
include up to 160 characters. Treo 700w smartphones 
can send and receive text messages while you are on a 
voice call.

Start : The menu on your smartphone from which 

you can open all applications.

Username: The name associated with your 
smartphone that distinguishes it from other Windows 
Mobile devices. When you first synchronize your 
smartphone, you are asked to give it a username. 

Windows Mobile: The operating system of your Treo 
700w smartphone. 
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FCC

FCC Statement This equipment has been tested and found to 
comply with the limits for a Class B computer peripheral, 
pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for 

help. 

RF Safety Exposure To Radio Frequency Energy (SAR) Radio 
transmitting devices radiate Radio Frequency (RF) energy during 
its operation. RF energy can be absorbed into the human body 
and potentially can cause adverse health effects if excessive 
levels are absorbed. The unit of measurement for human 
exposure to RF energy is “Specific Absorption Rate” (SAR). 

The Federal Communications Commission (FCC), Industrie 
Canada (IC), and other agencies around the world have 
established limits that incorporate a substantial safety margin 
designed to assure the safety of all persons using this 
equipment. 

In order to certify this unit for sale in the US, Canada and 
Europe this unit has been tested for RF exposure compliance at a 
qualified test laboratory and found to comply with the 
regulations regarding exposure to RF Energy. 

SAR was measured with the unit transmitting at its maximum 
certified RF power. Often, however, during normal operation the 
unit will transmit much less than maximum power. Transmit 
power is controlled automatically and, in general is reduced as 

you get closer to a cellular base station. This reduction in 
transmit power will result in a lower RF energy exposure and 
resulting SAR value. 

FCC RF Safety Statement In order to comply with FCC RF 
exposure safety guidelines, users MUST use one of the following 
types of bodyworn accessories. 
1. A Palm® brand body-worn accessory that has been tested for 

SAR compliance and is intended for use with this product. 
2. An accessory that contains NO metal (snaps, clips, etc) and 

provides AT LEAST 1.5 cm of separation between the users 
body and the unit. 

Do NOT use the device in a manner such that it is in direct contact 
with the body (i.e. on the lap or in a breast pocket). Such use will 
likely exceed FCC RF safety exposure limits See www.fcc.gov/

oet/rfsafety/ for more information on RF exposure safety. 

Responsible party
(North America) (Europe)
Palm, Inc. Bornibus Francois
950 W. Maude Ave. Buckhurst Court 
Sunnyvale, CA 94085 London Road
USA Wokingham, Berkshire RG40 1PA,
www.palm.com UK

Antenna Care/Unauthorized Modifications Use only the 
supplied integral antenna. Unauthorized antenna modifications 
or attachments could damage the unit and may violate FCC 
regulations. Any changes or modifications not expressly 
approved by the party responsible for compliance could void the 
user’s authority to operate the equipment.

Potentially Unsafe Areas Potentially explosive atmospheres: 
Turn off your smartphone when you are in any areas with a 
potentially explosive atmosphere, such as fueling areas (gas or 
petrol stations) or storage facilities for fuel or chemicals.

FCC

http://www.palm.com
http://www.fcc.gov/oet/rfsafety/
http://www.fcc.gov/oet/rfsafety/
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Declaration of Conformity 

Treo 700w Model  

Palm declares that the above model of Treo 700w smartphone is 
compliant with the regulations below. The declaration applies to 
the smartphone and its associated accessories (power supply, 
headset, and USB cable) where applicable. 

FCC OET Bulletin 65 Supplement C
Safety: EN 60950: 2000 (Jan-2000)
Radiated Emissions: EN 55022
FCC ID: O8FJIMI
IC ID: 3905A-JIMI 

Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT 
OPERATION. Read this information before using your integrated 
multi-service portable radio. 

For the safe and efficient operation of your radio, observe 
these guidelines:

Potentially Unsafe Areas / Potentially explosive 
atmospheres Obey all signs and instructions regarding 
turning off your smartphone. In particular, turn off your 
smartphone when you are in any areas with a potentially 
explosive atmosphere, such as fueling areas (gas or petrol 
stations, below deck on boats), storage facilities for fuel or 
chemicals, blasting areas and areas near electrical blasting caps, 
and areas where there are chemicals or particles (such as metal 
powders, grains, and dust) in the air.

Maximum Scaled SAR Values (W/kg)

Band  Cellular  PCS

Head SAR
(Held to Ear)

(W/Kg) (W/Kg)

Body SAR
(Worn)

(W/Kg) (W/Kg)

Using TTY 
A TTY (also known as TDD or text telephone) is a 

telecommunications device that allows people who are deaf or 
hard of hearing, or who have speech or language disabilities, to 
communicate by telephone.

Your Palm Treo 700w smartphone is compatible with select 
TTY devices. You can connect a TTY/TDD machine to your 
smartphone through the headset jack, but you cannot use your 
headset jack with a headset or hands-free kit while this mode is 
enabled. Please check with the manufacturer of your TTY device 
for connectivity information and to ensure that the TTY device 
supports digital wireless transmission.

To use TTY, you may need to make additional arrangements 
with Verizon Wireless. Please contact Verizon Wireless’s 
customer service department for more information.
1. Press the Start button and select Settings.
2. Select Personal, and then select Phone.
3. Select Phone.
4. Select the TTY/TDD list, and then select either Default mode, 

VCO mode, or HCO mode.
5. Press OK. A keyboard icon appears at the top of your Today 

screen whenever TTY is enabled.
To disable TTY, repeat steps 1 and 2.
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Interference to Medical and Personal Electronic 
Devices Most but not all electronic equipment is shielded from 
RF signals and certain electronic equipment may not be shielded 
against the RF signals from your smartphone.

Pacemakers The Health Industry Manufacturers Association 
recommends that a minimum separation of six inches (6") be 
maintained between a smartphone and a pacemaker to avoid 
potential interference with the pacemaker. These 
recommendations are consistent with the independent research 
by the recommendations of Wireless Technology Research.

Persons with pacemakers should:
• ALWAYS keep the smartphone more than six inches from their 

pacemaker when the smartphone is turned ON. 
• Not carry the smartphone in a breast pocket.
• Use the ear opposite the pacemaker to minimize the potential 

for interference.
• Turn the smartphone OFF immediately if you have any reason 

to suspect that interference is taking place.

Audio Safety Some hearing aids may be affected by some 
digital smartphones. You may want to consult your doctor in the 
event of you experience interference with your hearing aid while 
using your smartphone. When using the speakerphone feature, it 
is recommended that you place your smartphone at a safe 
distance from your ear. 

Other Medical Devices If you use any other personal 
medical device, consult the manufacturer of your device to 
determine if it is adequately shielded from external RF energy. 
Your physician may be able to assist you in obtaining this 
information.

Turn your smartphone OFF in health care facilities when any 
regulations posted in these areas instruct you to do so. Hospitals 
or health care facilities may be using equipment that could be 
sensitive to external RF energy.

Interference to Other Electronic Devices RF energy may 
affect improperly installed or inadequately shielded electronic 
operating and entertainment systems in motor vehicles. Check 
with the manufacturer or representative to determine if these 

systems are adequately shielded from external RF energy. Also 
check with the manufacturer of any equipment that has been 
added to the vehicle.

Repetitive Motion Injuries When using the keyboard or 
playing games on your smartphone, you may experience 
discomfort in your neck, shoulders, hands, arms, of other parts of 
the body. To avoid any injury, such as tendonitis, carpal tunnel 
syndrome, or other musculoskeletal disorder, make sure to take 
necessary breaks from use, take longer rests (such as several 
hours) if discomfort or tiring begins, and see a doctor if 
discomfort persists.

Blackouts and Seizures Blinking lights, such as those 
experienced with television or playing video games, may cause 
some people to experience blackout or seizure, even if never 
experienced before. In the event a smartphone user should 
experience any disorientation, loss of awareness, convulsion, eye 
or muscle twitching or other involuntary movements, stop use 
immediately and consult a doctor. Individuals with personal or 
family history of such events should consult a doctor before 
using the device. To limit the possibility of such symptoms, 
wherever possible every hour take a minimum of 15 minutes, use 
in a well lighted area, view the screen from the farthest distance 
and avoid exposure to blinking lights if you are tired. 

Aircraft While in aircraft, follow all instructions regarding the 
operation of your smartphone. Use of your smartphone while on 
board on aircraft must be done in accordance in compliance with 
airline instructions and regulations.

Vehicles with Air Bags Your smartphone should not be 
placed in a position that would affect the operation of air bag 
deployment or in a position that, should the air bag inflate, could 
propel the smartphone. Air bags will inflate with great force and 
care should be taken to protect within a vehicle that has air bags.

Battery Your smartphone includes an internal lithium ion 
battery. Please note that use of certain data applications can 
result in heavy battery use and may require frequent battery 
charging. Any disposal of the smartphone must comply with laws 
and regulations pertaining to lithium ion batteries. 
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Driving Safety Tips Overview
Always obey all laws and regulations on the use of 

smartphones in your driving area.
Safety — Your most important call. The Wireless Industry 

reminds you to use your smartphone safely when driving.
1. Get to know your smartphone and its features, such as speed 

dial and redial.
2. When available, use a hands-free device.
3. Position your smartphone within easy reach.
4. Let the person you are speaking to know you are driving; if 

necessary, suspend the call in heavy traffic or hazardous 
weather conditions.

5. Do not take notes or look up phone numbers while driving.
6. Dial sensibly and assess the traffic; if possible, place calls 

when you are not moving or before pulling into traffic.
7. Do not engage in stressful or emotional conversations that 

may divert your attention from the road.
8. Dial 9-1-1 to report serious emergencies -it’s free from your 

smartphone!
9. Use your smartphone to help others in emergencies.
10.Call roadside assistance or a special non-emergency wireless 

number when necessary.

Driving Safety Tips Details
1. Get to know your smartphone and its features such as speed 

dial and redial. Carefully read your instruction manual and 
learn to take advantage of valuable features most 
smartphones offer including, automatic redial and memory 
dial-most smartphones can store up to 99 numbers in memory 
dial. Also, work to memorize the smartphone keypad so you 
can use the speed dial function without taking your attention 
off the road.

2. When available, use a hands-free device. A number of hands-
free smartphone accessories are readily available today. 
Whether you choose an installed mounted device for your 
smartphone or a speaker phone accessory, take advantage of 
these devices if available to you.

3. Position your smartphone within easy reach. Make sure you 
place your smartphone within easy reach and where you can 
grab it without removing your eyes from the road. If you get 

an incoming call at an inconvenient time, let your voice mail 
answer it for you.

4. Suspend conversations during hazardous driving conditions 
or situations. Let the person you are speaking to know you are 
driving; if necessary, suspend the call in heavy traffic or 
hazardous weather conditions. Rain, sleet, snow and ice can 
be hazardous, but so is heavy traffic. As a driver, your first 
responsibility is to pay attention to the road.

5. Do not take notes or look up phone numbers while driving. If 
you are reading an address book or business card while 
driving a car, or writing a “to do” list, then you are not 
watching where you are going. It’s common sense. Don’t get 
caught in a dangerous situation because you are reading or 
writing and not paying attention to the road or nearby 
vehicles.

6. Dial sensibly and assess the traffic; if possible, place calls 
when you are not moving or before pulling into traffic. Try to 
plan your calls before you begin your trip, or attempt to 
coincide your calls with times you may be stopped at a stop 
sign, red light or otherwise stationary. But if you need to dial 
while driving, follow this simple tip-dial only a few numbers, 
check the road and your mirrors, then continue.

7. Do not engage in stressful or emotional conversations that 
may be distracting. Stressful or emotional conversations and 
driving do not mix-they are distracting and even dangerous 
when you are behind the wheel. Make people you are talking 
with aware you are driving and if necessary, suspend phone 
conversations which have the potential to divert your attention 
from the road.

8. Use your smartphone to call for help. Your smartphone is one 
of the greatest tools you can own to protect yourself and your 
family in dangerous situations-with your smartphone at your 
side, help is only three numbers away. Dial 9-1-1 in the case of 
fire, traffic accident, road hazard, or medical emergencies. 
Remember, 9-1-1is a free call on your smartphone!

9. Use your smartphone to help others in emergencies. Your 
smartphone provides you a perfect opportunity to be a “good 
Samaritan” in your community. If you see an auto accident, 
crime in progress, or other serious emergency where lives are 
in danger, call 9-1-1, as you would want others to do for you.
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10.Call roadside assistance or a special wireless non-emergency 
assistance number when necessary. Certain situations you 
encounter while driving may require attention, but are not 
urgent enough to merit a call to 9-1-1. But you can still use 
your smartphone to lend a hand. If you see a broken-down 
vehicle posing no serious hazard, a broken traffic signal, a 
minor traffic accident where no one appears injured, or a 
vehicle you know to be stolen, call roadside assistance or 
other special non-emergency wireless number.

NOTICE FOR CONSUMERS WITH HEARING DISABILITIES

Digital Wireless Phones to be Compatible with Hearing Aids

On July 10, 2003, the Federal Communications Commission 
(FCC) modified the exemption for wireless phones under the 
Hearing Aid Compatibility Act of 1988. This means that wireless 
phone manufacturers and service providers must make digital 
wireless phones accessible to individuals who use hearing aids.

For more information, please go to the FCC’s Consumer Alert 
on accessibility of digital wireless phones at http://www.fcc.gov/

cgb/consumerfacts/accessiblewireless.html.
Wireless telephones are hand-held phones with built-in 

antennas, often called cell, mobile, or PCS phones. These phones 
are popular with callers because they can be carried easily from 
place to place.

Wireless telephones are two-way radios. When you talk into a 
wireless telephone, it picks up your voice and converts the sound 
to radio frequency energy (or radio waves). The radio waves 
travel through the air until they reach a receiver at a nearby base 
station. The base station then sends your call through the 
telephone network until it reaches the person you are calling.

When you receive a call on your wireless telephone, the 
message travels through the telephone network until it reaches a 
base station close to your wireless phone. Then the base station 
sends out radio waves that are detected by a receiver in your 
telephone, where the signals are changed back into the sound of 
a voice.

The Federal Communications Commission (FCC) and the Food 
and Drug Administration (FDA) each regulate wireless 
telephones. FCC ensures that all wireless phones sold in the 
United States follow safety guidelines that limit radio frequency 
(RF) energy. FDA monitors the health effects of wireless 
telephones. Each agency has the authority to take action if a 
wireless phone produces hazardous levels of RF energy.

FDA derives its authority to regulate wireless telephones from 
the Radiation Control provisions of the Federal Food, Drug, and 
Cosmetic Act (originally enacted as the Radiation Control for 
Health and Safety Act of 1968). [http://www.fda.gov/cdrh/comp/

eprc.html].
FCC derives its authority to regulate wireless telephones from 

the National Environmental Policy Act of 1969 (NEPA) and the 
Telecommunications Act of 1996 [http://www.fcc.gov/

telecom.html]. Updated 7/16/2003

Hands-Free Capability

All CTIA Certified portable products provide the consumer with 
a toll-free number for the purchase of a compatible hands-free 
device. 1-800-881-7256

 

http://www.fda.gov/cdrh/comp/eprc.html
http://www.fda.gov/cdrh/comp/eprc.html
http://www.fda.gov/cdrh/comp/eprc.html
http://www.fda.gov/cdrh/comp/eprc.html
http://www.fda.gov/cdrh/comp/eprc.html
http://www.fda.gov/cdrh/comp/eprc.html
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Specifications

Radio • CDMA 800 (Digital Cellular), 1900 (PCS), and 1400(GPS)
• EVDO and 1XRTT

Phone features • Personal speakerphone
• Hands-free headset jack 
(2.5 mm, 3-barrel connector)

• Microphone mute option
• TTY compatible 
• 3-way calling

Processor 
technology

• Intel XScale™ processor, 312MHz

Expansion • SD/MultiMediaCard/SDIO card slot

Battery • Rechargeable Lithium Ion
• Removable for replacement

• Up to 4.75 hours talk time
• Up to 230 hours standby 
• 4 hours full charge time

Operating 
system

• Windows Mobile Edition 5.0.2 (Phone Edition)

Camera (not 
included on all 
smartphones)

• Still image capture resolution:1280 x 1024, 1.3 megapixel
• Automatic light balance

Size • 5.08 in x 2.28 in x 0.89 in (129mm x 58mm x 22.5mm) with antenna

Weight • 6.4 ounces (180 grams)
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Connectivity • Infrared (1.2 compliant)
• Bluetooth® wireless technology (1.2 compliant)

Display • Touch-sensitive LCD screen (includes stylus)
• 65,536 colors (16-bit color)
• User-adjustable brightness

Keyboard • Built-in QWERTY keyboard plus 5-way navigator
• Backlight for low lighting conditions

Included 
software

• Today/Phone (includes Speed Dial 
and Dial Pad)

• Messaging (text, multimedia, and 
email)

• Internet Explorer Mobile (web browser)
• Camera
• Pictures & Videos
• Windows Media Player 10
• File Explorer
• Contacts
• Calendar
• Tasks
• Notes

• Calculator
• ActiveSync®

• Excel Mobile
• Word Mobile
• PowerPoint Mobile
• Pocket MSN
• Solitaire
• Bubble Breaker
• Voice Command
• Download Agent
• Quick Tour
• Search
• Terminal Services

System 
requirements

• Windows 2000 or XP with USB port
• Later versions may also be supported

Operating and 
storage 
temperature 
range

• 32°F to 104°F (0°C to 40°C)
• 5% to 90% RH 
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Index

SYMBOLS
! icon 10

NUMERICS
1xRTT data networks 198
1xRTT network icons 198
3G2 files 111, 112
3GP files 111, 112
3GPP2 files 73
5-way navigator 6, 17, 19, 

211
802.1x page (Network 

Authentication) 185
911 calls 162, 171

A
A2DP devices 97
AC charger 8
accented characters 24
Access page 178
accessing

alternate characters 24
applications 26, 168
battery status window 34
calculator 70
corporate email accounts 

187, 207
Dial Pad 40
field lists 22
File Explorer 142, 155
information 27, 177

instant messages 90
menu items 21, 22
on-device help 31
Outlook folders 202
Phone Settings screen 13
Quick Tour 31
secure websites 177, 208
shortcut menus 22
speed dial buttons 38
spreadsheet templates 

130
Tasks entry bar 66
the Internet 186, 198
Today screen 33, 217
voicemail 42
web pages 91, 93, 208

accessories 150, 196
account types 74
accounts

accessing corporate 187, 
207

getting help with 32
preventing unauthorized 

use of 172, 177
setting up email 74–79
synchronizing 83
troubleshooting 204

Accounts page 84, 89
action keys 6, 20
activating items on screen 

19, 20

activating the phone 12
active calls

See also phone calls
adding a second 46
adjusting volume for 160
ending 12, 44, 46
managing 43, 46

ActiveSync icons 28
ActiveSync software 14, 146, 

201, 207
options 146

ActiveSync technology 217
Add Contact prompt 44
Add Server Source 

command 75
Add Server Source prompt 

146
Add to Favorites command 

93
adding

a second call 46
accessories 150
applications to Start 

menu 168
appointments 58, 59
attachments to email 80, 

142
bulleted or numbered 

lists 123
caller ID pictures 55
connections 186, 187
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Index

contacts 44, 55
document templates 121, 

125
email messages 80
expansion cards 150
favorites links 93
files to playlists 115
folders 124
My Text phrases 72
notes 55, 64, 67
signatures 87
speed dial buttons 49
spreadsheets 128
tasks 64
untimed events 58, 59

address book 81, 88
Address page 81, 88
addresses

adding email 55, 80, 81
entering message 71, 72, 

73
messaging options for 88
multiple recipients 71
selecting email 19

adjusting screen brightness 
166

Advanced page (Power 
Settings) 180

advancing slides 126, 127
After calls from numbers… 

setting 161
Agenda View (calendar) 57
alarm clock 176
alarm sounds 176
alarms

events and 59
setting system 176
setting vibrating 165
tasks and 64
turning on and off 164

Alarms page 176
albums 105
alert tones. See ringtones
aligning the screen 167
alignment settings

documents 123
spreadsheets 128

Allow cookies setting 96
Allow USB connections 

check box 201
Alt key 23, 217
alternate characters 24
alternate characters list 24, 

25
alternate phone numbers 38
animated images 111
animation 126, 127
anniversaries 59
Answer button 41
answering the phone 41, 46
antenna 5, 219
Appearance page 157, 158, 

167
applications

See also third-party 
applications

accessing help for 31
accessing shortcut 

menus 22
associating with buttons 

168
battery life and 29
closing 15, 26, 179
copying 154
customizing 168–170
deleting 145, 214
displaying 179
downloading 143
error reporting for 177
included with 

smartphone 226
installing 143–144, 211
losing information in 192
moving to expansion 

cards 154
opening 26, 152, 218
phone conversations and 

running 43, 44
reinstalling 192
running from expansion 

cards 152, 214
storing 214
transferring information 

from 28
troubleshooting 195
turning sounds on or off 

for 164
viewing main menus 21
viewing memory usage 

for 179
appointments 60

See also events
adding 58
appearing in wrong time 

slots 203



数码说明书之家—WWW.54GG.COM
Using Your Treo 700w Smartphone 229

Index

deleting 61
entering multiple 57
hiding 60
marking as private 60
reminders for 59, 62
scheduling repeating 59
viewing 57

Appointments page 62
Area code setting 56
arrow icons (navigator) 18
Assign a program list 169
attachments

See also email
adding 80, 142
downloading 84
embedded objects in 85
freeing internal memory 

and 214
opening 84
receiving 84
storing 85, 88
troubleshooting 206

audio 41, 110, 112
See also media files; 

music
audio accessories 53
authentication 185
Authentication dialog box 77
Authentication list 184
auto shut off timer 149
Auto Sync, troubleshooting 

205
auto-completion options 169
AutoCorrect command 108
Autofill setting 132
AutoFilter command 135

AutoFilter settings 
(spreadsheets) 129

auto-keyguard feature 171
Auto-Keyguard settings 172
Auto-lock settings 172
auto-off interval 217

B
back view (Treo™ 700 

smartphone) 7
backgrounds 103, 108, 117, 

157
backing up information 192
backlight (keyboard) 23, 180
Backspace key 20, 23
backup utilities 189, 192
backups, restoring 192
Band selection settings 162
battery

Bluetooth connections 
and 99

charging 9–10
conserving power for 29, 

100, 180
consumption factors 10
disposing of 193, 221
installing 8
maximizing life of 29
replacing 193
specifications for 225
viewing remaining 

power for 10, 180
viewing status of 35

battery contacts 8
battery door release 7
battery icon 10

Battery Power page 180
battery status icons 35
battery status window 34
Beam… command 99, 102
beaming 99, 101–102, 142, 

217
birthdays 59
Bluetooth devices

compatibility with 97
connecting to 97–99, 100
discovery setting for 99
phone calls and 52
sending and receiving 

information over 99
synchronizing with 100
troubleshooting 200

Bluetooth feature 97, 98, 100
Bluetooth icon 36, 98
Bluetooth Settings screen 98
Bluetooth status indicator 36
BMP files 73, 111
Bold setting 123
border glow highlight 19
borders 128
Brightness command 104
brightness icons (camera) 

104, 105
brightness, adjusting 104, 

105, 166
broadband technology 217
browsing files and folders 

141, 155
browsing the web. See web 

browsing
built-in applications 31, 145, 

226
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built-in camera. See camera
bulleted lists 123
bullets 119
buttons

activating menus and 21
assigning voice 

commands to 169
associating with 

applications 168
calculator 70
creating speed dial 49
disabling 171
editing speed dial 51
on 5-way navigator 17
opening applications and 

26
reassigning 168–169
selecting or activating 19
turning sounds on or off 

for 164
Buttons page 117
Buttons Settings page 168

C
calculations 70, 128, 131
Calculator application 70
calculator buttons 70
Calculator icon 70
calendar

adding meeting requests 
60

adding special events 58
displaying 57
removing events 61
setting alarms for 59
setting options for 62

unavailable time slots on 
60

Calendar application
adding contacts and 55
customizing 62–63
managing schedules 

with 58–61
selecting views 57
starting 57
synchronizing with 28
untimed events in 58

calendar views 57
call forwarding 47
Call Log 40, 48
Call Log command 40
Call Timers command 48
call waiting 46
call waiting notification 

window 46
callback number 72
caller ID applications 211
caller ID blocking 44
caller ID pictures 55, 103, 160
calling plans 48
calls. See phone calls
camera

See also pictures
battery life and 29
capturing videos with 

104–105
freeing internal memory 

and 214
specifications for 225
taking pictures 103–104
troubleshooting 209–210

Camera icon 104
camera lens 7
Camera page 110
Camera Preview Mode 210
camera settings 109–110
Cancel Bluetooth command 

52
Cancel Mute command 43
capitalization 23, 170
Caps Lock 24
captions 74
capture resolution 225
carrying cases 196
case-sensitive searching 

121, 137
cell patterns 128
cell phones. See wireless 

phones
Center button (navigator) 17
certificates 95, 176, 177
Certificates page 177
Change passcode button 172
changing

alarm sounds 176
connections 186
contacts 56
date and time settings 

175
information 14, 137
lock codes 172
picture or video 

resolution 104, 105, 209
speed dial buttons 51
text 121
text size 166
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character sets 95
characters

capitalizing 23, 170
entering 23, 169
phone calls and 42, 50
text messages and 71, 72
typing alternate 24

charging
smartphone 8, 29
the battery 9–10

charging status 10
Chart command 135, 136
charts 129, 135, 136
chat rooms 31
check boxes 19
Clear Cookies setting 96
Clear History setting 96
Clear Now Playing 

command 115
Clear Type setting 166
Clock & Alarms Settings 

page 175, 176
closed networks 182, 183
closing

applications 15, 26, 179
battery status window 34
lists in fields 22
menus 21
screens 19

color settings 210
color themes 158, 167
colors 167
command buttons 169
commands 169

See also menus; specific 
command

company lists 39
company names 39, 56
comparisons 135
completed tasks 64, 65
compliancy statement 220
components (Treo 

smartphone) 2
compressed files 143
computers

connecting to 15
installing from 144
synchronizing with 14, 

28, 147
system requirements 14

Conference button 47
conference calls 46, 47
Confidential setting 61
Configure Server command 

146
Configure Wireless Network 

page 183
configuring

data services 199
Exchange Server 146
TTY devices 161
wireless networks 183

Connect command 187
Connect via Bluetooth 

command 100
Connect via IR command 102
connecting

smartphone to PCs 15
to a headset 98
to Bluetooth devices 97–

99, 100
to data service providers 

186
to hands-free car kit 98
to mobile networks 197
to the Internet 186, 198
to VPNs 186–187
to Wi-Fi networks 182, 

183, 185
connection icons 198
connections

adding 186, 187
band selection settings 

for 162
changing 186
customizing 182–188
ending 188
manually starting 187
removing Bluetooth 98
synchronizing 

information and 28
synchronizing over 

infrared 102
troubleshooting 197–200
unavailable 198
unsupported 97

Connections Settings page 
186, 187, 188

connectivity 226
conserving battery power 

29, 100, 180
consumption (battery) 10
contacts

adding 44, 55
addressing to 72, 73, 80
alternate phone numbers 

for 38
assigning ringtones to 
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49, 55, 106, 160
changing 56
displaying 56
entering multiple 55
linking speed dial 

buttons to 49
looking up 37
personalizing 160
removing 56
saving information for 44
selecting communication 

method for 38
sending meeting 

requests to 60
synchronizing 28
viewing details list for 37

Contacts application
customizing 56
managing contact 

information with 55–56
starting 55
synchronizing with 28

Contacts list 37, 56
context-sensitive menus 21
continuous playback (slides) 

127
cookies 96
Copy command 70, 95, 107, 

122, 154
copying

applications 154
items in folders 142
numbers 70
phone numbers 39, 40
pictures and videos 107

text 95, 122
copyrighted items 106
corporate email accounts 75
corporate mail systems 186, 

207
corporate servers 186, 207
coverage area 11, 197
creating

appointments 58, 59
bulleted or numbered 

lists 123
caller ID pictures 55
connections 186, 187
contacts 44, 55
documents 119, 120, 121
email messages 80
favorites links 93
folders 124
multimedia messages 72
My Text phrases 72
notes 67, 68
playlists 115
signatures 87
speed dial buttons 49
spreadsheets 128
tasks 64
templates 83, 121, 125, 

130
text messages 71
untimed events 58, 59
video ringtones 106
workbooks 130

cropping pictures 108
Currency page 167
currency symbols 167

current call. See active calls
customer support 31
Customize the playlists… 

check box 113
customizing

applications 168–170
Calendar 62–63
camera 109–110
connections 182–188
Contacts application 56
dates and time 175
display settings 166–167
Excel Mobile 139
format settings 166
Internet Explorer 95
Media Player Mobile 116
Messaging application 87
multimedia messages 89
Notes application 69
phone 159–162
system settings 175–181
system sounds 163
Tasks application 66
text messages 89
Today screen 27, 157–158
voicemail system 50
Word Mobile 125

Cut command 107, 122
cutting. See deleting

D
daily schedules 57
data 130, 132, 192

See also information
Data Encryption settings 184
data formats 166
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data service providers 186, 
198

data services 3, 36, 198
data transfer 198, 217
date formats 167
Date page 167
dates 132, 167, 175

See also calendar
Day View (calendar) 57
day-planner formats 57
decimal places 166
decimal symbols 166, 167
decompression utility 143
default format settings 166
default lock code 172
default template 125
default zoom level 170
defined names 

(spreadsheets) 133
Delete Appointment 

command 61
Delete Cells command 138
Delete command 86, 125, 

138
Delete Contact command 56
Delete Files setting 96
Delete from Library 

command 114
Delete Task command 66
Deleted Items folder 86, 88
deleting

applications 145, 214
Bluetooth connections 98
certificates 176
contacts 56
directory services 81

documents 125
events 61
favorites links 93
files 142
items from playlists 115
items in folders 142
messages 86, 88
notes 69
pictures 108
sounds 160
speed dial buttons 51
tasks 66
text 20
workbooks 138
worksheets 138

desktop software 190, 217
See also applications

Device Setup Wizard 113
devices

See also Bluetooth 
devices; smartphone

beaming to 101
caution for storing 7
compliancy for 220
configuring TTY/TTD 161
connections and 

unsupported 97
identifying 99, 184
setting up GPS 178
troubleshooting 200

diagnostic information 177
Dial dialog box 39
Dial Lookup list 12
Dial Pad 39, 40
Dial Pad command 40
dial pad tones 161

dialing 12, 37–40, 46, 50
Dialpad setting 161
digit grouping 166, 167
directory service 81, 88
Disable touchscreen check 

box 172
Disconnect Bluetooth 

command 100
Disconnect command 188
discoverable setting 99
Dismiss button 42
display

See also screen
customizing 166–167
scroll settings for 170
specifications for 226

display formats 166
Display message on screen 

check box 165
displaying

alternate characters 24
animated images 111
appointments 57
available applications 26
calendar 57
contacts 37, 56
daily schedules 57
documents 119
error messages 213
events 58, 61
Flight Mode settings 181
items in folders 124, 138
memory usage 179
menus 21, 22
multimedia messages 82
notifications 165
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pictures 105, 111
power settings 180
space on expansion 

cards 154, 179
spreadsheets 128, 129
tasks 65, 66
videos 105, 111
web pages 91, 95
wireless settings 181

document file types 119, 125
documentation 2
documents

See also Word Mobile 
application

creating 119, 120, 121
deleting 125
displaying 119
finding and replacing 

operations in 121
moving or copying 

operations in 122
opening 121
organizing 124
saving 120, 122, 125
setting margins for 123
spell-checking 124

documents list 125
down arrow in fields 22
Down button (navigator) 17
downloading

applications 143
attachments 84
email 207
files 94
images 94, 111

multimedia messages 81
ringtones 159

drafts 80
drawing 67
drivers 190
driving safety tips 222
dummy expansion card 150, 

151

E
EAP type setting 185
earpiece 6
eBooks 29
echoes 215
Edit command 108
Edit Speed Dial command 51
editing. See changing
email

adding attachments 80, 
142

addressing 55, 80, 81
creating messages for 80
dialing from 39
entering contact 

information and 55, 60
getting from corporate 

servers 186, 207
messaging options for 87
priority settings for 80
receiving attachments 

with 84
requirements for 1
selecting addresses 19
sending 80
troubleshooting 204–207

email accounts

setting up 74–79
synchronizing 83
troubleshooting 204

E-mail application 28
email client software 206
email message icons 86
embedded images 85
emergency calls 162, 171
Empty Deleted Items 

command 86
Enable local network time 

check box 175
Encoding setting 95
encryption 95, 184
encryption keys 77
End Conference button 47
End Show command 126
ending active calls 12, 44, 46
ending data connections 188
ending playback 114
endnotes 120
entering

alternate characters 24
data in spreadsheets 130, 

132
information 14, 23, 170
lock codes 172
numbers on calculator 70
owner information 174
passwords 78, 173
phone numbers 40

Erase all data? prompt 192
erasing. See deleting
error messages 164, 213
error reporting 177–178
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Error Reporting page 178
errors 177, 197, 213
EVDO (defined) 217
EVDO icons 198
EVDO networks 198
event icons 63
Event settings 165
events

categorizing 61
creating 58, 59, 60
deleting 61
hiding 60
marking as sensitive 60
reminders for 59, 62

Events check box 164
Excel applications 128
Excel Mobile application

customizing 139
display settings for 130
formatting 

considerations for 128
overview 128
searching in 137
starting 130

Excel Mobile icon 130
Exchange Address Book 202
Exchange Server accounts 

14, 75, 146, 207
exiting applications 26, 179
expanding lists in fields 22
expansion card slot 5, 150, 

225
expansion cards

adding applications 144
displaying available 

space on 154, 179

freeing memory and 214
inserting 151
moving items to 124, 137, 

153, 154
opening items on 152
removing 151
renaming 155
saving items on 153
searching on 141, 142
storing attachments on 

85, 88
transferring to 112, 115
types supported 150

extensible authentication 
protocol 185

extensions (phone) 50
external power sources 180
Extra Digits button 42, 50
Extra Digits text box 50

F
factory-installed 

applications 31, 145, 226
Favorites button 93
Favorites buttons. See Quick 

Keys
Favorites command 93
favorites links 93, 94
FCC Statement 219
features 1, 31
fields

accessing lists for 22
scrolling through 18

File Explorer 141, 142, 155
File Explorer icon 142
file lists 142

file names 120, 122, 124
file types 72, 112, 119, 125
files 141, 186, 214

caution for deleting 142
filtering information 56, 135
filtering tasks 65
Find/Replace command 121, 

137
finding

information 27, 137, 141
text 121

firewalls 187
first letter capitalization 23, 

170
First Synchronization dialog 

box 77
Flight Mode 29, 181
folder names 124
folders

accessing Outlook 202
adding documents to 122
arranging pictures and 

videos in 107
browsing 141, 155
creating 124
displaying contents 124, 

138
moving items to 124, 137
opening items in 142
organizing web favorites 

in 93, 94
sorting contents 124, 138, 

142
Font color setting 123
Font command 122
Font setting 123
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fonts 120, 123, 128
footers 120
footnotes 120
forgetting passwords 173
formatting

charts 136
paragraphs and lists 123
spreadsheet cells 133–

134
system information 166
text 122

Formatting toolbar 123
formulas 128, 131, 139
forwarding

email 206
messages 85
phone calls 47

forwarding codes (phone) 47
freeing memory 145, 214
front view (Treo 

smartphone) 6
full charge (battery) 9
functions (spreadsheets) 

128, 132

G
games 29
GIF files 73, 111
Global Positioning System 

(GPS) 178
Glossary 217
Go to Slide command 126
Google Lookup field 27, 91
GPS devices 178
GPS Settings page 178

H
Hands Free check box 98
hands-free car kit 52, 98
hands-free devices 52, 97, 

223
hanging indents 123
hanging up phone 44, 46
hard resets 173, 192
hardware 2
Hardware buttons box 164
Hardware page 178
headers 120
headset 52–53, 98
headset button 52
headset jack 6
hearing disabilities 161, 220, 

223
heat sources 30
help 31, 189, 212
Help command 31
Help screen 31
hiding

appointments 60
events 60
speed dial buttons 39
Tasks entry bar 66

Highlight setting 123
highlighting

alternate characters 24
items in lists 22
items on screen 18, 19
menu items 21, 22
multiple items 142
text 20, 123

high-speed data transfer 217

hints (passwords) 173
History command 95
History list 95, 96
Hold button 43
home locations 175
Home Page setting 95
Hotmail accounts 75, 90
hypertext links. See links

I
icons

charging status 10
data services 198
email 86
events 63
phone status 34
signal-strength 11, 181
synchronization 28

Ignore with text message 
command 41

IM messaging 71, 90
image files 73, 111
images 85, 94, 208, 210, 214

See also pictures
IMAP accounts 75, 78, 84
inactivity 171, 180
Inbox 86
Indentation setting 123
indented lists 120
indenting text 123
indicator light 6, 9, 11
information

accessing 27, 177
backing up 192
changing 14, 137
entering 14, 23, 170
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filtering 56, 135
losing 192
moving 153, 154
protecting 171, 173
restoring 192
saving 153
searching for 27, 121, 

137, 141
sorting 135
storing 150, 214
synchronizing 14, 28, 

148, 201
transferring 189, 217
updating 14, 217

infrared port. See IR port
infrared transmissions 102, 

217
Input Settings page 169
installation, troubleshooting 

190, 192, 211
installing

applications 143–144, 211
desktop software 190
synchronization software 

14, 15
VPN clients 187
Windows drivers 190

instant messages 71, 90, 211
interference 100
internal memory 145, 214
Internet 186, 198
Internet Connection Speed 

setting 116
Internet Explorer Mobile 91–

96, 186, 208
interruptions 213

IR port 5, 101, 217
ISP settings 186
ISPs (Internet Service 

Providers) 75
Italics setting 123
items

accidentally activating 
171

highlighting 18, 19
moving through 18
opening shortcut menus 

for 22
selecting for Today 

screen 158
selecting or activating 19, 

20, 22
Items page 158

J
JPEG files 73, 111

K
Key index setting 184
keyboard

accessing alternate 
characters on 24

dialing from 37
displaying alternate 

characters list for 24
entering text from 23–24
locking 171
opening applications 

from 26
pressing keys on 23
scrolling with 18
selecting menu items 

from 21
setting key combinations 

for 168
specifications for 226
third-party applications 

and 211
keyboard backlight 23, 180
Keyguard 171
Keyguard Settings page 172
Known Caller setting 159

L
LANs 187
large files 214
LCD projector 127
leading zeros 167
Left button (navigator) 17
Legacy Pocket Word files 120
libraries (media) 114
Library command 113, 114
Library list 113
Library screen 113, 117
lightening bolt 10
Li-Ion battery 217

See also battery
links

freeing internal memory 
and 214

media files and 114
selecting or activating 19
text messages and 85
troubleshooting 208

list separators 166
List setting 123
Listen button 42
listening to
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media files 53, 112
voicemail messages 42

lists
accessing 22
closing 22
creating 120, 123
formatting 123
highlighting items 18, 22
scrolling through 18
selecting items 19, 22

local area networks 187
locating information 27, 137, 

141
Location Privacy icon 36, 162
Location Privacy setting 162
location-specific information 

162, 166, 175, 178
lock codes 171, 172
Lock icon 91, 106
locking

spreadsheet rows and 
columns 131

the keyboard 171
Treo smartphone 171, 

172
logging in to

corporate servers 186
secure websites 177

Long tones setting 161
lookup feature 37, 141
losing

information 192
passwords 173
Treo smartphone 28, 174

low coverage areas 197

low lighting conditions 23
lowercase letters 23

M
magnet 7
magnification. See zoom 

settings
mail servers 186, 207
main menus 21
Make this device 

discoverable setting 99
Manage existing 

connections setting 187
Manage GPS automatically 

check box 178
maps 178, 208
margins 123
Match case box 121, 137
Match whole words only 

check box 121, 137
maximizing battery life 29
measurement units 167
media files

creating playlists for 115
formats for 112
linking to 114
playing 113
transferring 112, 115
updating 114

media libraries 114
Media Player Mobile

customizing 116
overview 112
starting 113, 116

media players 29
meeting requests 60, 63, 85

memory buttons 70
Memory page 96
Memory Settings page 179
memory usage 179
memory, freeing 145, 214
memos. See messages; 

notes
Menu button 21
menu items, selecting 21, 22
menus 21, 22
Menus page 168
Message page 87
messages

See also multimedia 
messages; text 
messages; voice notes

adding signatures 87
addressing 71, 72, 73
creating email 80
deleting 86, 88
dialing from 39
displaying status of 86
forwarding 85
invalid characters and 72
listening to 42
phone calls and 43
rearranging 86
receiving notifications for 

81, 82, 199
saving as drafts 80
selecting multiple 86

messaging
requirements for 1
troubleshooting 199

Messaging application
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accessing 71, 80
adding contacts and 55
customizing 87
freeing internal memory 

and 214
overview 71

messaging applications 211
Messaging icon 71
Messaging list 87
messaging services 1, 199, 

217, 218
microphone 6, 43, 110
microphone icon 169
Microsoft Excel 128
Microsoft Exchange Server. 

See Exchange Server
Microsoft Outlook. See 

Outlook
microwaves 100
MIDI files 72
Missed call setting 159
MMS messaging 71, 217
mobile accounts 32, 172
mobile devices

battery life and 30
getting help with 31

mobile networks 197
mobile phone numbers 55

See also wireless phones
Mobile to Market certificates 

143
Modify Sheets command 

134
Month View (calendar) 57
most recently dialed 

numbers list 40

moving
documents to folders 124
information 153, 154
pictures and videos 107
speed dial buttons 51
text 122
workbooks 137

moving around the screen 
17–18

MP3 files 112
MSN Hotmail 75, 90
MSN Messenger Contacts 

list 90
multi-connector 6
multimedia messages

See also messages
adding items to 74
addressing 73
creating 72
customizing 89
displaying 82
downloading 81
file types for 72
freeing internal memory 

and 214
maximum size 73
phone numbers in 39
playing 82–83
previewing 74
receiving 81
requirements for 3
saving 83
sending 72, 74
troubleshooting 199

Multimedia Messaging 
System. See MMS 

messaging
MultiMediaCard expansion 

cards 150, 151
Multiple Networks Detected 

dialog box 182
multiple recipients 71
music 41, 112, 113, 160

See also media files
Mute command 43
My Device folder 142
My Device library 114
My Documents folder 141
My Mobile Devices folder 

217
My Pictures folder 103, 104
My Playlists category 115
My Storage Card library 114
My Text command 72, 80
My Text phrases 71, 72, 80

N
names 218
naming

document files 120, 122, 
124

folders 124
groups of pictures 110
speed dial buttons 49
templates 130
workbooks 130, 137
worksheets 133

navigating the screen 17–18
navigator. See 5-way 

navigator
negative numbers 166, 167
Network Cards icon 183, 185
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network connections 182, 
197–200

Network Key page 184
Network key setting 184
Network page 116, 162
New Appointment 

command 58
New Network Detected 

dialog box 183
New Sound command 160
New Speed Dial command 

49
notes

adding tasks and 64
creating 67, 68
entering contacts and 55
removing 69
saving 69

Notes application 67, 69
Notes icon 67
Notes list 68
Notes page 55
notification screens 42, 46, 

82
notifications

Bluetooth devices and 99
displaying on screen 165
downloading sounds 159
messages and 81, 82, 199
previewing ringtones 160
receiving 89
selecting 164
setting ringtones for 159
silencing sounds for 163
voicemail and 42

Notifications check box 164
Notifications page 159, 165
Now Playing playlist 115
Now Playing screen 115
number pad 12
Number page 166
number sign symbol 167
numbered keys 37
numbered lists 123
numbers

See also phone numbers
entering 24, 70
formatting 128, 132, 166

O
Off Hold button 43
offline synchronization 202
Off-peak times setting 149
OK button 6
on-device help. See help
online address book 81, 88
online forums 31
online support 31
open networks 182, 183
opening

applications 26, 152, 218
attachments 84
battery status window 34
calculator 70
characters list 24
Dial Pad 40
documents 121
File Explorer 142, 155
Help screen 31
items in folders 142
Outlook folders 202

Phone Settings screen 13
Quick Tour 31
shortcut menus 22
templates 130
Today screen 33
web pages 91, 93, 208

operating system (Treo 
smartphone) 225

operating systems (PCs) 14
operating temperatures 226
operational warnings 220
Option button 18, 217
Option key 23, 24
Option Lock 24
options 21, 22, 60
Options page 170
organizer features 11, 29
orientation (slides) 127
Orientation page 127
Outbox 74, 86
Outlook

accessing folders for 202
client software and 206
downloading from 84
entering appointments in 

57
entering contacts in 55
installing drivers for 190
synchronizing with 77, 81

overdue tasks 65
owner information 174
Owner Information page 174

P
page breaks 120
Palm Powered devices 15, 
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189
Palm Treo smartphone. See 

Treo 700 smartphone
Paragraph command 123
paragraph formatting 123
partial battery icon 10
passkeys 98
Password Settings page 173
passwords 75, 78, 171, 173
Paste command 70, 95, 107
patches 145
patterns in workbooks 128
PCS phones. See wireless 

phones
PCs. See computers
Peak times setting 148
performance 195
personal information 28, 

173, 174, 217
personal information 

manager 203
Personal setting 61
Personal Settings page 157, 

159, 168, 174
phone

See also phone calls; 
smartphone

activating 12
adjusting volume 13, 160
advanced features 46–48
answering 41, 46
customizing 159–162
disabling touch-sensitive 

feature for 171
downloading ringtones 

for 159

getting forwarding codes 
for 47

hanging up 44, 46
overview 33, 37
previewing ringtones 160
requirements for 1
running applications and 

43, 44
silencing ringer 41, 163
specifications for 225
turning off 12
turning on and off 11
viewing minutes usage 

for 48
waking up screen for 43

phone calls
See also phone numbers
ending 44, 46
entering extra digits for 

42, 50
forwarding 47
hands-free devices and 

97
making 37, 43, 46
placing on hold 43
receiving 41, 43
sending to voicemail 41
setting ringtones for 159
setting up conference 

sessions for 47
troubleshooting 200

phone contacts 8
phone headset 52–53
phone lock feature 171, 172
phone numbers

adding to messages 72

assigning to speed dial 
buttons 49

checking 13
copying 39, 40
dialing 12, 37–40, 46, 50
entering manually 40
redialing most recent 40
saving 44–45
selecting 19

Phone Off
 217

Phone Settings page 161, 
162

Phone Settings screen 13
phone status icons 34
Phone/Send button 6, 12, 

217
Phone/Send icon 37
phone-off icon 11
picture files 73, 111
picture speed dial buttons 

39, 49
pictures

adding to messages 74
as backgrounds 108, 157
as screensaver 109
assigning to contacts 160
changing resolution 104, 

108, 209
creating caller ID 55
defaults for 103
deleting 108
editing 108
naming groups of 110
on phone without 

camera 103
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organizing 107
previewing 210
saving 110
sending 106
setting default size 110
synchronizing 111
taking 103–104
troubleshooting 209
uploading 73
viewing 105, 111

Pictures & Videos 
application 104, 105

PIM applications 203, 217, 
218

PIX Place accounts 73
Play button 113
Play Slide Show command 

106
Play sound check box 165
Play Sound list 176
playback icons 50, 113
Playback page 116, 127
Playback screen 116
playback, ending 114
playing

media files 113
multimedia messages 

82–83
presentations 126, 127
sounds 110, 160
voice notes 68
voicemail messages 42

playlist files 112
playlists 113, 115
plug-ins 27

PNG files 111
Pocket MSN application 90
POP accounts 75, 78
portable radio. See radio
ports. See IR port; USB ports
Power Settings page 180, 

181
Power/End button 6
PowerPoint Mobile 

application 126–127
PowerPoint Mobile icon 126
preferences, setting. See 

customizing
presentations 126, 127, 150

See also PowerPoint 
Mobile application

previewing
multimedia messages 74
pictures 210
sounds 160, 165

priority levels 64
Priority list 80
privacy settings 162
private appointments or 

events 60
Private setting 60
processor 225
Program Buttons page 168
Programs check box 164
Programs page (GPS 

Settings) 178
Programs screen 26
programs. See applications; 

software
projectors 127

protected spreadsheets 128
protecting

expansion card slot 150
information 171
Treo 700 smartphone 

171–174
proxy servers 188
punctuation marks 24

Q
QCELP files 73
Quality command 105
Quick Keys 39, 49
Quick Tour 31
quitting applications 26, 179

R
radio 220, 225
radio frequencies 219
RAS connections 186
Receive all incoming beams 

check box 99
receiving

attachments 84
beamed information 102
email 205
meeting requests 85
multimedia messages 72, 

81
notifications 89
text messages 72, 81

Receiving Data message 102
rechargeable battery. See 

battery
recipients, sending to 

multiple 71
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Record button 69
recording

ringtones 160
videos 104–105
voice notes 67, 170

recording toolbar 67
records 102
recurring appointments. See 

repeating appointments
redialing phone 40
redirector (websites) 208
Region page 166
regional settings 166, 175
Regional Settings page 166
reminders

events and 59, 62
system alarms and 176
tasks and 64, 66
turning on and off 164

remote access server 186
remote synchronization 146
Remove Programs icon 145
Remove Programs page 145
removing

applications 145, 214
Bluetooth connections 98
certificates 176
contacts 56
directory services 81
documents 125
events 61
expansion cards 151
favorites links 93
files 142
items from folders 142
items from playlists 115

messages 86, 88
notes 69
pictures 108
sounds 160
speed dial buttons 51
tasks 66
text 20
workbooks 138
worksheets 138

Rename command 155
Rename/Move command 

121, 124, 137, 153
renaming

documents 124
expansion cards 155
items in folders 142
workbooks 137
worksheets 134

Repeat check box 165
Repeat command 114
repeat patterns 59
repeating appointments 59
repeating current song 113
repeating sounds 165
repeating tasks 64
Replace All setting 121, 137
replacing

information 137
text 121
the battery 193

reset button 191
resetting Treo 700 

smartphone 173, 191, 192
resolution 103, 209
Resolution command 104
restoring information 192

restoring sound settings 163
retrieving voicemail 42
Return key 23
reverse type 19
revision marks 119
RF Safety Statement 219
Right button (navigator) 17
right-click menus 21
Ring tone list 159
Ring type list 159
ringer switch 5, 163
ringer volume 160
ringer, silencing 41, 163
ringtone files 72
ringtone IDs 160
ringtone managers 211
ringtones

assigning to contacts 49, 
55, 106, 160

creating video 106
downloading 159
previewing 160
selecting 159
silencing 163

roaming 36, 149, 159
Roaming setting 159
rotating pictures 108, 109
Running Programs screen 

26, 179

S
Save As command 122
Save password check box 

76, 78
Save to Contact Ring Tone 

command 106
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Save to Drafts command 80
Save to list 153
Save to Template command 

83
saving

documents 120, 122, 125
information 153
multimedia messages 83
notes 69, 170
phone numbers 44–45
pictures and videos 110
workbooks 128, 130, 139

Schedule command 148
schedules

adding items to 58, 59, 
60, 64

managing 58–61
organizing events for 61
removing events 61
removing tasks 66
sorting tasks on 65
unavailable time on 60
viewing daily 57

scheduling synchronization 
148–149

screen
accessories for 196
activating items on 19, 20
adjusting brightness 166
aligning 167
backgrounds for 108, 157
caring for 6
disabling touch-

sensitivity for 171
moving around on 17–18

selecting items on 19, 20
setting appearance of 

157, 158, 167
troubleshooting 196
turning off 30, 180
waking up 11, 43

Screen taps check box 164
screens, returning to 

previous 19
screensavers 109
scroll arrows 18
scroll bar 18
scrolling 18, 60, 126, 170
SD expansion cards 150, 151
SDIO expansion cards 150
Search dialog box 142
Search for list 142
Search icon 142
searching

contacts list 37
documents 121
spreadsheets 137
web pages 27, 91

searching for files 141, 142
searching for information 

27, 121, 137, 141
searching for signal 30
secure websites 177, 208
security 171–174, 177
security certificates 95
Security page 96
security software 171
self-portrait mirror 7, 105
Send outgoing items… 

setting 149

Send Sound command 160
sending

copyrighted items 106
email 80, 205
meeting requests 60, 63
multimedia messages 72, 

74
pictures 106
text messages 41, 72
videos 106

Sent folder 84, 88
Services page 162
Set as Today Background 

command 108
setting alarm clock 176
setting up smartphone 8
sheet list 131
Shift key 23, 24
Short Messaging Service. 

See SMS messaging
Short tones setting 161
shortcut menus 21
Show alphabetical index 

setting 56
Show contact names only 

setting 56
Show list 105
Show Options command 

127
Shuffle command 114
side button 6
signal, searching for 30
signal strength 34, 197
signal-strength icon 11, 181
signatures 87
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silencing all sounds 163
silencing ringer 41, 163
silent alarm 163, 165
single carrier radio 

transmission 198
Size setting 123
sketching 67
Skins page 117
Slide Show page 109
slide show toolbar 106
slide shows 106, 109, 127
slide timings setting 127
slider 18
slides 73, 106
smartphone

See also Treo 700 
smartphone

caution for resetting 192
caution for storing 7
charging 8, 29
components of 5–7
connecting to PCs 15
disabling touch-

sensitivity for 171
disposing of 221
freeing space on 145, 214
getting help with 31
locking 171, 172
losing 28, 174
low light and 23
monitoring status 34–36
not responding 191, 211
not turning on 197
operational precautions 

for 220
setting up 8

third-party applications 
and 210, 211

unlocking 172, 173
usage guidelines for 219

SMS messaging 71, 218
soft resets 8, 191
software

See also applications
hard resets and 192
included with 

smartphone 2, 226
installing 14, 15, 190

songs. See music
Sort by list 135, 142
Sort command 135
sorting

folder items 124, 138, 142
History list items 95
information 135
pictures and videos 107
tasks 65

sound clips 73
Sound Mode positions 163
sounds

changing alarm 176
customizing system 163
playing 110, 160
previewing 160, 165
recording 160
selecting 164
setting Dialpad 161
setting ringtone 159
turning off 163, 165

Sounds & Notifications page 
159, 164

Sounds page 164

Space key 23
speaker 7, 112
speakerphone 43
Speakerphone command 43
special characters. See 

alternate characters
special occassions 58
specifications 225
speed dial buttons 38, 49–51
Speed Dial Options 

command 51
Spell Check command 72, 80
spell-checking 72, 80, 124
Spelling command 124
split bar 131
spreadsheet templates 128, 

130, 139
spreadsheets

See also Excel Mobile 
application; workbooks

changing order of 
worksheets 133

creating 128
displaying 128, 129
entering data in 130, 132
filtering in 135
searching 137
sorting in 135

Start button 6, 26
Start menu 26, 168, 218
starting

Calendar application 57
Contacts application 55
data connections 187
Excel Mobile 130
Internet Explorer 91
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Media Player Mobile 113, 
116

Notes application 67
Pictures & Videos 

application 104
PowerPoint Mobile 126
Quick Tour 31
synchronization 148
Tasks application 64
Word Mobile 120

status icons 34, 86
stereo adapters 53, 112
stereo headphones 112
stereo headsets 97
Still image compression 

level setting 110
Stop command 114
stopping playback 114
stopping synchronization 

148
Storage Card page 154, 179
Storage Card setting 152, 

153
storage card symbol 142
storage cards. See 

expansion cards
Storage page 88
storage temperatures 226
storing

applications 214
attachments 85, 88
document files 122
information 150, 214
passwords 75
smartphone 7

workbooks 137
Strikethrough setting 123
stylus 5
support information 31
Symbol command 130
symbols 24, 50, 130
sync cable 15, 16, 202
sync conflicts 76
Sync Setup Wizard 146
synchronization

scheduling 148–149
setting options for 146
starting 148
troubleshooting 191, 

201–203, 206
synchronization icons 28
synchronization software 14, 

15
synchronizing

dates and time 175
email accounts 83
information 14, 28, 148, 

201
offline 202
over Bluetooth 

connections 100
over infrared 

connections 102
pictures and videos 111
playlists 113
prerequisites for 14
remotely 146
web files 96
wirelessly 75, 77, 97
with Exchange Server 

146
with multiple computers 

147
system alarms 176
system errors 197, 213
system locks 171, 173
system requirements 14, 226
System Settings page 166, 

167, 177, 178, 179
system sounds 163
system warnings 164

T
tables in documents 120
tabs, scrolling through 18
taking pictures 103–104, 209
tapping 17, 20, 164, 196
tasks

adding 64
assigning to keys 20
deleting 66
displaying 65, 66
marking as completed 65
marking as sensitive 64
setting reminders for 64, 

66
Tasks application

customizing 66
filtering options for 65
starting 64
synchronizing with 28

Tasks entry bar 64, 66
Tasks icon 64
Tasks list 65
technical assistance 31, 212
telecommunications 220
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temperature range 226
templates

documents 121, 125
multimedia messages 83
spreadsheets 128, 130, 

139
temporal key integrity 

protocol (TKIP) 184
tentative appointments 58
text

aligning 123
changing 121
copying 95
correcting 72, 80, 124
deleting 20
entering 23–24, 170
finding and replacing 121
formatting 122
highlighting 20, 123
moving or copying 122
resizing 166
searching for 27, 121
selecting 19
word-processing 

features for 119
text captions 74
text fields 18
text messages

See also messages
addressing 72
creating 71
customizing 89
links in 85
phone numbers in 39
receiving 81
requirements for 1

sending 41, 72
troubleshooting 199

text messaging service 1
Text Size page 166
Text Speed Dial button 49
text speed dial buttons 39, 49
themes 158, 167
third-party applications

5-way navigator and 17, 
211

accessing Outlook 
folders and 202

error messages and 213
freeing internal memory 

and 214
getting help with 144
installing 143
losing 192
synchronizing 

information and 190
troubleshooting 192, 210, 

211
third-party vendors 190
Thumbnail View 104, 105
Thumbnails button 105
time formats 167
Time page 167, 175
time settings 175
time zones 175
tips icon 1
Today screen 27, 33, 217

customizing 108, 157–158
Today Settings page 157, 

158
tones. See ringtones; 

sounds

touchscreen. See screen
touchscreen lockout 171
touch-sensitive feature 171
transferring

information 189, 217
media files 112, 115

transition effects (slides) 127
Transparency level list 108
Treo 700 device

features of 1, 11, 31
online support for 31
required items for 3
specifications for 225

Treo 700 smartphone
See also smartphone
compatibility with third-

party vendors 190
compliancy statement for 

220
components of 2
resetting 173, 191, 192
turning on and off 11

Treo700wVerizon web page 
31

troubleshooting 189
TTY devices 161, 220
TTY/TDD settings 161, 220
Turn on Bluetooth check box 

97
turning keyboard backlight 

on and off 23
turning off call forwarding 47
turning off screen 30, 180
turning off system sounds 

163
turning on alarms 176
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turning on indicator light 9
turning phone on and off 11
Typing mode 69

U
unauthorized users 172, 177
unavailable connections 198
unavailable time slots 60
underlining text 120, 123
Unknown Caller setting 159
unlocking

smartphone 172, 173
spreadsheet rows and 

columns 131
unread messages 86
unretrieved voicemail 42
unsafe areas 219
untimed events 58, 59
Up button (navigator) 17
Update Library command 

114
updating

information 14, 217
media files 114

uploading media files 73
uppercase letters 23, 170
URLs 113, 126
USB hub 202
USB ports 16, 202
USB sync cable 15, 16, 202
Use above settings while 

roaming setting 149
user discussion groups 31
usernames 218

V
vCal attachments 206
vCard attachments 206
Verizon Wireless accounts 1
Verizon Wireless Customer 

Care 32
Vibrate when… check boxes 

160, 165
vibrating alarm 163, 165
video files 73, 111
Video Mode command 105
Video page 110, 116
video ringtones 106
videos

adding sounds 110
adding to messages 74
adjusting volume for 160
changing resolution 105, 

209
defaults for 104
limiting length 110
on phones without 

camera 103
organizing 107
recording 104–105
saving 110
sending 106
synchronizing 111
uploading 73
viewing 105, 111

View Recording Toolbar 
command 67

viewing
alternate characters 24
animated images 111

appointments 57
available applications 26
calendar 57
contacts 37, 56
daily schedules 57
documents 119
error messages 213
events 58, 61
Flight Mode settings 181
items in folders 124, 138
memory usage 179
menus 21, 22
multimedia messages 82
notifications 165
pictures 105, 111
power settings 180
space on expansion 

cards 154, 179
spreadsheets 128, 129
tasks 65, 66
videos 105, 111
web pages 91, 95
wireless settings 181

virtual private networks. See 
VPN connections

Voice Command buttons 169
voice mail buttons 50
Voice mail setting 159
voice notes 67, 74, 170
voice privacy icon 36
Voice Privacy setting 162
voice quality 215
voice recording formats 170
voicemail

customizing 50
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playing 42
sending calls to 41
setting ringtones for 159
setting up 42
troubleshooting 161
viewing minutes usage 

for 48
voicemail controls 50
Voicemail icon 42
voicemail systems 42
Volume button 6, 160
volume, adjusting 13, 160
VP icon 36
VPN clients 187
VPN connections 84, 186–

187

W
waking up screen 11, 43
wallpaper 103
warnings 164, 220
warranty 2
WAV files 73
web browser. See Internet 

Explorer Mobile
web browsing 1, 91, 95
web links. See links
web pages

accessing 91, 93, 208
clearing links to 214
copying from 95
dialing from 39
display options for 91
downloading items from 

94, 143
playing media files from 

113, 114
returning to recently 

viewed 91, 95
searching 27, 91
security settings for 96
setting as home 95
troubleshooting 208
viewing 91, 95

websites
connecting to 91
ending connections 188
logging into secure 177
problems accessing 

secure 208
Week View (calendar) 57
WEP networks 184
Wi-Fi connections 182–185
Wi-Fi icon 183
Wi-Fi network cards 150
Wi-Fi routers 100
Wi-Fi SDIO cards 182
Windows Media Player. See 

Media Player Mobile
Windows Mobile Edition 225
wireless band setting 162
wireless features 29, 181
wireless networks 182, 183
Wireless page 181
wireless phones 30, 100, 223
Wireless Sync accounts 75, 

77
wireless synchronization 75, 

77, 97
WLANs. See wireless 

networks
WMA files 112

WMV files 111, 112
Word Completion page 169
word matching 121, 137
Word Mobile application 

119–125
Word Mobile icon 120
word-processing features 

119, 120
workbook list 130, 139
workbooks

See also Excel Mobile 
application; 
spreadsheets

adding calculations 131
adding cells, rows, and 

columns 133
adding charts 135, 136
adjusting column and 

row size 134
creating 130
defining filters for 135
deleting 138
display options for 130
formatting options for 

133–134
formulas in 131, 139
functions in 132
moving around in 131
naming 130, 137
organizing 137
removing cells, rows, 

and columns 138
replacing information in 

137
saving 128, 130, 139
searching 137
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setting default template 
for 139

worksheet names 129
worksheets 131, 133, 134, 

138
See also spreadsheets; 

workbooks
WPA networks 184
WPA-PSK connections 184
Writing mode 69

Y
Year View (calendar) 57

Z
ZIP files 143
Zoom command 104
zoom icons (camera) 104
zoom icons (presentations) 

126
Zoom In command 126
zoom settings 129, 131, 170
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